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vi Conventions

Conventions

For clarity this guide uses the following typographical

conventions:

This style Refers to this

COMPUTER Anything you type, exactly as it appears.

bold Names of items that appear on the screen.

R Return or Enter key.

C, E… Other special keys on the keyboard.

italics References to other sections of the guide.

The following symbols identify special instructions:

This symbol Refers to this

➤ A step in a procedure.

■ An item in a list of alternatives.

Important information.

Abbreviations

This guide uses the following abbreviations:

This abbreviation Refers to this

Insignia Insignia Solutions.

MS-DOS Microsoft Disk Operating System for the

IBM PC or compatible.

Macintosh A PowerPC processor-based Macintosh

computer or MacOS compatible.

PC An IBM PC or compatible computer.

Windows Microsoft Windows 3.11 or 95.
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Introduction

Introduction

Welcome to RealPC, the software that enables you to run PC

games and applications on your Power Macintosh or Power

Macintosh compatible.

Read this chapter for a quick overview of the features of RealPC,

and then turn to Installing RealPC, page 7, to get started.
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What is RealPC?

RealPC is the most cost effective way of running MS-DOS games

and applications on your Macintosh.

It is also easy to add your own copy of Windows to RealPC, so

you can run Windows games and applications.

RealPC is easy to use, and provides several unique features

including:

■ Apple Guide help, to give you step-by-step assistance with

setting up and using RealPC.

■ AppleScript support, to allow you to automate PC-based tasks

from your Macintosh.

■ EasyLaunch, to let you run MS-DOS and Windows games and

applications simply by double-clicking an icon on your

Macintosh desktop.

■ Joystick support, so you can use your Macintosh joystick with

PC games.

■ Drag and drop, for easy copying of information between PC

and Macintosh applications.

RealPC emulates a Pentium-based PC with MMX technology,

allowing you to run PC programs, including MS-DOS,

Windows 3.x, and Windows 95 games and applications,

alongside your existing Macintosh applications. It gives the same

performance as you would expect from a PC, and the faster your

Macintosh the faster the performance of RealPC.

Running MS-DOS RealPC is provided with MS-DOS 6.22 already installed, so that

applications you can immediately run MS-DOS games and applications on

your Macintosh.

RealPC supports Sound Blaster and MMX, and allows you to use

a Macintosh joystick, making it ideal for running MS-DOS games

on your Macintosh.

What is RealPC? Introduction
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Quake running on a Macintosh using RealPC

Adding Windows 3.x You can easily add your own copy of Windows 3.x to RealPC to

allow you to run Microsoft Windows applications on your

Macintosh. RealPC incorporates specially-written display, sound,

mouse, and printer drivers for Windows, to give PC performance

and the flexibility of a display size of your choice.

Windows 3.x running on a Macintosh using RealPC

Introduction What is RealPC?



4 Key features of RealPC Introduction

Adding Windows 95 If you want to take advantage of the extra features provided in

Microsoft’s latest version of Windows you can upgrade to

Windows 95 from MS-DOS or Windows 3.x using a standard

Windows 95 CD-ROM, or a set of Windows 95 installation disks.

RealPC includes a special Windows display driver which gives

enhanced display performance, and allows you to re-size the

Windows desktop dynamically without restarting.

Windows 95 running on a Macintosh using RealPC

The Insignia TurboStart™ feature lets you quit from RealPC

without exiting Windows 95. Windows 95 loads instantly the next

time you run RealPC, and you can resume where you left off.

Key features of RealPC

The following key features of RealPC make running PC

applications on your Macintosh as straightforward as running

your existing Macintosh applications:

Full integration RealPC is seamlessly integrated with your Macintosh. It includes

clipboard linking to let you copy and paste graphics and text

between your Macintosh and PC applications.
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Moving data between your PC and Macintosh applications is no

problem using the RealPC built-in file sharing. In addition, your

PC programs can make use of your Macintosh peripherals,

including your floppy disk drive, CD-ROM drive, sound, mouse,

keyboard, joystick, microphone, serial ports, printers, SCSI

devices, and network.

Networking RealPC is fully network aware, and can take advantage of your

Macintosh Ethernet or Token Ring connection to access other

PCs on your network. RealPC includes Novell NetWare client and

Microsoft Network client software. In addition, it supports most

other PC network clients, to allow you to communicate with

common network servers including Windows NT, Banyan VINES,

DEC PATHWORKS, LANtastic, and Novell LAN WorkPlace.

Easy to use RealPC is easy to use, in most cases easier than using a real PC.

Insignia’s EasyLaunch feature lets you run MS-DOS, Windows 3.x,

and Windows 95 games and applications simply by double-

clicking an icon on your Macintosh. And you can copy

information between PC and Macintosh applications using drag

and drop.

Setting up RealPC is easy too. Many changes that would require a

hardware change on a PC can be made simply by changing

options on the RealPC Setup dialog box.

If you are not already familiar with PCs this guide includes brief

introductions to MS-DOS, Windows 3.x, and Windows 95 to help

you get started. If you need more information you can use the

RealPC Apple Guide help or Balloon Help to tell you what you

need to do.

Introduction Key features of RealPC
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Requirements

Feature Requirements

Macintosh Any Power Macintosh or MacOS

compatible.

System System 7.1.2 or later.

Application memory Minimum: 16 Mbytes.

size Recommended: 24 Mbytes.

Hard disk space 50 Mbytes (MS-DOS), 60 Mbytes

(Windows 3.x), 130 Mbytes

(Windows 95).

CD-ROM drive Any Macintosh compatible CD-ROM

drive.

Requirements Introduction
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Installing RealPC

This chapter describes how to install RealPC on your Macintosh,

and how to set it up to run MS-DOS applications. It also explains

how to add Windows 3.x or Windows 95 using standard PC

installation media.

RealPC is supplied on a CD-ROM. If your Macintosh does not

have a CD-ROM drive you can connect an external CD-ROM

drive, or use file sharing to connect to a Macintosh with a

CD-ROM drive. Alternatively, a PowerBook can use SCSI disk

mode to connect it to a Macintosh with a CD-ROM drive. Refer to

your Macintosh documentation for more information about these

options.

Installing RealPC
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RealPC includes an installer which

automatically installs all the files you need.

If the installation fails, set the Extensions

Manager control panel to the system default

and then try installing again.

You will need about 50 Mbytes of free disk

space for the default installation.

1 Read the ReadMe file
➤ Insert the RealPC installation CD.

Before proceeding we recommend you double-

click the ReadMe RealPC icon on the

installation CD-ROM for any important

information that it was not possible to include

in this guide.

2 Run the installer
➤ Double-click the Installer icon.

➤ When the welcome screen appears click

Continue… to display the Easy Install

dialog box.

By default, the installer will install RealPC into a

folder named RealPC on your startup disk.

➤ Click Select Folder… if you want to install

RealPC in a different folder, and then click

the New  button if you want to create a

new folder for RealPC.

➤ Click Install to proceed with the installation.

If you are installing on the startup disk, and

applications are running, this dialog box appears:

➤ Click Continue to quit from other

applications before installing. You will be

prompted to save your work if necessary.

Installing RealPC

Installing RealPC Installing RealPC
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3 Create a hard disk file
This dialog box allows you to create a file to act

as the hard disk for RealPC:

By default, the hard disk is created with the

name RealPC Hard Disk File C and a size of

40 Mbytes, which is sufficient for MS-DOS.

If you want to install other applications you will

need to increase the size. Refer to the user

guides for the applications you want to install

for help in choosing the size you need.

Alternatively you can increase the size later,

using the HD Expander utility. Refer to To

change the size of a hard disk file, page 45.

➤ Select the size for the hard disk file from the

Size pop-up menu, or type the size into the

box.

➤ Click Create to create the hard disk file.

The installer then copies the MS-DOS files to

your hard disk:

4 Personalize RealPC
This dialog box then appears, allowing you to

personalize your copy of RealPC:

➤ Type in your name.

➤ Type in your company, or press the space

bar.

➤ Enter the serial number from the back of the

installation CD-ROM jacket.

If there is no serial number on the CD jacket see

the enclosed Activation Card for details.

To run a full version of RealPC all three fields

must be completed. Alternatively, click Time

Limited Demonstration to evaluate RealPC for

a limited period.

➤ Click OK to save your details.

Alternatively, if you want to install RealPC

without personalizing it click Later. You will

then be asked to personalize RealPC when you

first run it.

Installing RealPC Installing RealPC
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This dialog box then confirms that installation

was successful:

➤ Click Quit.

RealPC is now installed.

5 Run RealPC
➤ Double-click the RealPC™ icon.

If you are using US system software the

Registration program will then run, to help you

register your copy of RealPC. Refer to

Registering RealPC, page 11, for information

about how to proceed.

The RealPC MS-DOS window then appears with

the MS-DOS startup information.

To use MS-DOS
You can now run MS-DOS commands and

programs by typing commands at the C:\>
prompt.

For example, to see the files on the PC hard disk

type:

DIR R

Installing RealPC Installing RealPC

Once you have installed a game or application

you can run it simply by typing its name; for

example:

QUAKE R

What next?
If you want to use Windows with RealPC refer to

Installing Windows 3.x, page 15, or Installing

Windows 95, page 19.

For more information about using RealPC refer

to Running RealPC, page 27, Setting up RealPC,

page 39, and Networking with RealPC, page 133.
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In the US or Canada you can use the RealPC

Registration program, to make registering your

copy of RealPC as straightforward as possible.

Registering your copy will entitle you to 30 days

of free technical support and customer service

from your first call, and it will also ensure that

you are notified of future product upgrades.

Note that the Registration program only runs if

you have a US system. To register RealPC

outside the US or Canada please complete and

return the registration card included in the

package.

If you have a modem, the RealPC Registration

program can save you effort by sending your

registration information directly to Insignia, on a

toll-free number.

Alternatively, you can choose to print out your

registration details to make a pre-addressed

form, which you can then fax or mail to Insignia

to complete the registration.

Installing RealPC Registering RealPC

Registering RealPC

To register RealPC
Until you register your copy of RealPC, the

Registration program runs automatically every

time you run RealPC, and the following title

screen appears:

➤ Click Continue to proceed with the

registration.

The Welcome screen then appears:
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➤ Click Continue to display the following

screen:

➤ If you are going to register by modem, turn

on your modem now.

➤ Click Continue to display the Contact

Information screen:

Your name and company will already have

been filled in from the data you entered earlier,

but you can change these if you wish.

➤ Complete the screen with your name and

address, and your other contact information,

so that we can keep you updated with

information about RealPC.

➤ Click Next to display the Additional

Information screen:

➤ Complete the screen with the requested

information.

➤ Click Next to display the Purchasing

Information screen:

➤ Select your answers from the pop-up menus.

➤ Click Previous to review your other

information, or Done when you have

completed all three information screens.

Registering RealPC Installing RealPC



13

This screen then lets you choose how to send

the registration information to us:

The Registration Program can read your

computer model, system version, and RAM size.

If you prefer not to send us this information,

click Include System Information, so that the

check box is not checked.

Then proceed as described in the following

sections, depending on whether you want to

send the registration by modem, or print it.

To send your registration
information by modem
➤ Click Send… if you have a modem

connected to a telephone line, and you

would like to send your registration

information electronically.

This dialog box then lets you specify which port

your modem is connected to:

➤ Click Find it for me to set up the port

automatically.

➤ Click Send… to send the registration

information by modem.

If there is a problem using the modem you will

be given the opportunity to print the

information so that you can fax or mail it.

Installing RealPC Registering RealPC
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To print your registration
information
➤ Choose Print in the Send Data screen if you

want to print out a copy of your registration

information, and fax or mail it to us.

This screen allows you to choose a printer

before printing:

➤ When you have selected the printer click

Print to proceed with printing the

information as a single pre-addressed sheet

of paper.

➤ Fax the information to the toll free number

specified on the sheet, or fold it as directed

and mail it to the pre-printed address to

complete your registration.

Registering RealPC Installing RealPC
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This section describes how to install

Windows 3.x using a standard set of Windows

installation disks available from most PC

suppliers.

Ensure that your hard disk is at least 50 Mbytes

to upgrade to Windows 3.x; refer to To change

the size of a hard disk file, page 45.

You must install Windows 3.x in the

C:\WINDOWS directory.

Before upgrading your hard disk file it is

recommended that you make a backup copy of

it using the Finder’s Duplicate command.

1 Install the Windows files
➤ Ensure you do not have a CD in the CD-ROM

drive.

➤ Insert the first Windows installation disk into

the Macintosh floppy disk drive.

➤ Type the following command at the MS-DOS

C:\> prompt:

A:SETUP R

The Windows Setup program runs and the

following screen is displayed:

➤ Press R to set up Windows.

The following screen then lets you choose the

Setup method:

➤ Press R to run the recommended Express

Setup.

Installing Windows 3.x

Installing RealPC Installing Windows 3.x
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The Windows Setup program then copies the

files from the installation disks.

When a message appears asking you to insert

the next installation disk:

➤ Eject the current installation disk by

choosing A:SuperDrive from the RealPC

Eject menu, or press CS1.

➤ Insert the next installation disk, as specified.

➤ Press R to continue the installation.

Windows then starts and the following dialog

box allows you to personalize your copy of

Windows:

➤ Select Emulate PC Mouse from the RealPC

Setup menu to use the mouse, or type CM.

➤ Enter your name and company and click

Continue.

You are then asked to confirm the information.

➤ Click Continue to proceed.

The Windows Setup program then copies the

Windows files from the installation disks.

The following dialog box prompts you to

change disks when necessary:

➤ Eject the previous installation disk as before

and insert the next installation disk.

➤ Click Continue to continue.

The following dialog box then lets you set up a

printer for use with Windows:

➤ Select Apple LaserWriter in the list of

printers and click Install.

Installing Windows 3.x Installing RealPC
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The following dialog box then lets you specify

which port your printer is connected to.

➤ Select LPT1: and click Install.

The Windows Setup program then sets up the

Windows desktop and displays the following

dialog box.

➤ Click OK to continue.

Windows then allows you to run a tutorial about

using Windows.

➤ Click Run Tutorial to see the tutorial or

Skip Tutorial to proceed without the

tutorial.

This dialog box then confirms that the

installation is complete:

➤ Eject the installation disk from the drive and

click Reboot to restart RealPC.

The RealPC MS-DOS window then appears,

displaying the standard MS-DOS startup

information.

Installing RealPC Installing Windows 3.x
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2 Run Windows
➤ Type the following command at the MS-DOS

C:\> prompt:

WIN R

After the welcome screen Windows plays a

chime to tell you that Windows is starting, and

the Windows desktop will be displayed.

➤ Press CM to use the optimized Windows

mouse pointer.

What next?
For more information about using Windows 3.x

refer to Using Windows 3.x, page 99.

Installing Windows 3.x Installing RealPC
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If you want to take advantage of the additional

features in Windows 95 you can install from

MS-DOS or Windows 3.x, or upgrade from

Windows 3.x, using a standard Windows 95

CD-ROM, or a set of Windows 95 installation

disks.

Note that Windows 95 is supplied on DMF-

format disks. To read these you need System 7.6

or later, or version 2.0.7 or later of Apple’s PC

Exchange control panel.

Before upgrading your hard disk file it is

recommended that you make a backup copy of

it using the Finder’s Duplicate command.

Ensure that your hard disk is at least 120 Mbytes

to install Windows 95; refer to To change the

size of a hard disk file, page 45.

You must install Windows 95 in the

C:\WINDOWS directory.

1 Start the installation
If you are installing Windows 95 from CD-ROM:

➤ Start RealPC.

➤ Select Emulate PC Mouse to allow you to

control the setup process.

➤ Insert the CD-ROM into your Macintosh

CD-ROM drive.

➤ If you are upgrading from Windows 3.x start

Windows 3.x and choose Run from the

Program Manager File menu.

➤ Type F:\SETUP R.

Installing Windows 95

If you are installing Windows 95 from a set of

floppy disks:

➤ Insert the first Windows 95 installation disk

into your disk drive.

➤ Start RealPC.

When a message appears asking you to insert

the next installation disk:

➤ Eject the current installation disk by

choosing A:SuperDrive from the RealPC

Eject menu, or press CS1.

➤ Insert the next installation disk, as specified.

➤ Press R to continue the installation.

2 Run the Setup program
The Windows 95 Setup program will then run.

➤ When the Software License Agreement is

displayed click Yes to proceed.

You will then be given the opportunity to exit

from other Windows applications.

➤ Press AT to display the SmartCopy icon,

then press A4 to quit from SmartCopy.

Repeat this procedure for any other running

applications.

➤ Click OK to continue.

➤ When asked where to install Windows select

C:\Windows and click OK.

➤ When asked if you want to save your system

files select Yes and click OK.

Installing RealPC Installing Windows 95



20

➤ When the Setup Options dialog box is

displayed select Typical and press OK.

➤ When the Analyzing Your Computer

dialog box is displayed select Sound, MIDI,

or Video Computer Card and click OK.

➤ When the Get Connected dialog box is

displayed select only those items that you

wish to use and click OK.

➤ When the Windows Components dialog

box is displayed select Install the most

common components and click OK.

➤ When the Startup Disk dialog box is

displayed select Yes only if you want to

create a Startup Disk, otherwise select No

and click OK.

The Windows 95 Setup program then copies the

files for Windows 95. This will take several

minutes.

Windows 95 will then restart.

➤ Press CM to use the mouse.

The Windows 95 Setup program then sets up the

components of Windows 95.

3 Set up Microsoft Exchange
This dialog box then prompts you to set up

Microsoft Exchange.

➤ Follow the screens to install the Microsoft

Exchange options you require.

4 Complete the installation
Finally this dialog box confirms that installation

has been successful:

➤ Click OK to restart with Windows 95.

The installation is now complete.

Installing Windows 95 Installing RealPC
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5 Set up Windows 95 for use
with TurboStart

Finally set up Windows 95 for use with the

TurboStart feature.

If you have the original version of Windows 95:

➤ From the Windows 95 desktop click Start,

then click Settings and Control Panel.

➤ In the Control Panel folder double-click the

System icon.

➤ Click the Device Manager tab.

➤ Click View devices by connection.

➤ Double-click the Advanced Power

Management Support icon.

➤ Select Settings.

➤ Check the Enable power management

support box. Do not select any of the other

boxes.

➤ Click OK on this and the next dialog box.

➤ Click Yes to restart Windows 95.

If you have the later version of Windows 95:

➤ From the Windows 95 desktop click Start,

then click Settings and Control Panel.

➤ In the Control Panel folder double-click the

Power icon.

➤ Check the Allow Windows to manage

power use on this computer box.

➤ Click OK.

Installing RealPC Installing Windows 95

➤ Click Yes to restart Windows 95.

RealPC is now fully set up to run Windows 95.

What next?
For more information refer to Using

Windows 95, page 115.
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Installing additional RealPC options

The Custom Install option provides additional

installation options.

To install selected files
➤ Run the installer and choose Custom Install

from the installer’s pop-up menu.

This dialog box shows the features you can

install:

➤ Click the checkbox for each item you want

to install.

For more information about each item refer to

the table opposite.

➤ Click Install to install the selected items.

Hard Disk Expander will be installed into the

RealPC folder, and the other utilities will be

installed into the Utilities folder in the RealPC

folder.

To remove selected files
➤ Run the installer and choose Custom

Remove from the installer’s pop-up menu.

➤ Click the checkbox for each item you want

to remove.

➤ Click Remove to remove the selected items.

To get information about an
item
➤ Click the  information icon to the right of

the item.

Information about the item will be displayed;

for example:
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The table below gives information about each

of the installation options:

Select this option To do this

RealPC Install the RealPC

application.

Apple Guide Help Install help for use with

File Apple Guide.

MS-DOS Install a data file for

Data File creating a C: hard disk

file containing MS-DOS.

MS-DOS Hard Create a new C: hard

Disk disk file containing

MS-DOS.

RealPC Upgrade Create a new D: hard

Disk disk file containing the

Insignia upgrade utilities.

Insignia Fonts for Install TrueType fonts to

System 7.1/7.0 give the correct IBM

extended character set

when copying or printing

text from RealPC.

Insignia Fonts Install bitmap versions of

for System 6 the Insignia fonts.

MacIPX Install the Macintosh IPX

NetWare protocol stack.

DECnet Address Install a utility to enable

Override Utility the DECnet protocol to

be used with your

Macintosh Ethernet card.

Select this option To do this

Hard Disk Install a utility to change

Expander the size of an existing

hard disk file.

PowerBook Install the ~don’t rest and

Utilities ~rest utilities to disable or

enable the rest mode of

PowerBooks, which can

otherwise reduce the

performance of RealPC.

SharePC Install a utility to set up

RealPC on a file server so

that it can be run

simultaneously by several

users.

Installing RealPC Installing additional RealPC options
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The Easy Install option creates a folder

containing the following files:

■ RealPC™ is the RealPC application.

■ ReadMe RealPC contains additional

information about RealPC.

■ SimpleText is the application used to read

the ReadMe file.

■ RealPC Hard Disk File C is a bootable

hard disk file for use by RealPC.

■ HD Expander is a utility to change the size

of an existing hard disk file; for more

information refer to To change the size of a

hard disk file, page 45.

■ RealPC Upgrade Disk is a hard disk file

containing utilities to upgrade hard disk files

and install Insignia drivers.

■ RealPC Guide is the Apple Guide help file.

■ Registration and REGPRINT.CTL are the

registration utilities installed if you have US

system software; refer to Registering RealPC,

page 11.

The components of RealPC
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The RealPC installation CD contains a number

of additional useful files for use with RealPC.

You can install these on your Macintosh from

the installation CD.

Extras
The Extras folder contains the following items:

■ CD-ROM Software is a folder containing an

installer for the Apple CD-ROM extensions to

provide support for Macintosh/PC dual-

format CD-ROMs.

■ Internet Explorer is an installer for the

Macintosh version of Internet Explorer,

Microsoft’s browser for the World Wide Web.

■ NTRIGUE Net Client contains an installer

for a demo version of the NTRIGUE Net

Client for Macintosh, which will allow you to

access NTRIGUE servers across a TCP/IP

network from your Macintosh.

■ Open Transport 1.1.1 contains an installer

for the Open Transport networking software,

which is recommended for better

performance and greater functionality.

Other files on the installation CD

■ QuickTime™ 2.5 contains an installer for

the latest version of QuickTime. To play MIDI

files from RealPC you need the QuickTime

Musical Instruments and QuickTime

PowerPlug extensions which you can

install with this installer.

PC Extras
The PC Extras folder contains installers for the

additional Internet utilities and network clients

provided with RealPC; refer to Using Internet

utilities, page 174, for more information.

Documentation
The Documentation folder contains the

following files:

■ Fax Response contains copies of the

Insignia fax response sheets, in Adobe

Acrobat format, providing additional

information about using other networking

packages with RealPC.

■ Install Acrobat Reader 3.0 is an installer

for Adobe Acrobat on the Macintosh. For

information about installing Acrobat refer to

To install Acrobat Reader, Microsoft Internet

Explorer, PKZIP, Shockwave, or Stuffit,

page 168.

■ ReadMe RealPC is a copy of the RealPC

read-me file.

Installing RealPC Other files on the installation CD
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You can upgrade to RealPC from Virtual PC.

RealPC is compatible with hard disk files

created by Virtual PC, so you can continue to

use applications and documents you created

with Virtual PC.

To install RealPC
Proceed as described in Installing RealPC,

page 8.

To use a Virtual PC hard disk
file
➤ Choose RealPC Setup from the Setup menu

to display the RealPC Setup dialog box.

➤ Click the Hard Disks button to display the

Hard Disks panel.

Upgrading from Virtual PC

➤ Click the Change… button in the D: Drive

section. This dialog box allows you to select

the Virtual PC hard disk file to use:

➤ Select the Virtual PC hard disk file and click

Open.

➤ Click Restart to restart RealPC with the new

drive.
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Running RealPC

This chapter describes how to run RealPC, and use it to run

Windows and MS-DOS applications on your Macintosh.
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Running RealPC

When you run RealPC you get a PC in a window

on your Macintosh, so that you can run PC

applications at the same time as using your

Macintosh applications.

To run RealPC
➤ Double-click the RealPC icon.

The MS-DOS window appears and the standard

MS-DOS startup information is displayed.

For more information about using MS-DOS refer

to Using MS-DOS, page 81.

To show the files on the C:
drive
➤ Type the following command at the MS-DOS

C:\> prompt:

DIR R

To get help on MS-DOS
➤ Type the following command at the MS-DOS

C:\> prompt:

HELP R

For more information refer to Getting help on

MS-DOS (MS-DOS and Windows 3.x only),

page 86.

To run RealPC with a specific
startup hard disk file
➤ Drag the hard disk file icon and drop it onto

the RealPC icon.

The hard disk file will be set up as drive C:,

overriding the previous selection.

For example, you could have two hard disk

files, one with Windows 3.x and one with

Windows 95, and use this method to select

which one to use.

Running RealPC Running RealPC
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To restart RealPC
➤ Choose Restart RealPC from the Setup

menu.

This dialog box warns you that work can be lost

if you have not exited from PC applications or

saved files before restarting:

Click Cancel to cancel the command or

Restart to restart RealPC.

If you are running Windows 95 click the

Start button, click Shut Down…, and then

click Yes, to shut down Windows 95 before

restarting RealPC.

If you are running Windows 3.x you should

close all Windows applications and exit

Windows before restarting RealPC.

Running RealPC Restarting RealPC

Restarting RealPC
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Quitting from RealPC

To quit from MS-DOS or
Windows 3.x
➤ Close any PC applications you are using and

quit from Windows 3.x.

➤ Choose Quit from the File menu.

This dialog box appears:

➤ Choose Quit to quit from RealPC, or Cancel

to continue using RealPC.

To quit from Windows 95
If you have installed Windows 95 an additional

TurboStart option becomes available. This

saves your work so that Windows 95 loads

instantly the next time you run RealPC, and you

can resume where you left off.

➤ Choose TurboStart from the File menu.

Alternatively, if you choose Quit from the File

menu this dialog box appears:

➤ Choose TurboStart to use TurboStart.

Alternatively you can exit without using

TurboStart by clicking the Windows 95 Start

button and then clicking Shut Down…. When

you next run RealPC, Windows 95 will be

restarted in the usual way.

TurboStart requires additional space on your

Macintosh hard disk of 1 Mbyte more than

the PC memory setting.
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RealPC includes Apple Guide help, to give you

step-by-step instructions on the most important

features of RealPC as you work.

The Apple Guide help uses the RealPC Guide

file in the RealPC folder on your hard disk.

RealPC also includes Balloon Help, which gives

a brief explanation of each of the RealPC menu

commands and dialog boxes.

To use Apple Guide
➤ Choose RealPC Guide from the help menu:

The RealPC Help window appears:

➤ Click one of the following buttons to choose

what you want to do:

Click this To do this

Choose from a list of topics,

organized by subject.

Look up a topic in an

alphabetical list.

Type in the topic you need help

with.

To choose from a list of topics
➤ Click Topics in the RealPC Help window.

A list of topic areas is displayed.

➤ Select a topic area to display a list of topics,

and then select the phrase you want to know

about:

➤ Choose OK to see help.

Running RealPC Getting help

Getting help
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The help consists of a series of panels, which

tell you what to do:

➤ Follow the instructions on each panel.

Where appropriate, areas of the screen will be

highlighted to help you:

➤ When you have finished click the close box

to exit from Apple Guide.

To choose a topic from the
index
➤ Click Index in the RealPC Help window to

display the help index.

➤ Move the marker to the initial letter you are

interested in.

➤ Select an index entry to display a list of

topics, and then select the phrase you want

to know about.

To look for a topic
➤ Click Look For in the RealPC Help

window.

➤ Type in the topic you want to know about to

display a list of the available topics, and then

select the phrase you want to know about.
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To get Balloon Help
You can also use Balloon Help to give you

information about the RealPC menus, menu

commands, and dialog boxes.

➤ Choose Show Balloons from the Balloon

Help menu.

To get help about an item move the mouse

pointer over it.

Getting help on MS-DOS and
Windows
You can also get help on using MS-DOS and

Windows.

For more information refer to Getting help on

MS-DOS (MS-DOS and Windows 3.x only),

page 86, Getting help on Windows 3.x, page 106,

and Getting help on Windows 95, page 122.

Running RealPC Getting help
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IBM 101-key keyboard

Using the keyboard and mouse

RealPC can use the various Macintosh

keyboards to produce all the keys and key

combinations you need to run PC applications.

The IBM 101-key keyboard
The illustration below shows the layout and

keycap engravings of the 101-key US IBM

keyboard emulated by RealPC.

The table opposite lists the Macintosh keyboard

keys, or key combinations, needed to produce

all the keys on this keyboard that do not

correspond directly to Macintosh keys.

The following keys are used by the Macintosh to

enter accented characters. To enter one of these

key combinations in RealPC you need to press

the key combination twice:

AE, AI, AU, and AN.

To use a PowerBook keyboard
Some PowerBook keyboards do not have

function keys or a numeric keypad. RealPC

therefore provides two special modes to enable

these keys to be entered.

➤ Press CF to select Function mode, which

lets you type function keys.

➤ Press CK to select Keypad mode, to let you

use the PC keypad.

➤ Press the same keys again to cancel the

mode.

The PC mouse
The PC mouse usually has two buttons. RealPC

uses the Macintosh mouse button as the left PC

mouse button. The right mouse button is

obtained by using keypad =, or CR
(or Enter on PowerBooks).
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Extended keyboard Standard keyboard PowerBook keyboard

   

PC key Normal mode Function mode(CF)

Alt option option option
Right Alt (Alt Gr) right option C< C<
Backspace delete delete delete
Break control pause (F15) control C keypad / control C\
Ctrl control control control
Ctrl right right control CV CV
Delete del CD CD
End end CL CL
Escape escape escape or CE escape or CE
1 to 9 F1 to F9 C keypad 1 to 9 C1 to 9 1 to 9
) F10 C keypad 0 C0 0
! F11 C keypad . C-
@ F12 C keypad enter C=
Home home CO CO
Insert CI CI CI
Page Up page up CU CU
Page Down page down CW CW
Pause pause (F15) C keypad / C\
Print Scrn print screen (F13) C keypad = or CP C[ or CP
Scroll Lock scroll lock (F14) C keypad clear C]
Shift right right shift C> C>
Right mouse button keypad = or CR keypad = or CR enter or CR

PC keypad key NumLock off NumLock off Normal mode Keypad mode (CK)

Del keypad . keypad . . (period)
End keypad 1 keypad 1 1
Enter keypad enter keypad enter enter
Home keypad 7 keypad 7 7
Ins keypad 0 keypad 0 0
Num Lock keypad clear or keypad clear or CN CN

numlock numlock
Pg Up keypad 9 keypad 9 9
Pg Dn keypad 3 keypad 3 3
^ keypad 8 keypad 8 8
V keypad 2 keypad 2 2
< keypad 4 keypad 4 4
> keypad 6 keypad 6 6
/ / / C/
* * * C'
+ +
- -
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RealPC allows you to read PC-format

CD-ROMs, 3.5-inch floppy disks, and SCSI disks,

using your Macintosh drives.

By default, drive F: is set up as the Macintosh

CD-ROM drive, drive A: is set up as the

Macintosh internal floppy disk drive, and

drive E: will be used if you have a PC-

compatible SCSI drive.

To show the files on a CD-ROM
MS-DOS

➤ Type the following command at the MS-DOS

C:\> prompt:

DIR F: R

Windows 3.x

➤ Run File Manager, by double-clicking its

icon in the Main program group.

➤ Click the f CD-ROM icon in the toolbar:

Windows 95

➤ Double-click the [F:] CD-ROM icon in the My

Computer folder:

To run CD-ROM applications
➤ Follow the instructions supplied with the

CD-ROM.

To eject a CD-ROM
➤ Choose the CD-ROM drive from the Eject

menu:

You may not be able to eject the CD-ROM if it is

being shared, or if a file on it is in use by a

Macintosh application. In this case either turn

file sharing off, or close the Macintosh

application.

To eject a dual-format CD-ROM you may also

need to eject the Macintosh partition from the

Macintosh desktop by dragging it to the Trash.

Using CD-ROMs, floppy disks, and SCSI disks
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To show the files on a floppy
disk
MS-DOS

➤ Type the following command at the MS-DOS

C:\> prompt:

DIR A: R

Windows 3.x

➤ Run File Manager, by double-clicking its

icon in the Main program group.

➤ Click the a floppy disk icon in the toolbar:

Windows 95

➤ Double-click the [A:] floppy disk icon in the

My Computer folder:

Running RealPC Using CD-ROMs, floppy disks, and SCSI disks

To eject a floppy disk
➤ Choose the appropriate floppy disk drive

from the Eject menu:

You can also eject a floppy disk by typing one

of the following key combinations:

Type this To eject a disk in

CS1 Internal drive 1.

CS2 Internal drive 2.

CS0 External drive.

To eject a SCSI disk
➤ Choose the SCSI drive from the Eject menu:
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Setting up RealPC

This chapter describes how to build a PC to the specification you

want, using RealPC to emulate the PC’s ports, disks, memory, and

display.
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Using the Setup dialog box

Click this To change this

Shared Folders The Macintosh folders set up

as PC drives.

Serial Ports PC serial ports settings.

Printer Port Printing options.

Floppy Disks The emulated PC floppy disk

drive.

Joystick The emulation of a PC

joystick using a Macintosh

joystick.

CPU The MMX, FPU, and CPU

emulation settings.

These options are described in greater detail in

the following pages.

Restarting RealPC

After changing hard disks or PC memory, which

would correspond to a hardware change on a

real PC, RealPC has to be restarted, and the OK

button in the RealPC Setup dialog box

changes to Restart to warn you.

➤ Click Restart to restart with the new

configuration you have specified.

Using the RealPC Setup dialog box you can

change the configuration of several features of

RealPC in one go, and then click the OK button

to make the changes you have specified.

To display the RealPC Setup dialog box

choose RealPC Setup… from the Setup menu:

Click a button on the left (or use the arrow

keys) to show the current configuration of that

feature of RealPC, or to change it:

Click this To change this

Hard Disks The emulated PC hard disk

drives.

Memory The amount of PC memory

available.

Display The display memory,

Windows desktop size, and

number of colors.

Sound The Sound Blaster and MIDI

emulation.
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Drive Default Description

A: Internal The floppy disk drive.

C: RealPC Hard Disk File C The startup, or boot, hard disk drive.

D: RealPC Upgrade Disk Additional hard disk drive.

E: RealPC Mac/PC shared folder.

F: CD-ROM drive Default for CD-ROM drive.

G:, H: RealPC Mac/PC shared folders.

Setting up RealPC Setting up disk drives

Setting up disk drives

PCs identify the different types of disk drive

using the drive letters A: to Z:.

The table below shows the significance of the

different drive letters and how they are set up

when you first install RealPC.

You can set up the floppy disk drive A:, the

hard disk drives C: and D:, and the shared

folders E:, G:, and H:, using the Floppy Disks,

Hard Disks, and Shared Folders panels in the

RealPC Setup dialog box.

Drive letters
The number of drives available is specified by

the value of LASTDRIVE in the CONFIG.SYS
file. The default setting, LASTDRIVE=Z, makes

drives up to Z: available.

To use shared folders you need a HOST.SYS
entry in the CONFIG.SYS file. The FSADRIVE
command specifies which drives you want to

use as Mac/PC shared folders in MS-DOS or

Windows 3.x.

By default the AUTOEXEC.BAT file includes the

line:

C:\INSIGNIA\FSADRIVE E: G: H:

to make drives E:, G:, and H: available as

Mac/PC shared folders. To provide additional

shared folders in MS-DOS or Windows 3.x add

additional drives to FSADRIVE.
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By default, PC drive A: is set up as the

Macintosh internal SuperDrive.

To set up the PC floppy disk
drive
➤ Display the Floppy Disks panel in the

RealPC Setup dialog box.

➤ Check the Use Internal Floppy as A: box

to use the Macintosh internal SuperDrive as

drive A:.

➤ Check the Don’t Boot From Floppy Disk

box to prevent RealPC from attempting to

boot from a floppy disk, if you restart with a

disk in the drive.

Which disks to use
The recommended floppy disks to use are

3.5-inch high-density disks. These are identified

by a second window, opposite the write-protect

window.

720 Kbyte

Double density

1.44 Mbyte

High density

Second window

You cannot use Macintosh format floppy

disks for the PC floppy disk drive.

On a PC, a double density (720 Kbyte) 3.5-inch

disk can be formatted as 1.44 Mbytes, but it will

not be recognized as a valid PC disk by your

Macintosh. Likewise, a high density 3.5-inch

disk will only be accepted if it is the correct

1.44 Mbyte format.

To use PC 1.6 Mbyte DMF-format floppy disks

you need System 7.6 or later, or version 2.0.7

or later of Apple’s PC Exchange control

panel.

Setting up the floppy disk drive Setting up RealPC

Setting up the floppy disk drive
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RealPC emulates each PC hard disk using a

single file on the Macintosh.

The individual files within a RealPC hard disk

file are accessible only from within RealPC and

you cannot list them directly from the Finder.

RealPC hard disk files can be attached to and

detached from either of the PC drives C: and

D: without affecting the information stored

within the hard disk file.

You can use SoftWindows hard disk files as

drive C: or D: with RealPC.

You can also use hard disk files from Virtual PC

or the Apple Compatibility Card as drive D:.

RealPC will attempt to boot from a floppy disk

in drive A: when restarted, unless Don’t Boot

from Floppy Disk is selected in the Floppy

Disks panel of the RealPC Setup dialog box.

To see which hard disk files are
set up as drives C: and D:
➤ Display the Hard Disks panel in the RealPC

Setup dialog box.

This shows the name of the hard disk file

selected as the C: and D: drives, or None

Selected if there is no D: drive.

➤ Click the  button to the left of the filename

to display the full path of the hard disk file:

Setting up RealPC Setting up hard disk drives

Setting up hard disk drives
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To choose the hard disk file for
C: or D:
➤ Display the Hard Disks panel in the RealPC

Setup dialog box.

➤ Click the Change… button in the C: Drive

or D: Drive section, as appropriate.

The following dialog box lets you select the

hard disk file to use:

➤ Select the hard disk file you want to use and

click Open.

Setting up hard disk drives Setting up RealPC

In addition to RealPC hard disk files you can

select SoftWindows hard disk files, Virtual PC

hard disk files (D: drive only), or Apple

Compatibility Card container files (D: drive

only).

➤ Click Restart to restart RealPC with the new

drive you have specified.

To detach the hard disk file
from D:
➤ Display the Hard Disks panel in the RealPC

Setup dialog box.

➤ Click the Use None button in the D: Drive

section.

➤ Click Restart to restart RealPC with no D:
drive.
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The HD Expander utility, installed in the

RealPC folder, allows you to:

■ Increase the size of a hard disk file up to

505 Mbytes.

■ Decrease its size to remove unused space.

To change the size of a hard
disk file
➤ Quit from RealPC if the hard disk file you

want to expand is set up as the C: or

D: drive.

If the hard disk file contains valuable data

make a backup before proceeding.

You may need free disk space equivalent to

the size of the hard disk file, even if you are

reducing its size.

➤ Double-click the HD Expander icon:

This dialog box appears:

➤ Select the hard disk file you want to expand,

and click Open.

Setting up RealPC Changing the size of hard disk files

Alternatively, you can drag the hard disk file

icon and drop it onto the HD Expander icon.

The Hard Disk Expander window shows the

current size of your hard disk file.

➤ Enter the new size, and click Expand:

HD Expander changes the size of your hard

disk file, defragmenting it first if necessary:

➤ When the hard disk file has been resized

click Select Disk… to select another hard

disk file to expand, or Quit to quit from the

HD Expander.

Changing the size of hard disk files
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When you first install RealPC two hard disk files

are created to act as the C: and D: drives for

RealPC.

The C: drive, called RealPC Hard Disk File C,

contains the startup files and MS-DOS.

The D: drive, called RealPC Upgrade Disk,

contains additional utilities to upgrade hard

disk files and install the Insignia drivers.

You can change the size of a hard disk file using

the HD Expander utility; for more information

refer to Changing the size of hard disk files,

page 45.

You can use the Custom Install option in the

RealPC installer to create additional copies of

these hard disk files at any time.

Alternatively you can create C: or D: drives

from within RealPC, using the Hard Disks

panel in the RealPC Setup dialog box. This

command allows you to create either bootable

disks, for use as a C: drive, or non-bootable

empty hard disk files, for use as a D: drive. In

each case you can specify the size of the file

you want to create. For more information refer

to To create a new hard disk file from RealPC,

opposite.

To create a new C: hard disk
file using the installer
➤ Insert the first installation CD and double-

click the Installer icon.

➤ When the Welcome screen appears click

Continue… to display the Easy Install

dialog box.

➤ Choose Custom Install from the pop-up

menu to display the Custom Install dialog

box:

➤ Select the MS-DOS Hard Disk option to

create a bootable C: drive hard disk file.

➤ Click Install to install the hard disk you have

selected.

Creating new hard disk files Setting up RealPC

Creating new hard disk files
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This dialog box appears:

➤ Enter a name for the new hard disk file.

➤ Select the size for the hard disk file from the

Size pop-up menu, or type the size into the

box.

➤ Click Create to create the hard disk file.

The installer then copies files to the new hard

disk file.

Finally this dialog box informs you when the

hard disk file has been copied successfully:

➤ Click Quit to quit from the installer.

The first time you use a new C: drive an

update utility will run automatically to

prepare it for use with RealPC.

Setting up RealPC Creating new hard disk files

To create a new hard disk file
from RealPC
You can create a new hard disk file from within

RealPC using the Hard Disks panel in the

RealPC Setup dialog box.

If you are creating a new C: drive you will need

to have installed the HDData file using the

installer’s MS-DOS Data File option in the

Custom Install dialog box.

➤ Display the Hard Disks panel in the RealPC

Setup dialog box.

➤ Click the Create… button in the C: Drive or

D: Drive section, as appropriate.

This dialog box appears:

If necessary this dialog box lets you locate the

HDData file:



48

➤ Locate the HDData file and click Select.

➤ Enter a name for the new hard disk file.

➤ Select the size from the pop-up menu. The

options available will depend on the amount

of free space on your Macintosh hard disk.

➤ Click Create to create the hard disk file you

have specified.

RealPC will then need to be restarted to use the

new drive you have created.

➤ Click Restart to restart RealPC with the new

drive you have created.

The first time you use a new C: drive an

update utility will run automatically to

prepare it for use with RealPC.

Creating new hard disk files Setting up RealPC
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Sharing PC files between RealPC and the Macintosh

RealPC lets you designate one or more

Macintosh folders to be used as PC drives.

You can then work with files in these shared

folders using either Macintosh or MS-DOS and

Windows applications.

To see which Macintosh folders
are set up as PC drives
➤ Choose RealPC Setup… from the Setup

menu.

The RealPC Setup dialog box is displayed.

➤ Click the Shared Folders button.

The Shared Folders panel shows the PC drives

currently set up as Macintosh folders:

Initially drives E:, G:, and H: are set up as the

RealPC folder.

➤ Click on the  button to the left of the drive

letter to display the full path of the folder:

To set up a Macintosh folder as
drive E:
➤ Drag the folder and drop it onto the RealPC

window.

To set up a Macintosh folder as
a PC drive
➤ Click the Shared Folders button in the

RealPC Setup dialog box to display the

Shared Folders panel.

➤ Select the PC drive you want to set up and

click Change… (or double-click the PC

drive):
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This dialog box lets you select the folder to use

and the PC drive you want to assign it to.

➤ Select the Macintosh folder you want to use,

so that its name appears in the Use button

below the list of files.

➤ Click the button to use the folder you have

selected.

You can make more drive letters available for

Mac/PC shared folders if necessary; refer to

Drive letters, page 41.

To copy a PC file to the
Macintosh
➤ In RealPC, copy the file to a drive which has

been set up as a shared folder.

For example, if the RealPC folder is set up as

drive E:, copy the file to the E: drive. In

MS-DOS you would do this with a command

such as:

COPY C:\MYFILE.TXT E: R

You will then see the file in the RealPC folder.

To run a PC file from the
Macintosh
PC files saved from RealPC to a shared folder on

the Macintosh will automatically run RealPC if

you double-click them, and then run the

appropriate PC application.

For example, you can create a batch file to run

a game, and then copy the file to a shared

folder. Double-clicking the file icon will then

launch RealPC and run the game.

In MS-DOS this works for files with .BAT, .EXE,

or .COM extensions.

To copy a Macintosh file to
RealPC
➤ Put the file in a folder you have set up as a

shared folder.

For example, if the RealPC folder is set up as

drive E:, you can make a file available on the

PC drive E: by putting it in the RealPC folder.

To specify the type of files
created in shared folders
You can choose what types of Macintosh

documents are created when RealPC creates

MS-DOS files in Macintosh shared folders.

➤ Click the Shared Folders button in the

RealPC Setup dialog box to display the

Shared Folders panel.

➤ Click File Types.
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This dialog box allows you to specify how files

are created:

➤ Choose Automatically Select File Type to

assign standard RealPC file icons to the files

you create, based on their extension:

Document Used to Assigned to

icon identify these extensions

 PCFA MS-DOS .COM or .EXE
programs.

 PCFL PC binary .BIN, .DVR,

files. .OBJ, .OVL,

 .OVR, or.SYS

 TEXT MS-DOS data All other

files. extensions.

MS-DOS data files can be recognized by most

Macintosh applications, including SimpleText,

MacWrite Pro, Microsoft Word, Claris Works,

Excel, and WordPerfect.

➤ Choose Ask for File Type on File

Creation if you want to be prompted to

enter the four-character type to be used each

time a file is written to a shared drive from

RealPC. This dialog box appears:

Enter the file type for the file you are creating.

Alternatively, choose one of the options

Automatically Select File Type or Always

use File Type to specify the file type

automatically and change the preferences for

all subsequent files created by RealPC.

➤ Choose Always use File Type if you want

to use a specified file type for every file

regardless of its extension. The default type

is TEXT, but you can specify any other four-

character type.

MS-DOS and Windows 3.x
filenames
MS-DOS and Windows 3.x use filenames of the

form:

name.ext

where name is eight characters or less, and ext
is three characters or less.
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Also, filenames can only include the letters A–Z,

the digits 0–9, and the following symbols:

_ ^ $ ~ ! # % & - { } ( ) @ ' ´

RealPC automatically converts Macintosh

filenames to a valid name when you copy them

to a shared folder.

For example, if you list the files on the E: drive

the file:

will be given a name such as:

READMERE.28^

If you are working in a mixed PC/Macintosh

environment it is recommended you create

filenames according to the conventions

described above so they stay the same when

copied to or from shared drives.

Windows 95 filenames
Windows 95 supports long filenames, which can

contain up to 250 characters. The maximum

length of Macintosh filenames is 31 characters,

and you will not be allowed to save a

Windows 95 file to a shared folder if its name

contains more than 31 characters.

Some Windows applications automatically add

a four-character extension to the filename you

specify, in which case the maximum length is

27 characters.

Some Windows 95 applications cannot be

installed in a shared folder because they

include files which contain more than 31

characters. If necessary, install onto a

RealPC hard disk file instead.

To create additional shared
folders in Windows 95
By default only drives E:, G:, and H: are

provided in Windows 95. To set up additional

drives:

➤ Open the Windows Explorer.

➤ Choose Map Network Drive from the

Tools menu.

➤ Enter the name of the Macintosh folder you

want to map, in the format:

\\FSA_X\disk\folder

where X is the drive letter you want to map, disk
is the name of the Macintosh hard disk, and

folder is the name of the Macintosh folder.
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RealPC allows you to read data CD-ROMs which

are compatible with the Microsoft CD-ROM

Extensions (MSCDEX) as PC drives. The files on

a CD-ROM can be read just like the files on any

other drive.

By default PC drive F: is set up as the

Macintosh CD-ROM drive.

If you have other PC-compatible SCSI devices

attached to your Macintosh, these will be

recognized when RealPC starts up, using the

ASPI drivers.

They can then be used by running the

appropriate PC software. For example, a SCSI

disk drive will be assigned a drive icon in the

Windows 95 My Computer folder:

To have full access to dual-format CD-ROMs

from RealPC on an Apple Macintosh you

need version 5.1.7 or later of the Apple

CD-ROM driver. This version is supplied with

RealPC on the installation CD, in the Extras

folder.

Setting up RealPC Setting up CD-ROM drives and SCSI devices

Setting up CD-ROM drives and SCSI devices

Setting up CD-ROM drives
MS-DOS and Windows 3.x

The CD-ROM is automatically set up by the

batch file USECD which runs the following

MSCDEX command:

MSCDEX /D:CDROM$$$ /L:F /M:12 /V

This assigns the CD-ROM to drive F:.

For information about other options available

with the MSCDEX command type the following

command at the MS-DOS C:\> prompt:

HELP MSCDEX R

For example, you can set up the CD-ROM drive

as drive G: with the command:

MSCDEX /D:CDROM$$$ /L:G /M:12 /V

If the CD-ROM drive does not work, check that

your CONFIG.SYS file includes the line:

DEVICE=C:\INSIGNIA\CDROM.SYS

and restart Windows 3.x.

For more information refer to Configuring

MS-DOS, page 94.

Windows 95

Windows 95 uses a CD-ROM driver

ISLCDROM.PDR, which is loaded automatically

on startup.
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Setting up SCSI devices
MS-DOS and Windows 3.x

SCSI devices are automatically set up by the

following lines in the CONFIG.SYS file:

device=c:\insignia\aspidos.sys
device=c:\insignia\aspidisk.sys /d

Windows 95

By default Windows 95 is set up with a 32-bit

CD-ROM driver, which gives optimum

performance when reading CDs.

If you also want to access SCSI devices from

Windows 95 you need to replace this driver as

follows:

➤ Rename the file ISLCDROM.PDR, in the

C:\WINDOWS\SYSTEM\IOSUBSYS folder,

to ISLCDROM.BAK.

➤ Click the Start button, point to Settings, and

then click Control Panel.

➤ Double-click the Add New Hardware icon.

➤ When the Add New Hardware dialog box

appears click Next>.

➤ When asked if you want Windows to search

for your new hardware select No and click

Next>.

➤ From the list of Hardware types select SCSI

controllers and click Next>.

➤ In the list of SCSI controllers select Insignia

SCSI Adaptor and click Next>.

➤ Accept the default settings by clicking

Next>.

➤ Click Finish.

➤ When asked for the location of file

SWINSCSI.MPD enter

C:\WINDOWS\SYSTEM and click OK.

Windows 95 will then install the Insignia SCSI

controller.

➤ When asked if you want to shut down your

computer click Yes.

RealPC will now quit.

➤ Restart RealPC.

You will now be able to access SCSI devices.
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When you first install RealPC a recommended

PC memory configuration is set up for you, and

you should not normally need to change this.

If necessary, you can configure the PC memory

using the following procedure:

➤ Increase the RealPC application memory

size.

➤ Change the RealPC PC memory

configuration in the Memory panel of the

RealPC Setup dialog box.

Any of the available memory not used for PC

memory is allocated to the CPU Memory, which

is used to improve the performance of RealPC.

These steps are described in greater detail in the

following sections.

Expanded memory

RealPC provides extended memory, the type

used by most current PC applications.

If your application specifies that it needs

expanded memory, also referred to as LIM or

EMS (Lotus, Intel, Microsoft Expanded Memory

Specification), you can allocate some of the

memory to expanded memory using the

EMM386 expanded memory emulator. For

example, to use 2 Mbytes of extended memory

as expanded memory include this line in the

CONFIG.SYS file:

DEVICE=C:\DOS\EMM386.EXE 2048

To change the application
memory size
➤ Select the RealPC icon.

➤ Choose Get Info from the Finder’s File menu.

This dialog box shows the Minimum and

Preferred sizes to be used for RealPC; for

example:

For each 1 Mbyte of additional PC memory you

want to use you need to increase the Minimum

and Preferred memory sizes by 1030 Kbytes.

The amount of memory you need also depends

on the size of the Windows desktop, and the

number of colors used for it. For best

performance allocate as much memory as

possible to RealPC.

➤ Click the close box, in the top left corner

of the RealPC Info dialog box, to use the

size you have set.

Setting up RealPC Setting up memory

Setting up memory
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To see the amount of PC
memory
➤ Display the Memory panel in the RealPC

Setup dialog box.

The Memory panel shows the current amount

of PC memory:

To change the PC memory
➤ Display the Memory panel in the RealPC

Setup dialog box.

➤ Drag the slider or use the left and right arrow

keys to select the amount of memory:

You can choose any amount of PC memory up

to the amount of available memory, as shown

by the maximum setting of the slider.

For best performance the CPU Memory

indicator should be at Best. If you set the PC

Memory too high you will be warned that this

will reduce the performance of RealPC:

In this case increase the total amount of

memory available by increasing the application

memory size; refer to To change the application

memory size, page 55.

➤ Click Restart to restart RealPC with the

memory configuration you have selected.
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In MS-DOS RealPC emulates a VESA 2.0

standard Super Video Graphics Array (SVGA)

display, which provides a resolution of 640 x

480 or 640 x 400 with 256 colors, or 800 x 600 or

1024 x 768 with 16 colors.

You can choose the amount of memory

allocated to the display using the Display panel

in the RealPC Setup dialog box.

To change the display memory
➤ Display the Display panel in the RealPC

Setup dialog box.

➤ Choose the amount of memory from the

Video Memory pop-up menu.

To use more colors or a larger desktop size

you may need to increase the Video

Memory setting.

If this reduces the CPU Memory below the

Best setting, make more memory available by

increasing the application memory size; refer to

To change the application memory size, page 55.

To make the whole of the
RealPC window visible
➤ Choose Full Screen DOS from the Setup

menu. This hides the menu bar and displays

the MS-DOS window in the centre of the full

screen.

To display the menu bar when the menu bar is

hidden hold down the C key, or type CB to

toggle it on and off.

If you are running Windows the command

changes to Best Window Position.

➤ Choose Best Window Position to move the

Windows desktop to the position on the

screen that gives optimum performance.

Setting up RealPC Setting up the display

Setting up the display
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RealPC includes a Windows Display Driver that

improves the performance of Windows

graphics. It also allows you to run Windows in a

window of any size, up to 1600 x 1200.

To select the size of the
Windows desktop
➤ Choose the size you want from the

Windows Desktop submenu or the Setup

dialog box.

If you are running Windows 95 the desktop will

be resized immediately. If you are running

Windows 3.x the changes take effect when you

next run Windows.

Setting up the Windows desktop

To specify the Windows desktop
size and position
➤ Choose Other… from the Windows

Desktop submenu on the Setup menu or

the Setup dialog box.

The Windows Setup window is displayed, to

allow you to specify the size and position of the

Windows desktop, and, for Windows 3.x, the

number of colors to use.

The Macintosh menu bar is hidden so that you

can use the full Macintosh screen if you wish.

You can move the Windows Setup window to

the position you want it on the screen by

clicking on any part of the window and

dragging to the position you want.
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To move the Windows desktop
➤ Hold down the option and C keys.

The cursor changes to a  symbol.

➤ Drag the window to the position you want.

To change the size of the
Windows 95 desktop
➤ Hold down the option and C keys.

➤ Move the mouse pointer to the lower right

corner of the Windows 95 desktop.

The cursor changes to a  symbol.

➤ Drag the window to the size you want.

To zoom the Windows 95
desktop to fill the screen
➤ Hold down the option and C keys.

➤ Move the mouse pointer to the top right

corner of the Windows 95 desktop.

The cursor changes to a  symbol.

➤ Click on the window to zoom it to fill the

screen.

Alternatively you can choose Zoom from the

Windows Desktop submenu on the Setup

menu.

To use a larger desktop you may need to

increase the Video Memory setting. If this

reduces the CPU Memory below the Best

setting, make more memory available by

increasing the application memory size;

refer to To change the application memory

size, page 55.

To restore the Windows 95
desktop to its original size.
➤ Hold down the option and C keys.

➤ Move the mouse pointer to the top right

corner of the screen, so the pointer changes

to a  symbol.

➤ Click on the window.

Alternatively, hold down the C key to display

the menu bar and choose Zoom from the

Windows Desktop submenu on the Setup

menu.

To select the number of colors
for MS-DOS and Windows 3.x
➤ Select the number you want from the Depth

pop-up menu.

For best performance set the Number of colors

and your Macintosh Monitors control panel to

the same setting. The 256 Colors option is

optimal.

To use more colors you may need to

increase the Video Memory setting.

Setting up RealPC Setting up the Windows desktop
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To select the number of colors
for Windows 95
➤ Click Start, then click Settings and Control

Panel.

➤ Double-click the Display icon in the

Control Panel folder:

➤ In the Display Properties dialog box click

the Settings tab.

➤ Select 16 Color, 256 Color, High Color

(thousands of colors), or True Color

(millions of colors) from the Color palette

drop-down list box, as required.

For best performance set the Color palette and

your Macintosh Monitors control panel to the

same setting. The 256 Color option is optimal.

To use more colors you may need to

increase the Video Memory setting. If this

reduces the CPU Memory below the Best

setting, make more memory available by

increasing the application memory size;

refer to To change the application memory

size, page 55.

➤ Click OK to change the number of colors.
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To disable Sound Blaster
➤ Display the Sound panel in the RealPC

Setup dialog box.

➤ Choose None from the Sound Blaster pop-

up menu.

Using Sound Blaster in MS-DOS
and Windows 3.x
RealPC’s Sound Blaster emulation is configured

as follows:

I/O address: 220

Interrupt (IRQ): 5

DMA channel (8 bit): 1

DMA channel (16 bit): 5 (Sound Blaster 16 only)

The MPU-401 General MIDI port present on the

Sound Blaster 16, and emulated when Sound

Blaster Pro is in use, uses I/O address 330.

Some MS-DOS based games look at the MS-DOS

BLASTER environment variable to determine

which type of Sound Blaster card is present.

This can be set by one of the following

statements in AUTOEXEC.BAT if it is required

every time you boot RealPC:

Sound Blaster Pro

SET BLASTER=a220 i5 d1 t4

Sound Blaster 16

SET BLASTER=a220 i5 d1 h5 p330 t6

Note that the settings must agree with the Sound

Blaster card selected in the RealPC Setup

dialog box.

RealPC emulates a PC with both a Sound Blaster

card (MS-DOS and Windows) and a generic

Windows sound card (Windows only). Either or

both can be used to play sound using the

Macintosh sound system.

To provide Sound Blaster
support
➤ Display the Sound panel in the RealPC

Setup dialog box.

➤ Select the Sound Blaster support you want

from the Sound Blaster pop-up menu.

For best results choose Sound Blaster Pro. If

your software supports Sound Blaster 16

choose this option for optimum sound quality,

although this may reduce performance.

For more information refer to Using Sound

Blaster in MS-DOS and Windows 3.x opposite, or

Using Sound Blaster in Windows 95, page 62.

The Windows Sound Driver box should

normally be left checked, whether or not

you select Sound Blaster.

Setting up RealPC Setting up sound

Setting up sound



62

Using Sound Blaster in
Windows 95
Both Sound Blaster cards emulated by RealPC

are plug-and-play devices, and will

automatically be recognized by Windows 95.

This also means that if you change between the

emulated cards in the RealPC Setup dialog box

and restart Windows 95 the correct Sound

Blaster driver will automatically be loaded for

whichever card is in use. RealPC’s MPU-401

MIDI device is also a plug-and-play device.

If both the Windows Sound Driver and

Sound Blaster options are selected in the

RealPC Setup dialog box then Windows

behaves like a PC with two separate sound

cards installed. These sound cards are totally

independent of one another and can, if you

wish, be used simultaneously.

Specifying the default playback device

To specify the default playback device used by

Windows programs for audio output change the

Preferred device option for Playback in the

Audio tab of the Multimedia control panel.

The following options are available:

Preferred device Description

Insignia Native Insignia’s Windows

Playback Sound Driver

Sound Blaster Sound Blaster Pro

Playback (220)

SB16 Wave Out [220] Sound Blaster 16

Other audio devices in the selection list can be

used if the preferred device is busy when

another application wants to do audio output,

or if the preferred device does not support an

audio format required by an application but

which is supported by another device on the list

(which would be the case if CD audio quality

output was required but Sound Blaster Pro was

the preferred device, and the Windows Sound

Driver was also enabled).

In general the Windows Sound Driver will

produce clearer audio than the Sound Blaster

emulation where simple streaming audio is

required, such as playing .WAV files using

MediaPlayer. On faster Macintoshes however

the difference becomes less marked or

disappears altogether.

Because RealPC does not provide recording

support via Sound Blaster emulation the

Preferred device for Record in the Audio tab

of the Multimedia control panel should always

be set to Insignia Native Record.

To specify the default device used by Windows

programs for MIDI output change the selected

device in the MIDI tab of the Multimedia

control panel. Up to four devices may be listed

depending on whether the Windows Sound

Driver is enabled, and which if any Sound

Blaster card is enabled:

Setting up sound Setting up RealPC
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Preferred device Description

Insignia WAVE Recommended if the

& MIDI Sound Windows Sound Driver

System is enabled.

MPU-401 Compatible Recommended if the

Windows Sound Driver

is not enabled.

Creative Labs Sound Not recommended.

Blaster Pro

Internal OPL2/OPL3 Not supported.

FM Synthesis

Games written to run under Windows 95 will

generally use Microsoft’s new DirectSound

interface to produce audio output. This can

produce sound output using both digital audio

and MIDI devices and is supported by both the

Windows Sound Driver and both Sound Blaster

emulations.

The preferred device for DirectSound output is

the same as that specified in the Audio tab of

the Multimedia control panel.

Large video clips played back using

ActiveMovie may lose synchronization between

the sound and video when using the Windows

Sound Driver (the sound will complete before

the video does). The same clip should play

correctly if the Sound Blaster device is specified

as the preferred device for audio playback.

Setting up RealPC Setting up sound
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RealPC allows you to play PC MIDI files with the

Macintosh sound system, using the QuickTime

and QuickTime Musical Instruments

extensions in your Macintosh Extensions

folder. For information about installing these

refer to Other files on the installation CD,

page 25.

To play MIDI files using
QuickTime
➤ Display the Sound panel in the RealPC

Setup dialog box.

➤ Choose QuickTime from the MIDI Output

Use pop-up menu.

This is the default setting.

To play MIDI files to an
external MIDI device
➤ Set the MIDI device to 38400 baud, 8 data

bits, no parity, 1 stop bit.

➤ Connect the device to an unused Macintosh

serial port, using a suitable serial cable or a

Macintosh MIDI interface.

➤ Display the Sound panel in the RealPC

Setup dialog box.

➤ Choose Modem Port or Printer Port, as

appropriate, from the MIDI Output Use pop-

up menu.

➤ Choose Serial Cable from the Interface

pop-up menu if you are connecting via a

direct serial connection to a MIDI device

such as a keyboard.

If necessary set COM1: or COM2: to None to

make the port available.

Alternatively, if you are connecting to a MIDI

device via a Macintosh MIDI translator box

(such as Altech Systems’ MIDI Interface for

Macintosh) choose 0.5 MHz MIDI Interface,

1.0 MHz MIDI Interface, or 2.0 MHz MIDI

Interface from the Interface pop-up menu

depending on the clock speed of the device.

To play MIDI files in
Windows 95
For the best results set up Windows 95 as

described in Playing sound in Windows 95,

page 130.

Setting up MIDI Setting up RealPC
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The RealPC serial ports can be used to connect

modems, printers, and other kinds of serial

devices to your Macintosh computer’s serial

(modem or printer) ports.

To use a serial device with RealPC you need:

■ An external serial device, internal modem,

or network device that can be connected to

a Macintosh serial port.

■ A suitable cable.

■ PC software that communicates via a serial

port.

■ COM1: or COM2: assigned to the Macintosh

serial port.

To display the current serial
port settings
➤ Display the Serial Ports panel in the

RealPC Setup dialog box.

This shows the Macintosh port assigned to the

PC ports COM1: and COM2:, and the device

type connected to each port:

To set up a serial port
➤ Display the Serial Ports panel in the

RealPC Setup dialog box.

➤ Choose the option from serial port’s Use

pop-up menu.

The following options are available:

Select this option To do this

Modem Port, Printer, Use the specified

Port, Printer/Modem Macintosh port.

Port†, or Upper/Lower

PC Card Slot†

None Leave the port

unassigned.

Text File… Send output to a

(COM1: and COM2: Macintosh text file

only) document. No input

is allowed.

† PowerBook only.

If either Macintosh port is already in use the

corresponding option will be dimmed on the

pop-up menu.

Setting up RealPC Setting up serial ports
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The Connected to pop-up menu allows you to

specify the type of device connected to the port.

This provides the following options:

Select this option For

Modem To connect to a modem.

Another computer To connect to another

computer.

Printer To connect to a printer.

Printer requiring To connect to a slow

flowcontrol serial printer using

handshaking to avoid

losing data.

For details of these options refer to Serial device

options opposite.

To save output to a file
➤ Choose Text File from the COM1: or

COM2: Use pop-up menu.

This dialog box allows you to specify the file to

save the output as:

➤ Enter a name for the text file and click Save

to create the file.

The filename is displayed in the Serial Ports

panel of the RealPC Setup dialog box:

Each time you send output to the serial port it

will be added to the end of the file.

Serial port specifications

Data rates

RealPC supports the following serial port

transmission rates, in bits per second:

300 1200 2400 4800 7200

600 1800 3600 9600 19200

Higher rates up to 38400 may work, depending

on your system.

The data transfer rates which RealPC can

handle depend on the speed of your Macintosh.

In general, note the following:

■ When sending data from RealPC any data

rate (baud rate) can be used.
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■ When receiving data into RealPC choose a

lower data rate if you are running on a

slower Macintosh.

You can trade off speed for block size – at

higher speeds keep the data block size small

(100-200 bytes).

If the incoming data rate is too high some of the

data may be lost and serial communications

programs will not be able to connect. Reduce

the rate if you have problems.

Protocols

Supported serial port transmission protocols:

Parity: Even, Odd, None, Mark, or Space.

Data bits: 5, 6, 7, or 8.

Stop bits: 1, 1.5, or 2.

Default settings

By default, COM1: is set up by the following

MODE command in the AUTOEXEC.BAT file:

MODE COM1:9600,n,8,1

This gives the following communications

settings:

9600 baud, no parity, 8 data bits, 1 stop bit.

These settings can be changed with another

MODE command.

Serial device options
This section gives details of the different serial

device options in the PC Serial Ports dialog

box.

Modem

Hayes-compatible modems and MS-DOS

communications programs work well with

RealPC. Most modems that work with Macintosh

applications will also work with MS-DOS

software running in RealPC.

Not all such communications programs will

work, because some of them depend upon

reading the status of, or receiving signals from,

lines that the Macintosh serial port does not

have.

PC-compatible computers have five handshake

lines: RTS, CTS, DSR, DTR, and DCD, whereas

the Macintosh serial ports have just two: Input

Handshake and Output Handshake.

Printer

If you are using a serial printer with RealPC, and

your PC program is sending output directly to it,

you should make sure that you have the correct

cable. The printer may need to be configured to

match the serial port settings of RealPC; refer to

Serial port specifications opposite.

Problems with serial printing may be due to

handshaking; that is, the interchange of signals

between the program and the printer to ensure

that data is not sent before the printer can

accept it.

Setting up RealPC Setting up serial ports
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Printer requiring flow control

This option converts XON/XOFF software

handshaking into hardware handshaking as far

as the PC program is concerned. This is only

needed because most PC programs use

hardware handshaking and a few devices,

especially printers, use only software

handshaking.

If you are using the correct cable to your

printer, and both printer and PC program use

hardware handshaking, you should print

successfully.

If you have printing problems, try to configure

your printer and PC program to use software

handshaking.

If your program cannot be configured for

software handshaking, make sure that the

printer is using XON/XOFF and select Printer

requiring flow control from the appropriate

Connected to pop-up menu in the PC Serial

Ports dialog box. RealPC will then convert the

software signals sent by the printer into

emulated hardware signals that your PC

program can understand.

Other devices

Other serial devices may or may not work,

depending on their requirements and how

configurable they are. Almost any device that

uses software flow control will work.

Another computer

Select this option to connect to another

computer.

Cables
The Apple Peripheral-8 cable or equivalent will

work for connecting an Apple modem, an

ImageWriter II, or LaserWriter printer to a serial

port. For other modems use a Macintosh-to-

Hayes cable. For other printers use a Macintosh-

to-ImageWriter I cable.

Limitations
Programs that do not work well are those that

are extremely timing-sensitive or that rely on

serial port lines that are not available on the

Macintosh serial port.

RealPC has no access to the DSR, DCD, or RI

signals, and the RTS line cannot be set up due

to the lack of lines. Instead, RealPC makes the

DSR and RLSD/DCD lines have the same status

as the DTR line. RI is always set to off.

Copy-protection locks, also known as

dongles, do not work on RealPC due to

unavoidable timing variations in its

processing of serial port signals through the

Macintosh serial port driver.
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RealPC allows you to use a Macintosh joystick

with MS-DOS and Windows programs, such as

games, that use a joystick.

To use a Macintosh joystick
➤ Install the Macintosh joystick software in the

usual way.

➤ Turn off the joystick mapping features, so

that the joystick does not control the mouse

or keyboard.

➤ Display the Joystick panel in the RealPC

Setup dialog box:

➤ Select Enable Joystick Support and click

Restart to restart RealPC to use a joystick.

Setting up RealPC Setting up a joystick

Setting up a joystick
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RealPC allows you to select how the CPU

emulation is performed, to achieve the highest

possible performance with different

applications.

To see the CPU emulation
settings
➤ Display the CPU panel in the RealPC Setup

dialog box:

Setting up the CPU emulation

To disable the FPU
You may need to disable the FPU if you are

running a PC application which is written to use

the FPU, and which does not appear to run

properly with the emulated math co-processor.

The Macintosh math co-processor has a

different precision than the Pentium FPU, so

there may be a few applications that do not run

properly.

➤ Display the CPU panel in the RealPC Setup

dialog box.

➤ Uncheck the Floating Point Unit option.

➤ Check Restart to restart RealPC without FPU

emulation.

To disable the MMX instruction
set
If MMX is not required, unchecking the MMX

option may improve performance.
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To select advanced CPU options
➤ Display the CPU panel in the RealPC Setup

dialog box.

➤ Click Advanced… to display the advanced

CPU options:

The options are explained in the following

table:

Option Description

MMX Emulates the MMX

instruction set.

Unchecking this option

may improve

performance if MMX is

not required.

Floating Point Unit Allows you to adjust the

level of optimization. The

fastest setting, Fully

Optimized, is

recommended for most

applications.

RDTSC Required for some

applications, including

NASCAR 2. Unchecking

this option may improve

performance if it is not

required.

Name Can be set to Insignia

586 (recommended for

highest performance) or

Industry Standard

(required by some

applications, including

NASCAR 2 and Power

Chess).

Setting up RealPC Setting up the CPU emulation
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RealPC allows you to print to any printer

connected to your Macintosh, and take full

advantage of all of its features, including color.

RealPC provides an Insignia Printer Driver,

which allows you to print from PC applications

to any Macintosh printer.

If you have a PostScript printer you can get

improved performance and quality using the

RealPC PostScript option.

If you want fast draft printing or to print from

MS-DOS RealPC also provides an Epson

LQ-2500 option, which emulates a dot-matrix

printer on any Macintosh printer.

RealPC also provides a Direct Printing option,

to allow you to print directly to a PC printer

using an appropriate Macintosh printer driver

selected in the Chooser.

For more information about printing from

MS-DOS, Windows 3.x, or Windows 95 refer to

Printing from MS-DOS, page 89, Printing from

Windows 3.x, page 109, or Printing from

Windows 95, page 127.

To see the printer emulation
options
➤ Display the Printer Port panel in the

RealPC Setup dialog box.

This shows the current printer emulation:

To choose the printer emulation
➤ Display the Printer Port panel in the

RealPC Setup dialog box.

➤ Select the option you want to use.

The options are explained in the following

sections.

PostScript

This is the default option. Choose this if your

Macintosh has access to a PostScript printer,

such as a member of the Apple LaserWriter

family, and you are using a PostScript Windows

printer driver or one of the few MS-DOS

applications that support PostScript. RealPC will

send the output to the printer without

conversion.

Setting up printing
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Epson LQ-2500

Choose this option for most MS-DOS

applications, or if you want to emulate an

Epson LQ-2500 on any Macintosh printer.

RealPC will convert the output and format it

appropriately for the printer selected in the

Macintosh Chooser.

This option supports the IBM extended

character set, including graphics characters,

and you should choose this if you want to use

the Print Screen command or the PRINT
command from MS-DOS.

The Epson LQ-2500 option uses the Insignia

fonts to give the correct fonts when printing,

and these are installed automatically by the

Easy Install option. If you need to install them

refer to Installing additional RealPC options,

page 22.

Direct Printing

Choose this option to print to a PC printer using

an appropriate Macintosh printer driver

selected in the Macintosh Chooser.

Macintosh printer drivers are available for a

wide range of PC printers from Infowave

Wireless Messaging Inc. They can also supply a

cable to connect a PC printer to a Macintosh.

For more information contact their Web site at:

http://www.gdt.com

The Direct Printing option will only be

available if a PC printer driver is selected in the

Macintosh Chooser; otherwise it will be grayed

out. To use direct printing you should also

select an appropriate printer driver in the

MS-DOS application or Windows.

To set Epson LQ-2500
emulation options
➤ Select Epson LQ-2500 in the Printer Port

panel of the RealPC Setup dialog box.

➤ Click Options to set up the Epson LQ-2500

emulation options.

These correspond to the most important options

available on the Epson LQ-2500:

Country

Allows up to 12 special characters to be printed,

depending on the country selected. If you are

using an application designed for a different

national language, select the language you want

to use from the pop-up menu.

Setting up RealPC Setting up printing



74 Setting up printing Setting up RealPC

Auto Line-Feed (LF)

Prints a line feed after every carriage return. If

your printed output has unwanted double

spacing the application is already including line

feeds and you should uncheck this option.

Condensed

Condenses the characters horizontally to 60%.

Check this option if you want to fit 132 column

printing across the width of US letter size or A4

paper.

Pitch

Choose the pitch setting you want from the pop-

up menu.

Pica, the default, gives 10 characters per inch

and is the recommended setting.

Elite (12 characters per inch) and 15 pitch (15

characters per inch) reduce the horizontal

spacing to fit more characters on a line. The

character size and line spacing are set by the

Mono Spaced font size.

Proportional selects proportional printing.

Mono Spaced Font and Proportional Font

By default, two LQ-2500 fonts are selected

which emulate the character sets and spacing of

the monospaced and proportional fonts found

on an LQ-2500. Alternatively, you can select any

font on your Macintosh for either of these two

fonts. For best results you should use only

monospaced fonts (such as Courier or Monaco)

for the Mono Spaced Font option. The font size

chosen for the Proportional Font option

should be similar to that already chosen for the

monospaced font, because the size selected for

the monospace font governs the character size

and line spacing of the proportional font as

well.

Page Length

Specifies the length of the printed area to the

nearest 0.5 inches.

The Page Length is initially set to the length of

the paper selected in the Page Setup dialog

box; for example, 11 inches for US Letter paper.

Left Margin

Specifies the number of columns used for the

left margin. At the default Pica pitch there are

10 columns per inch.

You can ignore this option if you are using an

application, such as a word processor, which

sets the margins itself.

Right Margin

Specifies the number of columns to be used for

the right margin. The right margin will only

need to be set if the application is assuming a

narrower page width and the lines of print are

wrapped round, or the application is assuming

a wider page width and the lines of print run

over the paper edge.
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To use MS-DOS software in countries outside the

USA and English-speaking Canada you may

need to adjust it for the different keyboard

layouts, screen display character sets, and

printer character sets required in each country.

RealPC includes a special KEYBOARD.SYS file,

and custom Windows DLL files, to configure

MS-DOS and Windows to match the layouts of

international Macintosh keyboards.

To use an international
keyboard for MS-DOS
➤ Type the following line (or include it in your

AUTOEXEC.BAT file):

KEYB XX,,C:\INSIGNIA\KEYBOARD.SYS R

where XX represents the code for the keyboard

that you wish to install (see the table opposite).

The two-letter code is followed by two commas

then the path to the KEYBOARD.SYS file. Note

that the only space in the line is just after KEYB;

there is no space between the two commas.

Some programs, such as Microsoft Windows 3.x,

look at the PC hardware directly rather than at the

MS-DOS settings and so will ignore the installed

KEYBOARD.SYS driver.

Setting up RealPC International usage

Yugoslavia

International usage

The countries and the codes are as follows:

Country Code Country Code

Belgium BE Netherlands NL

Brazil BR Norway NO

Canadian French CF Poland PL

Czech Republic CZ Portugal PO

Slovak Republic SL Spain SP

Denmark DK Sweden SV

Finland SU Switzerland SF
(French)

France FR Switzerland SG
(German)

Germany GR United UK
Kingdom

Hungary HU United States US

Italy IT The former YU

Latin America LA

If there is no obvious \ (backslash) key on the

keyboard you can obtain a \ character as

follows:

➤ Hold down option (Alt), and type 9 and 2
on the numeric keypad.

On Macintosh keyboards with no numeric

keypad press CK to select Keypad mode, and

then use the normal numeric keys.
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To use an international
keyboard for Windows 95
➤ Click Start, then click Settings and Control

Panel.

➤ Double-click the Keyboard icon in the

Control Panel folder.

The Keyboard Properties dialog box is

displayed.

➤ Click the Language tab to display the

Language panel.

➤ Click Add… to display the Add Language

dialog box.

➤ Select the language you want to use from the

drop-down list box, and click OK.

➤ Click Set as Default to choose it as the

default language.

To use an international
keyboard for Windows 3.x
➤ Double-click the International icon in the

Windows Control Panel window.

The International dialog box will be displayed.

➤ Click the down arrow to open the Keyboard

Layout drop-down list box, and select the

layout you require.

➤ Click OK.

The following dialog box lets you select the

appropriate installed keyboard driver:

➤ Click Current to use the installed driver you

have selected.
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➤ Click OK.

To set up international printing
The following options are available for

international printing.

Epson LQ-2500 printing

The RealPC Epson LQ-2500 emulation is

complete, including the printer’s international

character sets. The LQ-2500 fonts provided

include the IBM Extended Character Set

graphics.

When you set options in the Epson LQ-2500

Emulation Options dialog box you are setting

up the initial defaults of the printer, just as if you

used the control panel of a real LQ-2500. These

initial settings may be changed by your MS-DOS

program.

If your MS-DOS software takes complete control

of the printer, including margin settings, pitch

setting, and character set selection, then you

should only need to change the options if the

default settings are incorrect.

PostScript or direct printing

For MS-DOS software that prints via PostScript or

directly to an attached PC-compatible printer,

the LQ-2500 settings are ignored and will not

affect your printouts.

To set up MS-DOS for Denmark
or Norway
To get the ø and Ø characters needed by Danish

and Norwegian users in printouts and when

using copy and paste:

➤ In the CONFIG.SYS file add the lines:

COUNTRY=045,850,C:\DOS\COUNTRY.SYS

DEVICE=C:\DOS\DISPLAY.SYS CON=(EGA,850,1)

➤ In the AUTOEXEC.BAT file add the lines:

NLSFUNC

MODE CON CODEPAGE PREPARE=((850)C:\DOS\EGA.CPI)

MODE CON CODEPAGE SELECT=850

KEYB DK,850,C:\INSIGNIA\KEYBOARD.SYS

➤ You must then restart RealPC.

The above example is for Denmark; for Norway,

replace the country code 045 with 047 and the

keyboard code DK with NO.

Setting up RealPC International usage
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To install a multi-user pack
The following procedure describes how a

system administrator should set up a multi-user

pack.

➤ Install and personalize RealPC for your

company.

➤ Duplicate and distribute the installed RealPC

and hard disk file to users. If installation is to

be server-based, only distribute the hard disk

file.

If RealPC is going to be run from a server:

➤ Install SharePC using the Custom Install

installation option; refer to Installing

additional RealPC options, page 22.

➤ Run SharePC from the Utilities folder within

the RealPC folder, and when prompted for

an application select RealPC.

Now the specified number of users will be able

to run RealPC from the server.

To share data files for creating
RealPC hard disk files
You can provide the RealPC HDData file on a

server to allow any RealPC user on the network

to build their own bootable (C: drive) hard

disk files.

To install this file use the installer’s Custom

Install option MS-DOS Data File; refer to

Installing additional RealPC options, page 22.

Setting up RealPC for multiple users

Each user will then be able to build their own

bootable hard disk files from within

RealPC using the following procedure.

➤ Choose PC Hard Disks… from the Setup

menu and proceed with creating a new hard

disk file.

➤ When prompted to locate the HDData file,

select the file on the file server.
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This section explains how to set up RealPC to

obtain the best possible performance from your

PC applications.

Application memory
The main factor affecting the performance of

RealPC is the amount of memory available to it.

For information about changing this refer to To

change the application memory size, page 55.

Increasing the application memory will allow

you to increase the PC Memory setting within

RealPC, which will improve the performance of

PC applications.

For details of the latest information on

recommended settings for different amounts of

physical memory see the RealPC ReadMe file.

For optimum performance of RealPC the CPU

Memory indicator should be at Best; refer to To

change the PC memory, page 56.

Memory-hungry PC applications such as

Windows 95 and Microsoft Excel may benefit

from as much as 15 Mbytes or more of PC

memory.

Setting up RealPC Optimizing the performance of RealPC

The Windows mouse pointer
For best performance with Windows use the

Macintosh mouse pointer, which you can select

by holding down the C key and choosing Mac

Mouse from the Setup menu.

The Windows desktop
The performance of the Windows desktop is

optimal when the whole window is visible on

the screen, unobscured by another window.

Pressing CB places the window in the best

position.

For best performance the Monitors control

panel should be set to 256 or 16 colors, and the

Windows desktop should match this.

When the Windows desktop is optimal, and you

are using the Windows mouse pointer, a ✓ is

displayed in the title bar.

Alternatively, if the title bar is not visible press

C and option to change the mouse pointer to a

hand. The hand pointer includes a dot to

indicate whether the Windows desktop is

optimal:

Optimal Non-optimal

The performance of RealPC will decrease

slightly as the size of the Windows desktop is

increased.

Optimizing the performance of RealPC
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Other factors
The following other factors also have a

significant effect on the performance of RealPC.

Macintosh performance

The performance of your Macintosh will directly

determine the performance of RealPC.

Level 2 Cache

If your Power Macintosh does not already

include Level 2 Cache you can achieve an

increase in performance of up to 30% by having

it installed.

Other Macintosh applications

Other applications running on your Macintosh,

in particular those that check the network

regularly, can slow down RealPC.

Macintosh extensions

You may find a performance improvement if

you turn off any unnecessary extensions using

Extensions Manager, as these can use system

memory. Try restarting your Macintosh with the

S key held down, to turn all extensions off,

and see if there is a significant improvement in

performance.

MS-DOS

Over time the PC hard disk may become

fragmented. To restore performance run the

MS-DOS DEFRAG utility.

Macintosh hard disk

Defragmenting the Macintosh hard disk, using

an appropriate Macintosh disk utility, may also

improve performance.
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Using MS-DOS

This chapter describes the original operating system for PCs,

called MS-DOS. RealPC includes version 6.22 of MS-DOS, and this

chapter explains the basics of how MS-DOS works and how to

use it.

For more information about MS-DOS, read any good book about

MS-DOS, such as DOS for Dummies from IDG books or the

Microsoft MS-DOS User’s Guide.
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Running MS-DOS

When you start RealPC MS-DOS will

automatically start, or you can run MS-DOS from

within Windows. This section explains how to

run MS-DOS from Windows 3.x or Windows 95,

and shows the main features of the RealPC

MS-DOS window.

To display the RealPC MS-DOS
window from Windows 3.x
➤ Double-click the MS-DOS Prompt icon in

the Main program group:

To exit from Windows 3.x to
the RealPC MS-DOS window
➤ Choose Exit Windows… from the Program

Manager File menu.

The following dialog box appears:

➤ Choose OK to exit from Windows to the

RealPC MS-DOS window.

To display the RealPC MS-DOS
window from Windows 95
➤ Click Start, then choose MS-DOS Prompt

from the Programs submenu on the Start

menu:

To exit from Windows 95 to the
RealPC MS-DOS window
➤ Click the Start button, then click Shut

Down….

➤ Select Restart the computer in MS-DOS

mode:

➤ Click Yes to proceed.
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RealPC MS-DOS window

The diagram below shows the main features of

the RealPC MS-DOS window.

The C:\> prompt at the bottom of the screen is

the basic user interface of MS-DOS. The

underscore next to the prompt is the cursor,

which shows where text will appear when you

type.

To use the mouse in MS-DOS
➤ Choose Emulate PC Mouse from the Setup

menu.

To restore the normal Macintosh mouse at any

time type CM.

Using MS-DOS The RealPC MS-DOS window

The RealPC MS-DOS window
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MS-DOS basics

On the Macintosh you perform operations on files and folders by

manipulating their icons with the mouse or by selecting menu

commands from the Finder. In MS-DOS you perform such

operations by typing an MS-DOS command at the C:\> prompt.

Note that you must press R, or Return, after every command

you type.

If you have entered a valid command, MS-DOS will carry out the

operation you requested. If you have mistyped the command or

used an invalid command you will see:

Bad command or file name

MS-DOS displays this whenever it does not recognize something.

For information on the MS-DOS commands, and how to use

them, see Getting help on MS-DOS (MS-DOS and Windows 3.x

only), page 86.

The following table gives some basic information about MS-DOS

in terms of the equivalent Macintosh information you are already

familiar with:

Macintosh MS-DOS

A file is represented by

an icon:

The icon shows the type

of the file:

Disks are represented by

icons on the desktop:

A file is represented by a filename of

up to 8 characters followed by an

extension of up to 3 letters:

REPORT1.TXT

The extension (often) shows the

type of the file:

REPORT.TXT
PICTURE.BMP

Disks are represented by drive

letters:

Hard disks: C: D:
Floppy disk drive: A:

MS-DOS basics Using MS-DOS
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Programs you can run

are represented by

application icons:

The highest level of the

filing system is the disk

window:

You see the contents of a

drive by opening its

window:

Files are organized into

folders:

You copy a file by

dragging it from one disk

window to another.

Program files are identified by a

.EXE or .COM extension:

EDIT.EXE

Batch files contain commands you

can run:

INSTALL.BAT

The highest level of the filing system

is called the Root, and is referred to

in commands as:

C:\

You see the contents of a drive by

selecting it, for example by typing:

A: R

and then listing the files:

DIR R

Files are organized into directories.

You identify the file by specifying

the drive, list of directories, and

filename, separated by \ characters:

C:\REPORTS\REPORT1.TXT

You copy a file by using the COPY
command:

COPY C:\REPORT1.TXT A: R

Macintosh MS-DOS

Using MS-DOS MS-DOS basics
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Getting help on MS-DOS (MS-DOS and Windows 3.x only)

MS-DOS includes a comprehensive help system

which you can use to display information about

MS-DOS commands, and the procedures for

using MS-DOS.

To use the mouse with MS-DOS
➤ Choose Emulate PC Mouse from the Setup

menu.

To restore the normal Macintosh mouse at any

time type CM.

To display information about an
MS-DOS command
➤ Type the following at the C:\> prompt:

command /? R

where command is the name of the command.

For example, to get help on the DIR command

type:

DIR /? R

To display the MS-DOS help
➤ Type the following command at the C:\>

prompt:

HELP R

The Command Reference menu will be

displayed as shown below.

➤ Click on the entry you want to know about,

or move the cursor to it using the cursor keys

and press R.

The help page will be displayed.

Getting help on MS-DOS (MS-DOS and Windows 3.x only) Using MS-DOS
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When RealPC is in text mode, text can be

copied from and pasted into the RealPC

MS-DOS window, or moved using drag and

drop.

To copy text from the RealPC
MS-DOS window
➤ Select the text you want to copy, by holding

down the mouse button and dragging over

the text in the RealPC MS-DOS window, as

shown below.

To select the whole window choose Select All

from the RealPC Edit menu.

➤ Choose Copy from the RealPC Edit menu.

Holding down the option key when choosing

Copy replaces return characters with spaces, so

that the text will be treated by a word processor

as a single paragraph.

Copying, pasting, and using drag and drop

➤ Switch to the application you want to paste

into and choose Paste from the Macintosh

application’s Edit menu.

Using MS-DOS Copying, pasting, and using drag and drop
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To drag text from the RealPC
MS-DOS window
➤ Select the text you want to copy, by holding

down the mouse button and dragging over

the text in the RealPC MS-DOS window, as

shown below.

To select the whole window choose Select All

from the RealPC Edit menu.

➤ Drag the selected text to an open document

in a Macintosh application that supports

drag and drop, such as SimpleText.

Dragging to a Finder window creates a text

clipping file:

If you selected the whole window click inside

the selection to deselect it.

To paste text into the RealPC
MS-DOS window
➤ Select the text you want to copy.

➤ Choose Copy from the application’s Edit

menu.

➤ Switch to RealPC.

➤ Choose Paste from the RealPC Edit menu.

The text will be typed into the RealPC window

at the current cursor position.

To drag text into the RealPC
MS-DOS window
➤ Select the text you want to copy.

➤ Drag the text and drop it onto the RealPC

window.

The text will be typed into the RealPC window

at the current cursor position.
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Printing from MS-DOS

Most MS-DOS applications give best results

when set up for a dot-matrix printer. RealPC

emulates the widely-used Epson LQ-2500 printer

on any Macintosh printer.

RealPC also provides a Direct Printing option,

to allow you to print directly to a PC printer

using an appropriate Macintosh printer driver

selected in the Chooser.

In addition, RealPC can drive a PC serial printer

connected to a serial port on the Macintosh so

that your application can print directly to it.

The options on the Printouts submenu on the

File menu allow you to specify when printing

from your Windows program is sent to the

printer.

Auto-Send… specifies that printing is

automatically sent to the Macintosh printer; this

is the default setting.

Wait for ‘Send’ specifies that output should

not be sent until you select Send to Printer.

To set up printing to any
Macintosh printer
➤ Choose RealPC Setup… from the Setup

menu and click the Printer Port button to

display the currently-selected printer

support:

➤ Select the Epson LQ-2500 option and

choose OK.

➤ Follow the instructions supplied with your

MS-DOS application to configure it to print to

an Epson LQ-2500.

LQ-2500 printing is suitable for most MS-DOS

software which typically produces an 80- or 132-

character wide, plain text printout.

Using MS-DOS Printing from MS-DOS
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If your application presents you with a number

of Epson options, choose the first of the

following options that is available:

■ LQ-2500

■ LQ-1000

■ LQ-1500, v2 ROM

■ LQ-1500

■ FX-105

■ Epson printer

RealPC emulates the PC parallel printer port,

called LPT1:, so if you need to specify the port

used select LPT1:. This port is also referred to

as the parallel port.

The LQ-2500 can print up to 132 columns. Note

that using the standard fonts this is too wide for

a US letter size (or A4) sheet. In this case

choose the Condensed option; refer to To set

Epson LQ-2500 emulation options, page 73.

Alternatively, use landscape mode, or set a

percentage reduction with the Page Setup…

command on the File menu.

To get the margins you want you may need

to adjust the margins specified in the

MS-DOS application, the RealPC Epson

LQ-2500 Emulation Options dialog box,

and the Macintosh Page Setup dialog box.

To print from an MS-DOS
application that supports
PostScript to a PostScript
printer
A small number of MS-DOS applications support

printing to a PostScript printer.

➤ Select the PostScript printer connected to

your Macintosh or to your network in the

Macintosh Chooser.

➤ Choose RealPC Setup from the Setup

menu and click the Printer Port button to

display the currently-selected printer

support:

➤ If necessary, select PostScript and choose

OK.

➤ Follow the instructions supplied with the

application to configure the software for

printing to a generic PostScript printer.
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To set up direct printing to a PC
printer
Macintosh printer drivers are available for a

wide range of PC printers from Infowave

Wireless Messaging Inc. They can also supply a

cable to connect a PC printer to a Macintosh.

For more information contact their Web site at:

http://www.gdt.com

➤ Select the appropriate printer driver in your

Macintosh Chooser.

➤ Choose RealPC Setup from the Setup

menu and click the Printer Port button to

display the currently-selected printer

support:

➤ Select Direct Printing and choose OK.

➤ Configure your MS-DOS application to print

to your PC printer.

To print from MS-DOS
➤ Choose the appropriate command to print

from your MS-DOS application.

The application will first print to the RealPC

printing buffer. The PostScript information will

then be sent to the Macintosh printer. At this

point the print dialog box for the Macintosh

printer will be displayed.

➤ Click Print to send the print job to the

printer.

To print to a serial printer
You can also print from a PC application to a

serial printer by connecting it to the Macintosh

modem or printer port with a suitable cable,

such as a Mac Plus to ImageWriter II cable. You

then use the Serial Ports panel in the RealPC

Setup dialog box to assign COM1: to the

Macintosh port connected to the printer; refer to

Setting up serial ports, page 65.

If your MS-DOS program does not let you print

to the serial port you can achieve this by typing

this command at the MS-DOS C:\> prompt

before running the program:

MODE LPT1:=COM1: R

This redirects data sent to the LPT1: port so

that it goes to the COM1: port instead. You may

also need to set the correct baud rate.

Using MS-DOS Printing from MS-DOS



92 Installing and running MS-DOS applications Using MS-DOS

To install an MS-DOS application you should

follow the installation instructions in the

manual supplied with the application.

MS-DOS software is typically supplied on one or

more floppy disks, and to install the program

you copy the files from these disks to your PC

hard disk. To simplify the installation process

most MS-DOS programs provide a batch file

which automatically copies the files for you.

The batch file is typically called SETUP.BAT or

INSTALL.BAT and you run it by typing SETUP
or INSTALL at the A:\> prompt.

To install from floppy disks
The simplest way of installing PC software is to

install directly from 3.5-inch installation disks.

A typical sequence would be as follows:

➤ Choose RealPC Setup… from the Setup

menu, and click the Floppy Disks button to

display the current settings.

➤ Check that Use Internal Floppy as A: is

checked to use the Macintosh internal

floppy disk drive for drive A:.

➤ Insert the first installation disk.

➤ Follow the instructions supplied with the

software. For example, you may be

instructed to type:

A:INSTALL R

or

A:SETUP R

If at any stage during the installation you need

to change disks, eject the current disk by

choosing it from the Eject menu (or press

CS1, CS2, or CS0 to eject a disk

from the internal, second internal, or external

drive, respectively).

Some applications suggest you can copy all

the required files onto your hard disk before

installation. Only do this if the user guide for

the application recommends it, and follow

the instructions precisely.

Choosing where to install
The installation program will typically give you

the choice of where to install the files it is

copying from the installation disks.

Choose drive C: or D:, and make sure that the

files you are installing will fit on the

corresponding hard disk file.

To do this check the disk space requirements

specified in the PC application’s manual, and

display the available hard disk space by typing

the following command at the MS-DOS C:\>
prompt:

CHKDSK R

Note that 1048576 bytes = 1 Mbyte.

If necessary, you can create more space using

the Hard Disk Expander utility; refer to To

change the size of a hard disk file, page 45.

Installing and running MS-DOS applications
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Note that some PC application installer

programs will only install onto a hard disk. Also,

some programs will assume that drives E: to Z:
are a PC network, and install additional

networking software if you specify these drives.

To run an MS-DOS application
Most MS-DOS applications are run by typing the

name of a .BAT or .EXE file at the C:\>
prompt. For example:

QUAKE.EXE R

To run an MS-DOS application
from the Macintosh
RealPC’s EasyLaunch feature lets you run a PC

application simply by double-clicking an icon

on your Macintosh.

➤ Set up the E: drive as a Macintosh shared

folder.

For more information refer to Sharing PC files

between RealPC and the Macintosh, page 49.

➤ Create a batch file to run the application.

➤ Copy the batch file to the E: drive, with a

command such as:

COPY C:\RUNGAME.BAT E: R

You can now automatically run RealPC, and

then run the MS-DOS application, by double-

clicking the icon.

Using MS-DOS Installing and running MS-DOS applications
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MS-DOS uses two configuration files,

CONFIG.SYS and AUTOEXEC.BAT, in the root

directory C:\.

You can alter either file by using a text editor.

For information about using the MS-DOS editor

to do this refer to Editing configuration files,

page 96. Before doing so, we recommend that

you make copies of the original files. The

default CONFIG.SYS and AUTOEXEC.BAT files

are shown below, and are also provided in the

INSIGNIA directory.

Configuring MS-DOS

CONFIG.SYS

This is a text file that contains commands that

configure the PC’s hardware components.

When MS-DOS starts, it carries out the

commands in CONFIG.SYS before it does

anything else.

rem

rem CONFIG.SYS

rem Copyright 1997 Insignia Solutions PLC. All rights reserved.

rem

FILES=30

BUFFERS=30

device=c:\dos\himem.sys /TESTMEM:OFF

device=c:\insignia\host.sys

device=c:\insignia\cdrom.sys

device=c:\insignia\aspidos.sys

device=c:\insignia\aspidisk.sys /d

REM device=c:\insignia\aspicd.sys /d:cdrom$$$ /norst

device=c:\dos\setver.exe

lastdrive=z

STACKS=9,256
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@echo off

rem

rem AUTOEXEC.BAT

rem Copyright 1997 Insignia Solutions PLC. All rights reserved.

rem

path C:\windows;c:\insignia;c:\dos

path %path%;c:\insignia\softnode;c:\insignia\softnode\netbatch

path %path%;c:\novell

path %path%;c:\nwclient;c:\

if exist c:\windows\iexplore\mail\nul path %path%;c:\windows\iexplore\mail

set TEMP=C:\DOS

c:\insignia\fsadrive e: g: h:

call c:\insignia\usecd.bat

c:\insignia\mouse.com

mode com1:9600,n,8,1

prompt $p$g

ver

AUTOEXEC.BAT

This is a file that MS-DOS runs immediately after

carrying out the commands in CONFIG.SYS. It

can contain any commands you want to be

executed whenever you start up the system. You

can also include statements in this file that tell

MS-DOS where to look for specific commands.
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Editing configuration files

MS-DOS includes a simple screen editor which

you can use to create, edit, and print plain text

files. You can choose editing commands from

menus, and edit text using the mouse. The

MS-DOS editor is particularly useful for editing

MS-DOS batch programs and files, such as

AUTOEXEC.BAT and CONFIG.SYS.

To use the mouse with the
MS-DOS editor
➤ Choose Emulate PC Mouse from the Setup

menu.

To restore the normal Macintosh mouse at any

time type CM.

To run the MS-DOS editor
➤ Type the following command at the C:\>

prompt:

EDIT filename R

where filename is the name of the file you

want to edit.

Alternatively, type EDIT R with no filename to

create a new file.

For example, to edit the AUTOEXEC.BAT
configuration file type:

EDIT AUTOEXEC.BAT R

The file will then be displayed in the MS-DOS

editor window, as shown below.
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To edit the file
➤ Position the cursor using the cursor keys, or

by moving the mouse and clicking.

➤ Type to insert text at the cursor.

➤ Drag to select text. Whatever you type will

then replace the selected text, or you can

delete it by pressing delete.

➤ Use the Cut, Copy, Paste, and Clear

commands from the MS-DOS editor’s Edit

menu in exactly the same way as you would

use the equivalent commands in Macintosh

applications.

You will be prompted to save the file before

exiting if you have made any changes to it.

➤ Click Yes, or press R, to save the changes

and exit from the MS-DOS editor.

To use the MS-DOS editor on a
black and white Macintosh
For best results when using a monochrome

Macintosh screen you can reconfigure the

MS-DOS editor so that the cursor and selected

items in the menus are more visible.

➤ Run the MS-DOS editor.

➤ Choose Display from the editor’s Options

menu.

➤ Use the tab and arrow keys to select a

foreground color of white and a background

color of black.

➤ Press R to use the options you have

specified.

Using MS-DOS Editing configuration files
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Using Windows 3.x

This chapter explains how to run Windows 3.x and use it to

install and run Windows applications.

It includes a short tutorial to help you become familiar with using

Windows.
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Running Windows 3.x

Ensure that Windows 3.x is installed; refer to

Installing Windows 3.x, page 15, for details.

To start Windows
➤ Type the following command at the C:\>

prompt:

WIN R

After the Windows welcome screen the

Windows desktop will be displayed, as shown

below.

A ✓ appears in the title bar when the Windows

desktop is running at optimum performance; for

more information refer to Optimizing the

performance of RealPC, page 79.

To use the mouse
As you move the Macintosh mouse pointer onto

the RealPC window it automatically changes to

the Windows mouse pointer, so that you can

switch freely between Windows and Macintosh

applications.

To improve performance the Windows mouse

pointer is slightly reduced in size.

➤ Choose Emulate PC Mouse from the Setup

menu if you prefer to work with the full size

mouse pointer.

Graphics performance will be reduced, and the

✓ will not be displayed in the title bar, when

using the full size mouse pointer.

Running Windows 3.x Using Windows 3.x



101

Right mouse button

To get the right mouse button of a PC mouse

press keypad = or CR (or Enter on

PowerBooks).

To exit from Windows 3.x
➤ If necessary, double-click the Program

Manager icon to display the Program

Manager window.

➤ Choose Exit Windows… from the Program

Manager File menu.

The following dialog box appears:

➤ Choose OK to exit from Windows to the

RealPC MS-DOS window.

For more information about the MS-DOS

window refer to Using MS-DOS, page 81.

Using Windows 3.x Running Windows 3.x
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Windows 3.x is a graphical user interface for

PCs. It gives you an easier way of moving

around the MS-DOS structure of files and

directories, and provides some extra facilities

for managing the system.

If you are familiar with running applications on

your Macintosh you should not experience too

much difficulty using Windows. Many of the

techniques of using the mouse and resizing and

moving windows are almost identical in both

systems.

The following diagram gives a brief description

of the most important components of Windows.

MS-DOS Prompt

lets you switch to

MS-DOS, keeping

your Windows

session running.

Minimize button

reduces the

window to an icon

on the desktop.

Maximize button

enlarges the

window to fill the

entire desktop.

A group icon is a minimized group window,

comparable to a closed folder in the

Macintosh Finder. Group icons are usually

located along the lower edge of the

Program Manager window.

Program Manager is always

active when you are working

with Windows. You can use

Program Manager to start

other applications and organize

applications into logical groups.

The applications in the Control

Panel allow you to change the

configuration of Windows. Any

changes you make are stored in

the Windows initialization file

WIN.INI.

Print Manager allows you to

define default printers, connect

to printers on a network,

change the configurations of

printers, and manage the active

printing of files.

Control menu box

provides commands

to manipulate or

close the window.

File Manager is a

tool for managing

files and directories

in a graphical

fashion. You can use

File Manager to

view all your files

and directories, and

copy, move, delete,

and rename files. Clipboard

Viewer allows you

to look at the

contents of the

Windows

clipboard.

Windows 3.x basics
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This tutorial is designed to help you become

familiar with using RealPC by installing and

running a typical Windows application, and

printing from Windows.

It is based on the award-winning Windows

program WinPost, which is supplied with your

RealPC package. WinPost lets you create simple

reminders which you can leave on your Windows

desktop. It is a PC shareware application, so if you

like it and decide to continue using it please send

the author the registration fee, as described in its

on-line manual.

1 Run Windows
➤ At the MS-DOS C:\> prompt type:

WIN R

After the Windows welcome screen the

Windows desktop will be displayed.

2 Run Setup
Most Windows applications are installed from

the Windows Program Manager using a

standard Windows setup procedure.

➤ Choose Run… from the Program Manager

File menu:

The Run dialog box appears.

The WinPost installer and its associated files are

supplied in the C:\WNPST directory.

➤ Type:

C:\WNPST\SETUP

➤ Click OK to run the Setup program.

3 Specify where to install
WinPost

This dialog box allows you to specify the

directory into which WinPost should be

installed:

➤ Click OK to install in the WINPOST directory

on your RealPC hard disk file.

The files are then copied to the directory you

specified.

Tutorial

Using Windows 3.x Tutorial
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To run WinPost
➤ Double-click the WinPost 3.2 icon.

The first time you run WinPost, a shareware

registration notice is displayed informing you

that you can evaluate WinPost for 21 days.

➤ Click OK to dismiss the notice.

The WinPost program is now running and its

icon is displayed at the bottom of the RealPC

desktop.

To create a new note
➤ Double-click the WinPost icon on the

Windows desktop.

An empty Note window appears.

➤ Type in the information you want to

remember.

4 Finish the installation
Finally, this dialog box informs you when the

installation is complete:

➤ Click OK to return to the Program Manager.

The installation creates a new WinPost group in

the Program Manager, containing three icons:

■ WinPost 3.2 is the WinPost application.

■ WinPost Manual provides documentation

for WinPost. Double-click the icon to display

the document so that you can read it or print

it out.

■ Read Me! is a document which gives

additional information about WinPost.

For more information about the components of

Windows you may want to read Windows 3.x

basics, page 102.
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The buttons along the top of the note provide

useful functions. For example, the first three are

cut, copy, and paste just like the equivalent

commands in Macintosh programs.

To move the note Window
➤ Drag the Note window by its title bar.

To display the WinPost menu
➤ Click the WinPost icon on the Windows

desktop.

Some of the commands on the WinPost menu

are described below.

For more information about all the commands

refer to the WinPost Manual file.

To print from a Windows
application
You can print from Windows applications to the

printer available to your Macintosh, as set in your

Macintosh Chooser.

To illustrate printing from Windows try printing

the note you have created.

Before printing you need to ensure that RealPC

is set up for the Macintosh printer you want to

use. For more information refer to Printing from

Windows 3.x, page 109.

To print a note
➤ Click the control menu button, in the top left

corner of the Note window, to display the

control menu.

➤ Choose Print this note… from the control

menu.

Alternatively, you can use the key shortcut AP
(using the Macintosh option key as A).

➤ When the Print dialog box appears click OK

to print the note.

A few seconds after Windows has finished

printing, the printouts will automatically be sent

to your Macintosh printer.

Using Windows 3.x Tutorial
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Windows 3.x comes with a comprehensive

on-line help system. It is a convenient way of

looking up information about a task you are

performing, a feature you want to know more

about, or a command you want to use.

To use Windows Help
Windows Help is available whenever you see a

Help command button or a Help menu in the

menu bar.

➤ Select the command you want from the

Help menu.

The commands are explained in the following

table:

Command What it displays

Contents An alphabetical list of all

Help topics available for

the active application.

Search For Help On A dialog box for locating

information about a

specific topic.

How To Use Help Information on using

Windows Help.

About (application) Information about the

active application

(registration details,

version number, and

so on).

Getting help on Windows 3.x

To run the Windows Tutorial
➤ Choose Windows Tutorial from the

Program Manager’s Help menu.

To do the Windows tutorial you will need to

have a desktop of at least 640 x 480, otherwise

you will be informed that you need at least a

VGA display.

For more information
For more information about using Windows

refer to any good book on Windows, such as

Windows for Dummies from IDG books or the

Microsoft Windows User’s Guide and User’s

Reference.
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RealPC includes an Insignia utility called

SmartCopy, which transfers text and graphics

between the Macintosh and Windows

clipboards, so that you can copy or cut and

paste freely between Macintosh and Windows

applications.

When you move the mouse pointer out of the

RealPC window the SmartCopy icon changes

to show whether text or graphics is ready to

paste into a Macintosh application:

When you move the mouse pointer into the

RealPC window the SmartCopy icon changes

to show whether text or graphics is ready to

paste from a Macintosh application:

To copy text or graphics from
Windows to the Macintosh
➤ Select the text or graphics you want to copy

from the Windows application.

➤ Choose Copy from the Windows

application’s Edit menu:

The text or graphics is put onto the Windows

clipboard.

➤ Switch to the Macintosh application you

want to use.

SmartCopy transfers the text or graphics to

Macintosh format on the clipboard.

➤ Choose Paste from the Macintosh

application’s Edit menu to paste in the text

or graphics you copied.

Copying, pasting, and using drag and drop in Windows 3.x

Using Windows 3.x Copying, pasting, and using drag and drop in Windows 3.x
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To copy text or graphics from
the Macintosh to Windows
➤ Select the text or graphics you want to copy.

➤ Choose Copy from the Macintosh

application’s Edit menu.

➤ Switch to RealPC.

SmartCopy translates the text or graphics to

Windows format on the Windows clipboard,

and you can use the Clipboard Viewer to

view it.

➤ Choose Paste from the Edit menu of the

Windows application you want to use, to

paste the text or graphics in.

To drag text from the
Macintosh to Windows
➤ Select the text you want to copy.

➤ Drag the text and drop it onto a Windows

document in RealPC.

The text will be typed into the document at the

current cursor position.

To copy graphics from the
Windows desktop to the
Macintosh
➤ Hold down the C key.

The Windows mouse pointer changes to the

Macintosh mouse pointer.

➤ Press the mouse button, and drag to draw a

rectangle enclosing the section of the

Windows desktop you want to copy.

➤ Choose Copy from the RealPC Edit menu.

The graphics will be put on the Macintosh

Clipboard and you can use Show Clipboard

on the Macintosh Edit menu to display it.

To drag graphics from the
Windows desktop to the
Macintosh
➤ Hold down the C key.

The Windows mouse pointer changes to the

Macintosh mouse pointer.

➤ Press the mouse button, and drag to draw a

rectangle enclosing the section of the

Windows desktop you want to copy.

➤ Drag the selected area to an open document

in a Macintosh application that supports

drag and drop.

If you drag to a Finder window the graphic is

saved as a picture clipping file:
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RealPC allows you to print to any printer

connected to your Macintosh, and take full

advantage of all of its features, including color.

RealPC provides an Insignia Printer Driver,

which allows you to print from Windows

applications to any Macintosh printer.

If you have a PostScript printer you can get

improved performance and quality using the

RealPC PostScript option.

RealPC also provides an Epson LQ-2500

option, which emulates a dot-matrix printer on

any Macintosh printer, if you want fast draft

printing.

RealPC also provides a Direct Printing option,

to allow you to print directly to a PC printer

using an appropriate Macintosh printer driver

selected in the Chooser.

The options on the Printouts submenu on the

File menu allow you to specify when printing

from your Windows program is sent to the

printer.

Auto-Send… specifies that printing is

automatically sent to the Macintosh printer; this

is the default setting.

Wait for ‘Send’ specifies that output should

not be sent until you select Send to Printer.

Printing from Windows 3.x

Using Windows 3.x Printing from Windows 3.x

To set up printing to any
Macintosh printer
➤ Select the printer connected to your

Macintosh or to your network in the

Macintosh Chooser.

➤ Double-click the Control Panel icon in the

Windows Main program group.

➤ Double-click the Printers control panel icon

to display the Printers dialog box:

The currently-selected printer is shown in the

Default Printer box at the top of the dialog

box.

➤ Check that this is set to Insignia Printer

Driver on LPT1:.

➤ Click Cancel to close the dialog box.

The Insignia Printer Driver does not support

Windows shared printers.
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To set up printing to a
PostScript printer
➤ Select the PostScript printer connected to

your Macintosh or to your network in the

Macintosh Chooser.

➤ Choose RealPC Setup from the Setup menu

and click the Printer Port button to display

the currently-selected printer support:

➤ If necessary, select PostScript and choose

OK.

➤ Double-click the Control Panel icon in the

Windows Main program group.

➤ Double-click the Printers control panel icon

to display the Printers dialog box:

The currently-selected printer is shown in the

Default Printer box.

➤ Select Apple LaserWriter on LPT1: and

click Set As Default Printer.

➤ Click Close to close the dialog box.

To set up printing using Epson
LQ-2500 emulation
➤ Choose RealPC Setup from the Setup menu

and click the Printer Port button to display

the currently-selected printer support:

➤ Select Epson LQ-2500 and choose OK.

➤ Double-click the Control Panel icon in the

Windows Main program group.

➤ Double-click the Printers control panel icon

to display the Printers dialog box.
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➤ Select Epson LQ-2500 on LPT1: and click

Set As Default Printer.

➤ Click Close to close the dialog box.

To set up direct printing to a PC
printer
Macintosh printer drivers are available for a

wide range of PC printers from Infowave

Wireless Messaging Inc. They can also supply a

cable to connect a PC printer to a Macintosh.

For more information contact their Web site at:

http://www.gdt.com

➤ Select the appropriate printer driver in your

Macintosh Chooser.

➤ Choose RealPC Setup… from the Setup

menu and click the Printer Port button to

display the currently-selected printer

support:

Using Windows 3.x Printing from Windows 3.x

➤ Select Direct Printing and choose OK.

➤ Double-click the Control Panel icon in the

Windows Main program group.

➤ Double-click the Printers control panel icon

to display the Printers dialog box.

➤ Select an appropriate printer driver for your

PC printer, and click Set As Default

Printer.

➤ Click Close to close the dialog box.

To print from Windows 3.x
➤ Print from the Windows application;

typically you do this by choosing Print…

from the File menu.

The application will first print to the RealPC

printing buffer. The printing information will

then be sent to the Macintosh printer. At this

point the Print dialog box for the Macintosh

printer will be displayed.

➤ Click Print to send the print job to the

printer.
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Playing sound in Windows 3.x

RealPC emulates Sound Blaster and Windows

sound, allowing you to play Windows waveform

or MIDI files on your Macintosh. These are

identified with .WAV and .MID extensions,

respectively.

RealPC also supports ADPCM decompression,

to allow ADPCM sound files to be played in

RealPC.

You can choose an interesting sound for each

of the events that can occur in Windows using

the Sound control panel.

To use Windows sound you need to have

Windows Sound Driver or Sound Blaster

checked in the Sound panel of the RealPC

Setup dialog box; refer to Setting up sound,

page 61.

To adjust the volume and balance of RealPC

sound output you should use the controls in the

Macintosh Sound control panel.

To set up Windows 3.x to play
MIDI files
To play MIDI files using the Macintosh sound

system you need to have the Midi Output pop-

up menu set to QuickTime in the Sound panel

of the RealPC Setup dialog box, and you need

to have the Macintosh QuickTime and

QuickTime Musical Instruments extensions

installed.

To play a sound or MIDI file
from Windows 3.x
➤ Open the Accessories program group

window by double-clicking the Accessories

icon in the Program Manager:

➤ Run the Media Player, by double-clicking the

Media Player icon in the Accessories

window:

The Media Player window is displayed.

➤ Choose Open… from the Media Player File

menu, and select a waveform file, such as

chord.wav, or a MIDI file, such as

canyon.mid:

➤ Click OK to load the waveform.

Playing sound in Windows 3.x Using Windows 3.x
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➤ Click the Media Player play button to play

the waveform:

➤ Choose Exit from the File menu to exit from

Media Player.

To set sounds for Windows 3.x
events
➤ Open the Control Panels window, by

double-clicking the Control Panels icon in

the Main program group.

➤ Double-click the Sound icon:

The Sound control panel is displayed.

➤ Select the Windows event you want to

identify with a sound.

The Files list shows the current waveform file

assigned to that event, or <none> if no sound is

played.

➤ Select the waveform file you want to use.

Using Windows 3.x Playing sound in Windows 3.x

➤ Click Test to play the sound.

➤ When you have set up the sound you want

to play for each event click OK to exit from

the control panel.
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Installing and running Windows 3.x applications

Most Windows applications are installed using

the standard Windows setup procedure.

Provided you have a CD-ROM or standard

3.5-inch disks for your Windows application, the

procedure is similar to installing software on

your Macintosh.

To install a Windows
application
➤ Insert the application’s installation CD-ROM

or floppy disk into the Macintosh drive.

➤ Choose Run… from the Program Manager

File menu.

➤ Follow the application’s installation

instructions. For example, you may be

instructed to type A:SETUP.

➤ Click OK to start the installation.

As the installation proceeds, dialog boxes

similar to the one shown below will prompt you

for information needed for the installation.

Installing and running Windows 3.x applications Using Windows 3.x

To run a Windows application
➤ Double-click the application icon in the

appropriate program group.

For example, to run Solitaire, supplied with

Windows, proceed as follows:

➤ Double-click the Games program group

icon to open it.

➤ Double-click the Solitaire icon to run

Solitaire.

To run a Windows 3.x
application from the Macintosh
RealPC’s EasyLaunch feature lets you run a PC

application simply by double-clicking an icon

or your Macintosh.

➤ Set up the E: drive as a Macintosh shared

folder.

For more information refer to Sharing PC files

between RealPC and the Macintosh, page 49.

➤ Create a batch file to run the application.

➤ Copy the batch file to the E: drive.

You can now automatically run RealPC, and

then run the Windows application, by double-

clicking the icon.
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Using Windows 95

This chapter explains how to run Windows 95, and gives

information about working with Windows 95 and running

Windows applications.

It includes a short tutorial to introduce you to the procedures for

working with Windows 95.
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Ensure that Windows 95 is installed; refer to

Installing Windows 95, page 19, for details.

Windows 95 starts in seconds with TurboStart,

and you can resume your work where you left

off when you quit.

The first time you run RealPC the Windows 95

desktop will be displayed as shown below.

A ✓ appears in the title bar when the

Windows 95 desktop is running at optimum

performance; for more information refer to

Optimizing the performance of RealPC, page 79.

To use the mouse
As you move the Macintosh mouse pointer onto

the RealPC window it automatically changes to

the Windows mouse pointer, so that you can

Running Windows 95

switch freely between Windows and Macintosh

applications.

To improve performance the Windows mouse

pointer is slightly reduced in size.

➤ Choose Emulate PC Mouse from the Setup

menu if you prefer to work with the full size

mouse pointer.

Graphics performance will be reduced, and the

✓ will not be displayed in the title bar, when

using the full size mouse pointer.

Right mouse button

To get the right mouse button of a PC mouse

press keypad = or CR (or Enter on

PowerBooks).
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To exit from Windows 95
The recommended way to quit from

Windows 95 is to use TurboStart; refer to To

quit from Windows 95, page 30.

However, if you specifically want to exit from

Windows 95 proceed as follows:

➤ Click the Start button, then click Shut

Down….

This dialog box lets you choose how to shut

down:

➤ Click Yes to choose the first option and shut

down Windows 95.

RealPC will then automatically quit.
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Close button closes

the window.

The My Computer

window shows an

icon for each drive

attached to the PC.

Double-click an icon

to show the files on

the drive.

The Taskbar shows a

button for each open

window; click a button

to switch to the

corresponding window.

Click the Start button

to perform an action

from the Start menu;

see below.

The Recycle Bin

stores deleted files like

the Macintosh Trash.

Network

Neighborhood

shows the network

resources available.

Inbox is your in-tray

for sending and

receiving electronic

mail.

Scroll bar.

The Internet lets you

access the Internet and

World Wide Web.

Windows 95 basics Using Windows 95

The following diagram gives a brief introduction

to the most important components of

Minimize button

reduces the window

to a button on the

taskbar.

Maximize button

enlarges the window

to fill the entire

desktop.

Double-click the My

Computer icon to

show the drives

attached to the PC.

Windows 95. It also gives a summary of the

options available from the Start menu.

Windows 95 basics

My Briefcase is

used to keep

multiple versions of

a file in sync.

Documents displays a list of previously

opened documents.

Programs displays the programs on your

system. It also gives you access to the

MS-DOS prompt.

Find helps you find a file or folder.

Help gives help on Windows 95.
Click Run… to run an MS-DOS or Windows

program, or execute a command.

Click the Start button to display a menu

of commands for using Windows 95.

Settings lets you change system settings.

Click Shut Down… to shut down

Windows 95, or exit to MS-DOS.

Online Services

contains demos

from Internet

service providers.
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This Tutorial is designed to help you become

familiar with using RealPC by installing and

running a typical Windows application, and

printing from Windows.

It is based on the award-winning Windows

program WinPost, which is supplied with your

RealPC package. WinPost lets you create simple

reminders which you can leave on your

Windows desktop. It is a PC shareware

application, so if you like it and decide to

continue using it please send the author the

registration fee, as described in its online

manual.

1 Run Setup
Most Windows 95 applications are installed by

running a standard Windows setup procedure.

The installer and its associated files are supplied

in the C:\WNPST folder.

➤ Click the Start button on the taskbar, and

then click Run….

The Run dialog box appears.

➤ Type:

C:\WNPST\SETUP

➤ Click OK to run the setup program.

2 Specify where to install
WinPost

This dialog box allows you to specify the

directory into which WinPost should be

installed:

➤ Click OK to install in the WINPOST directory

on your RealPC hard disk file.

The files are then copied to the directory you

specified.

Tutorial

Using Windows 95 Tutorial
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3 Finish the installation
This dialog box informs you when the

installation is complete:

➤ Click OK to return to the Windows desktop.

The installation creates a new WinPost folder

containing the following shortcuts:

These are like Macintosh aliases to the actual

files.

■ WinPost 3.2 is a shortcut to the WinPost

application.

■ WinPost Manual is a shortcut to

documentation for WinPost. Double-click

the icon to display the document so that you

can read it or print it out.

■ Read Me! is a shortcut to additional

information about WinPost.

When you install a Windows application the

installer usually creates shortcuts for the

application, and for any other programs or

documents you might need to use with it. Often

these are put in a separate folder.

For more information about the components of

Windows 95 you may want to read Windows 95

basics, page 118.

To run WinPost
➤ Double-click the WinPost 3.2 shortcut icon.

The first time you run WinPost, a shareware

registration notice is displayed informing you

that you can evaluate WinPost for 21 days.

➤ Click OK to dismiss the notice.

The WinPost program is now running and its

icon is displayed in the taskbar at the bottom of

the Windows desktop:

To display the WinPost menu
➤ Point to the WinPost icon in the taskbar and

press keypad = or RR (or Enter on

PowerBooks).

This is equivalent to clicking the right PC mouse

button.

A pop-up menu appears above the taskbar.

Some of the commands on the WinPost menu

are described opposite. For more information

about all the commands refer to the WinPost

Manual file.
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To create a new note
➤ Display the WinPost menu, as described in

the previous section.

➤ Choose Default from the Create a note

submenu:

An empty Note window appears.

➤ Type in the information you want to

remember.

The buttons along the top of the note provide

useful functions. For example, the first three are

cut, copy, and paste just like the equivalent

commands in Macintosh programs.

To print from a Windows
application
You can print from Windows applications to the

printer available to your Macintosh, as set in

your Macintosh Chooser.

To illustrate printing from Windows try printing

the note you have created.

Before printing you need to ensure that RealPC

is set up for the Macintosh printer you want to

use. For more information refer to Printing from

Windows 95, page 127.

To print a note
➤ Click the control menu button, in the top left

corner of the Note window, to display the

control menu.

➤ Choose Print this note….

Alternatively, you can use the key shortcut AP.

Note that you should use the Macintosh option

key as A.

➤ When the Print dialog box appears click OK

to print the note.

A few seconds after Windows has finished

printing, the printouts will automatically be sent

to your Macintosh printer.

Using Windows 95 Tutorial
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Getting help on Windows 95

Windows 95 includes a comprehensive help

system, with answers to most problems you are

likely to have.

To display Windows Help
➤ Click the Start button, then click Help.

The Windows Help window appears showing

the list of help topics.

To find help from the contents
➤ Click the Contents tab to show the help

topics grouped by subject.

➤ Click a book icon to display the contents of

that book.

➤ Click a help topic icon and then click

Display to display help on that topic:

The Windows help topic will be displayed:
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To find help from the index
➤ Click the Index tab to show an alphabetical

list of topics.

➤ Click a help topic and then click Display to

display help on that topic.

To find help topics containing a
word or phrase
➤ Click the Find tab, and then type in the

word or phrase you want to find.

A list of matching topics will be displayed.

➤ Click a help topic and then click Display to

display help on that topic.

To get help on an item on the
screen
➤ Point to the item and press the = key on the

numeric keypad.

This is equivalent to clicking the right PC mouse

button.

A What’s This? box appears.

➤ Click What’s This? to display an

explanation of the item.

Using Windows 95 Getting help on Windows 95
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Copying, pasting, and using drag and drop in Windows 95

RealPC includes an Insignia utility called

SmartCopy, which transfers text and graphics

between the Macintosh and Windows

clipboards, so that you can copy or cut and

paste freely between Macintosh and Windows

applications.

When SmartCopy is running its icon appears at

the right end of the taskbar:

When you click the mouse button with the

pointer outside the RealPC window the

SmartCopy icon changes to show whether text

or graphics is ready to paste into a Macintosh

application:

When you click the mouse button with the

pointer inside the RealPC window the

SmartCopy icon changes to show whether text

or graphics is ready to paste from a Macintosh

application:

To copy text or graphics from
Windows 95 to the Macintosh
➤ Select the text or graphics you want to copy

from the Windows application.

➤ Choose Copy from the Windows

application’s Edit menu:

The text or graphics is put onto the Windows

clipboard.

➤ Switch to the Macintosh application you

want to use.

SmartCopy translates the text or graphics to

Macintosh format on the clipboard.

➤ Choose Paste from the Macintosh

application’s Edit menu to paste in the text

or graphics you copied.
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To copy text or graphics from
the Macintosh to Windows 95
➤ Select the text or graphics you want to copy.

➤ Choose Copy from the Macintosh

application’s Edit menu.

➤ Switch to RealPC.

SmartCopy translates the text or graphics to

Windows format on the Windows clipboard,

and you can use the Clipboard Viewer to

view it.

➤ Choose Paste from the Edit menu of the

Windows application you want to use, to

paste the text or graphics in.

To drag text from the
Macintosh to Windows 95
➤ Select the text you want to copy.

➤ Drag the text and drop it onto a Windows

document in RealPC.

The text will be typed into the document at the

current cursor position.

To copy graphics from the
Windows 95 desktop to the
Macintosh
➤ Hold down the C key.

The Windows mouse pointer changes to the

Macintosh mouse pointer.

➤ Press the mouse button, and drag to draw a

rectangle enclosing the section of the

Windows desktop you want to copy:

➤ Choose Copy from the RealPC Edit menu.
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The graphics will be put on the Macintosh

Clipboard and you can use Show Clipboard

on the Macintosh Edit menu to display it:

To drag graphics from the
Windows 95 desktop to the
Macintosh
➤ Hold down the C key.

The Windows mouse pointer changes to the

Macintosh mouse pointer.

➤ Press the mouse button, and drag to draw a

rectangle enclosing the section of the

Windows desktop you want to copy.

➤ Drag the selected area into the open window

of a Macintosh application that supports

drag and drop.

If you drag into a Finder window the graphic

will be saved as a Picture Clipping file:

Copying, pasting, and using drag and drop in Windows 95 Using Windows 95
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RealPC allows you to print to any printer

connected to your Macintosh, and take full

advantage of all of its features, including color.

By default RealPC is set up to use the Insignia

Printer Driver, which allows you to print from

Windows applications to any Macintosh printer.

If you have a PostScript printer you can get

improved performance and quality using the

RealPC PostScript option.

The Epson LQ-2500 option emulates a dot-

matrix printer on any Macintosh printer, if you

want fast draft printing.

The Direct Printing option allows you to print

directly to a PC printer using an appropriate

Macintosh printer driver selected in the

Chooser.

The options on the Printouts submenu on the

RealPC File menu allow you to specify when

printing from your Windows program is sent to

the printer.

Auto-Send… specifies that printing is

automatically sent to the Macintosh printer; this

is the default setting.

Wait for ‘Send’ specifies that output should

not be sent until you select Send to Printer.

To set up printing to any
Macintosh printer
➤ Select the printer connected to your

Macintosh or to your network in the

Macintosh Chooser.

➤ In Windows 95 click Start, then click

Settings and Printers.

The available printers are shown in the Printers

folder:

➤ Select Insignia Printer Driver and choose

Set As Default from the File menu.

The Insignia Printer Driver does not support

Windows shared printers.

Printing from Windows 95

Using Windows 95 Printing from Windows 95
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To set up printing to a
PostScript printer
➤ Select the PostScript printer connected to

your Macintosh or to your network in the

Macintosh Chooser.

➤ Choose RealPC Setup from the Setup menu

and click the Printer Port button to display

the currently-selected printer support:

➤ If necessary, select PostScript and choose

OK.

➤ In Windows 95 click Start, then click

Settings and Printers to display the

Printers folder.

➤ Select Apple LaserWriter, and choose Set

As Default from the File menu.

To set up printing using Epson
LQ-2500 emulation
➤ Choose RealPC Setup from the Setup menu

and click the Printer Port button to display

the currently-selected printer support:

➤ Select Epson LQ-2500 and choose OK.

➤ In Windows 95 click Start, then click

Settings and Printers to display the

Printers folder.

➤ Select Epson LQ-2500, and choose Set As

Default from the File menu.



129

To set up printing to a PC
printer
Macintosh printer drivers are available for a

wide range of PC printers from Infowave

Wireless Messaging Inc. They can also supply a

cable to connect a PC printer to a Macintosh.

For more information contact their Web site at:

http://www.gdt.com

➤ Select the appropriate printer driver in your

Macintosh chooser.

➤ Choose RealPC Setup from the Setup menu

and click the Printer Port button to display

the currently-selected printer support:

➤ Select Direct Printing and choose OK.

➤ Click Start, then click Settings and Printers

to display the Printers folder.

➤ Select an appropriate printer driver for your

PC printer, and choose Set As Default from

the File menu.

To print from Windows 95
➤ Print from the Windows application;

typically you do this by choosing Print…

from the File menu.

The application will first print to the RealPC

printing buffer. The printing information will

then be sent to the Macintosh printer. At this

point the Print dialog box for the Macintosh

printer will be displayed.

➤ Click Print to send the print job to the

printer.

Using Windows 95 Printing from Windows 95



130 Playing sound in Windows 95 Using Windows 95

RealPC emulates Sound Blaster and Windows

sound, allowing you to play Windows waveform

or MIDI files on your Macintosh. These are

identified with .WAV and .MID extensions,

respectively.

RealPC also supports ADPCM decompression,

to allow ADPCM sound files to be played in

RealPC.

You can choose an interesting sound for each

of the events that can occur in Windows using

the Sound control panel.

To use Windows sound you need to have

Windows Sound Driver or Sound Blaster

checked in the Sound panel of the RealPC

Setup dialog box; refer to Setting up sound,

page 61.

To adjust the volume and balance of RealPC

sound output you should use the controls in the

Macintosh Sound control panel.

To set up Windows 95 to play
MIDI files
To play MIDI files using the Macintosh sound

system you need to have the Midi Output pop-

up menu set to QuickTime in the Sound panel

of the RealPC Setup dialog box, and you need

to have the Macintosh QuickTime and

QuickTime Musical Instruments extensions

installed. For details refer to Other files on the

installation CD, page 25.

To play a sound or MIDI file
from Windows 95
➤ Click the Start button and click Programs,

Accessories, Multimedia, and Media

Player.

The Media Player window is displayed.

➤ Choose Open… from the Media Player File

menu, and select a waveform file, such as

Chord, or a MIDI file, such as Beethoven’s

Fur Elise:

➤ Click Open to load the file.

Playing sound in Windows 95
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➤ Click the Media Player play button to play

the file:

➤ Choose Exit from the File menu to exit from

Media Player.

To set sounds for Windows 95
events
➤ Open the Control Panel folder, by choosing

Control Panel from the Settings submenu

on the Start menu.

➤ Double-click the Sounds icon:

The Sound Properties dialog box is displayed.

➤ Select the Windows event you want to

identify with a sound.

The Name drop-down list box shows the

current waveform file assigned to that event, or

(none) if no sound is played.

➤ Select the waveform file you want to use.

➤ Click Preview to play the sound.

➤ When you have set up the sound you want

to play for each event click OK to exit from

the dialog box.

Using Windows 95 Playing sound in Windows 95
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Installing and running Windows 95 applications

Most Windows 95 applications are installed

using the standard Windows setup procedure.

Provided you have a CD-ROM or 3.5-inch disks

for your Windows application, the procedure is

similar to installing software on your Macintosh.

To install a Windows
application
➤ Insert the application’s installation CD-ROM

or floppy disk into the Macintosh drive.

➤ Click Start, then click Settings and Control

Panel.

➤ Double-click the Add/Remove Programs

icon.

This dialog box appears:

➤ Click Install… to start the installation.

The installation program locates the installer on

the disk you inserted:

➤ Click Finish to run the installer.

As the installation proceeds, dialog boxes will

prompt you for any information needed for the

installation.

To run a Windows application
➤ Click Start, then click Programs.

➤ Point to the folder containing the program,

and then click the program.

To run a Windows 95
application from the Macintosh
RealPC’s EasyLaunch feature lets you run a PC

application simply by double-clicking an icon

on your Macintosh.

➤ Set up the E: drive as a Macintosh shared

folder.

For more information refer to Sharing PC files

between RealPC and the Macintosh, page 49.

➤ Copy the application file to the E: drive.

You can now automatically run RealPC and

Windows 95, and then run the Windows

application, by double-clicking the icon.
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Networking with
RealPC

RealPC includes Insignia’s network drivers to enable you to share

files with other PCs, or run multi-user applications on a network.

This chapter gives full details of how to set up networking within

MS-DOS, Windows 3.x, and Windows 95.
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RealPC offers you the same network

functionality as any PC, enabling you to install a

wide variety of PC networking packages. This is

achieved using Insignia’s network drivers which

operate over both Ethernet and Token-Ring

networks.

As the installation of PC network packages

differs between MS-DOS/Windows 3.x and

Windows 95, this chapter begins with a brief

description of the network interfaces supported

within RealPC followed by instructions on how

to install PC networking packages within these

operating systems.

Network interfaces
In a PC networking environment, the operating

system does not communicate directly with the

network card itself, but through a software

interface called a network driver. Modern

network drivers and communication protocols

are written to common interface standards,

allowing multiple protocol stacks to be used

with any network interface driver written to the

same standard.

Currently the most popular standards are the

Network Driver Interface Specification (NDIS,

developed by Microsoft and 3COM), and the

Open DataLink Interface (ODI, developed by

Novell and Apple).

Another driver standard is Winsock, which is

one of the most popular PC network interfaces

for TCP/IP applications.

RealPC is supplied with the following drivers for

both Ethernet and Token-Ring networks:

■ NDIS, V3.1 miniport, Windows 95 only.

■ ODI, 16-bit real mode.

■ Winsock, V1.1, 16-bit and 32-bit.

All the RealPC networking drivers are stored in

the C:\INSIGNIA directory, and have the

following filenames:

Network driver Filename

Ethernet NDIS ISETH.SYS

Token-Ring NDIS ISTOK.SYS

Ethernet ODI ETHERSPC.COM

Token-Ring ODI TOKENSPC.COM

Winsock (16-bit) WINSOCK.DLL

Winsock (32-bit) WSOCK32.DLL

Since the Insignia ODI and NDIS drivers access

the same physical network interface they

cannot be used simultaneously.

Introduction
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Requirements for network
support
RealPC network drivers (NDIS, ODI, Winsock)

work with both of Apple’s Classic and Open

Transport network architectures. The preferred

network architecture for RealPC is Open

Transport (v1.1.1 and above), the installer for

which can be found on the RealPC installation

CD. Please consult the Open Transport readme

file for system requirements.

If you are planning to use the DECnet protocol

you will need to override your built-in Ethernet

address. Refer to DECnet Address Override,

page 166, for details.
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Networking with MS-DOS and Windows 3.x

The following section describes the

configuration of networking within MS-DOS and

Windows 3.x.

RealPC is supplied with 16-bit Winsock (V1.1)

support pre-installed. This allows any Winsock-

compliant application to be used without re-

configuring Windows 3.x.

If you need to access local area network servers

Windows 3.x should be configured to use the

RealPC ODI network drivers. The configuration

and use of the Insignia ODI drivers are outlined

in the following sections.

Using Insignia ODI drivers
In order to support any networking protocols

from within Windows 3.x, the Insignia ODI

driver must first be loaded from MS-DOS.

However, the ODI driver cannot simply be

loaded in isolation as it is only part of a network

environment which must be loaded in entirety

to provide network connectivity.

RealPC is supplied with the MS-DOS component

of the Novell NetWare 4 client pre-installed in

the C:\NWCLIENT directory. This client not

only provides access to Novell NetWare servers,

but also the necessary files to enable other

networking protocols to be supported within

Windows 3.x.

In general the following stages are required to

provide network support within Windows 3.x:

■ Load the ODI system files from MS-DOS.

■ Configure the ODI system to support the

required network client.

■ Install the required network client.

■ Ensure that Windows 3.x is configured to

support the new client.

These are explained in detail in the following

sections.

Loading the ODI system files from MS-DOS

The ODI system can be started by using the

following sequence of steps from within the

C:\NWCLIENT directory:

➤ Start the Link Support Layer with the

command:

LSL R

The Link Support Layer should load and display

its configuration as shown below:

C:\NWCLIENT>lsl

NetWare Link Support Layer v2.16 (950417)

(C) Copyright 1990-1995 Novell, Inc. All Rights Reserved.

BUFFERS 8 4210

MEMPOOL 8192

The configuration file used was "C:\NWCLIENT\NET.CFG".

Max Boards 4, Max Stacks 4

Buffers 8, Buffer size 4210 bytes, Memory pool 8192 bytes.

Networking with MS-DOS and Windows 3.x Networking with RealPC
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➤ Start the Insignia ODI driver for the Ethernet

or Token-Ring network by typing one of the

following commands:

ETHERSPC R

or

TOKENSPC R

The Insignia ODI driver will also display its

configuration, which may vary, on startup as

shown below.

➤ The above drivers may be added to your

C:\AUTOEXEC.BAT file.

Configure the ODI system to support the

required network client

The Insignia ODI drivers are configured by the

C:\NWCLIENT\NET.CFG file. By default this is

set to support both Ethernet and Token-Ring,

with the frame types set to ETHERNET_802.2

and TOKEN-RING, respectively, for both Novell

NetWare and Microsoft Networking. If your

network has different characteristics you will

need to edit the file to select the appropriate

options.

C:\NWCLIENT>etherspc

Insignia Ethernet MLID v2.00E (950908).

(C) Copyright 1991-1995 Insignia Solutions Inc. All Rights Reserved.

IRQ 10, Node Address 800690895E2 L

Max Frame 1514 bytes, Line Speed 10 Mbps, Bus ID 0

Board 1, Frame ETHERNET_802.2, LSB Mode

Board 2, Frame ETHERNET_II, LSB Mode

Board 3, Frame ETHERNET_SNAP, LSB Mode

Board 4, Frame ETHERNET_802.3, LSB Mode

To change the options:

➤ Comment out the current setting by inserting

a semicolon in front of the line and

removing the semicolons from the lines you

require.

Refer to Configuring ODI drivers, page 157, for

more details.

ODI to NDIS converter

Some Windows 3.x network clients simply

cannot support ODI drivers, most however will

support NDIS. Novell supply an NDIS to ODI

converter (ODINSUP) as part of the NetWare 4

client which provides an interface between

NDIS protocol stacks and the ODI system. With

this utility you may run NDIS networking

packages, such as Microsoft Client 3.0 and LAN

Manager with RealPC ODI drivers.

ODINSUP works by registering itself with the

Link Support Layer as an ODI protocol stack,

while appearing to NDIS protocol stacks as an

NDIS driver.

ODINSUP can be found in the NWCLIENT
directory.
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Configuring NDIS
Because ODINSUP is loaded before any of the

NDIS software it does not know which frame

types will be used by NDIS applications. It is

therefore necessary to enable all generally used

frame types in the NET.CFG file.

Example

The following example shows the NET.CFG file

for LAN Manager on Ethernet, using the

NetBEUI (SMB) protocol:

Link Support

Buffers 10 1518

Protocol ODINSUP

Bind ETHERSPC

Buffered

Link Driver ETHERSPC

Frame ETHERNET_802.2

Frame ETHERNET_802.3

Frame ETHERNET_II

Frame ETHERNET_SNAP

Protocol SMB F0 ETHERNET_802.2

Starting NDIS
To start the NDIS system proceed as follows:

➤ First start the ODI system in the usual way, by

typing:

LSL R
ETHERSPC R

➤ Start the ODI Support Layer by typing:

ODINSUP R

Setting up Novell NetWare with
MS-DOS or Windows 3.x
The Novell NetWare 4 client supplied with

RealPC is already set up for use with MS-DOS or

Windows 3.x.

The NET.CFG file is supplied set up for both

Ethernet and Token-Ring, with the default frame

types set to ETHERNET_802.2 and

TOKEN-RING_802.2 respectively.

If your network has different characteristics you

will need to edit the file to select the

appropriate options. To change the options,

comment out the current setting by inserting a

semicolon in front of the line, and remove the

semicolons from the lines you require.

➤ Edit the C:\AUTOEXEC.BAT file to include

the following lines:

CD C:\NOVELL
LSL
ETHERSPC
ISIPXODI
VLM /PS=servername
CD:
L:

where servername is the name of the server

you want to use.

Replace ETHERSPC by TOKENSPC if you are

using Token-Ring.

For information about editing files under

MS-DOS refer to Editing configuration files,

page 96.
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➤ Restart Windows.

Batch files ETHER.BAT or TOKEN.BAT are

provided in the C:\INSIGNIA directory, which

will execute the above steps with a single

command.

To list the servers
Once you have connected to the server you can

list the servers on the network by typing the

following command at the file server prompt:

NLIST R

A list of available servers will be displayed.

Installing Microsoft Network
client
This section describes how to configure

Microsoft Network Client 3.0 to work correctly

with RealPC. It includes setup instructions for

both the NetBEUI and TCP/IP protocols.

Ensure your Macintosh can connect to the

network card by selecting Ethernet or Token-

Ring in the AppleTalk control panel in Open

Transport or EtherTalk or TokenTalk in the

Network control panel in Classic AppleTalk. (If

this cannot be accomplished please consult

your information services department or call

Apple Technical Support at 1-800-SOS-APPL for

assistance).

When using Microsoft Network Client 3.0 with

the TCP/IP protocol in RealPC, simultaneous IP

(Internet protocol) connections are only

possible on a Power Macintosh using Open

Transport 1.1.1 (in the PC Extras folder on the

RealPC CD-ROM) through Open Transport’s

Multisession IP feature. This configuration

requires that a separate IP configuration be

used in the Microsoft Network Client 3.0 than

what is used on the Macintosh.

The Open Transport Multisession IP feature will

not work with RealPC when running on a Power

Macintosh with a version of Open Transport

earlier than 1.1.1 or with Classic AppleTalk. In

order to use the TCP/IP protocol from RealPC

on a Power Macintosh using an earlier version

of Open Transport or Classic AppleTalk,

MacTCP or TCP/IP must be disabled. (If you do

not disable MacTCP or TCP/IP, you will get error

messages which state that the Protocol IP and

Protocol ARP are already in use.)

To disable MacTCP or TCP/IP, either use the

Extensions Manager control panel, or drag the

MacTCP (or TCP/IP) Control Panel out of the

Control Panels folder and place it on the

Desktop (or any folder except for the Control

Panels and Extensions folders). You must

restart your Macintosh for this change to take

effect.

These instructions assume that you have RealPC

installed and that you are familiar with the

MS-DOS Editor. You will also need to have the

RealPC CD-ROM available.

1. Start RealPC.

2. Insert the RealPC CD-ROM into your CD

drive.
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3. On the Macintosh desktop drag the icon of

the folder msclnt3 in the PC Extras:clients

folder on the RealPC CD, onto the RealPC

window. This will assign this folder to

drive E:.

4. Create a new folder on your RealPC hard

disk by typing the following at the command

prompt:

MKDIR msclnt3 R

5. Copy the contents of the folder on the

RealPC CD to your RealPC Hard Disk File

by typing the following at the command

prompt:

COPY E:\*.* c:\msclnt3 R

You are now ready to install the Microsoft

Network Client.

6. The CONFIG.SYS file must be modified to

initially remove the Mac/PC Shared folder

feature. This will be replaced later. Type the

following:

EDIT C:\CONFIG.SYS R

Delete the following line:

device=C:\Insignia\host.sys

7. The AUTOEXEC.BAT file must be modified

to initially remove the Mac/PC Shared

folder feature. Type the following:

EDIT C:\AUTOEXEC.BAT R

Delete the following line:

c:\insignia\fsadrive e: g: h:

8. If you have installed Windows 3.x, the Novell

NetWare configuration needs to be removed

from the Windows step. Use the following

procedure to do so:

➤ At the C:\> prompt, type WIN R.

➤ Double-click the Windows Setup icon in

the Main program group.

➤ Select Change System Settings… from the

Options menu.

➤ Using the pull-down menu for Network,

select No Network Installed.

➤ Click OK.

➤ Click Continue.

➤ Click OK.

➤ Select Exit from the Options menu to exit

from Windows.

9. Restart RealPC by selecting Restart RealPC

from the Setup menu.

10. At the command prompt type the following:

c:\msclnt3\setup R

11. At the first screen, press R to continue.

12. The next screen prompts you for the location

where Microsoft Network Client should be

installed. Select the default, C:\NET, and

press R.
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13. When prompted to select an adapter from

the list below, select the final option, ODI/

NDIS Support Driver (this will be setup

later).

14. When prompted, enter your username for

your network (this information usually is

supplied by a system administrator or

information systems department).

15. The next dialog is used to change some of

the setup options, such as the Mail and

Sharing options. If help is required in

choosing the proper options, press l or refer

to the network administrator for your

Microsoft Network.

➤ Select Change Names and modify entries

per the network administrator.

➤ Select Change Setup Options and modify

entries per the network administrator.

16. To setup Microsoft Network Client to use the

NetBEUI protocol, proceed to Step 17. To

setup the client software to use the TCP/IP

protocol, proceed to Step 18. To setup the

client software to use both the NetBEUI and

TCP/IP protocols, proceed to Step 19.

17. If the network driver needs to be initialized

using the NetBEUI protocol, do the

following:

➤ Select Change Network Configuration at

the Setup Options screen. The ODI/NDIS

Support Driver will be selected.
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➤ Use the Tab to switch to the Installed

Network Adapter(s) and Protocol(s)

menu.

➤ Select NWLink IPX Compatible Transport

and Tab back to the Options menu.

➤ Select Remove and press R.

➤ Select Microsoft NetBEUI and press R.

➤ Select Network configuration is correct

and press R.

➤ Select The listed options are correct and

press R.

➤ Setup will now prompt you for the location

of ODINSUP.COM. Type the following in the

location box:

C:\NWCLIENT R

➤ Proceed to step 20.

18. If the network driver needs to be initialized

using the TCP/IP protocol, do the following:

➤ Select Change Network Configuration at

the Setup Options screen. The ODI/NDIS

Support Driver will be selected.

➤ Use the Tab to switch to the Installed

Network Adapter(s) and Protocol(s)

menu.

➤ Select NWLink IPX Compatible Transport

and Tab back to the Options menu.

➤ Select Remove and press Enter.

➤ Select Microsoft TCP/IP and press Enter.
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➤ Use the Tab to switch to the Installed

Network Adapter(s) and Protocol(s)

menu.

➤ Select Microsoft TCP/IP and Tab back to

the Options menu.

➤ Select Change Settings and press Enter.

➤ You will need to configure your IP

information before proceeding. If help is

required, refer to the network administrator

for your Microsoft or TCP/IP network.

➤ Select Settings are correct and press R.

➤ Select Network configuration is correct

and press R.

➤ Select The listed options are correct and

press R.

➤ Setup will now prompt you for the location

of ODINSUP.COM. Type the following in the

location box:

C:\NWCLIENT R

➤ You will be prompted to enter the path to

the OEM driver setup. Type the following in

the location box:

C:\msclnt3 R

➤ Proceed to step 20.

19. If the network driver needs to be initialized

using the NetBEUI and TCP/IP protocols, do

the following:

➤ Select Change Network Configuration at

the Setup Options screen.

➤ The ODI/NDIS Support Driver will be

selected.

➤ Use the Tab to switch to the Installed

Network Adapter(s) and Protocol(s)

menu.

➤ Select NWLink IPX Compatible Transport

and Tab back to the Options menu.

➤ Select Remove and press R.

➤ Select Microsoft NetBEUI and press R.

➤ Select Add Protocol and press R.

➤ Select Microsoft TCP/IP and press R.

➤ Use the Tab to switch to the Installed

Network Adapter(s) and Protocol(s)

menu.

➤ Select Microsoft TCP/IP and Tab back to

the Options menu.

➤ Select Change Settings and press R.

➤ You will need to configure your IP

information before proceeding. If help is

required, refer to the network administrator

for your Microsoft or TCP/IP network.

➤ Ensure that the settings are correct and press

R.

➤ Select Network configuration is correct

and press R.

➤ Select The listed options are correct and

press R.
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➤ Setup will now prompt you for the location

of ODINSUP.COM. Type the following in the

location box:

C:\NWCLIENT R

➤ You will be prompted to enter the path to

the OEM driver setup. Type the following in

the location box:

C:\msclnt3 R

➤ Proceed to Step 20.

20. Setup will complete the installation.

21. When prompted to restart or press the 3

key, press 3 to exit without restarting. You

will now need to make changes to the

configuration files.

22. The AUTOEXEC.BAT file must be modified

to load the ODI drivers. Type the following:

EDIT C:\AUTOEXEC.BAT R

Add the following lines at the beginning of the

file (if using Token-Ring network enter

TOKENSPC in place of ETHERSPC):

cd C:\NWCLIENT
LH lsl
LH etherspc
cd ..

Add the following lines after C:\NET\net
start:

c:\insignia\devlod.com
c:\insignia\host.sys
c:\insignia\fsadrive e: g: h:
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Save the changes made to the AUTOEXEC.BAT
file.

23. The CONFIG.SYS file must be modified to

load the Microsoft protocol manager drivers.

Type the following:

EDIT C:\CONFIG.SYS R

Modify the CONFIG.SYS file so that it matches

the working example that follows:

FILES=30

BUFFERS=15,0

DOS=high,umb

FCBS=20,0

device=c:\dos\himem.sys /TESTMEM:OFF

device=c:\insignia\host.sys

device=c:\insignia\cdrom.sys

device=c:\insignia\aspidos.sys

device=c:\insignia\aspidisk.sys /d

REM device=c:\insignia\aspicd.sys /d:cdrom$$$ /

norst

device=c:\dos\setver.exe

lastdrive=z

STACKS=9,256

DEVICE=C:\NET\ifshlp.sys

Save the changes made to the CONFIG.SYS file.

24. The NET.CFG file must be modified. Type

the following:

EDIT C:\NWCLIENT\NET.CFG R
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Modify your NET.CFG file to read as follows if

running on an Ethernet network:

   PROTOCOL ODINSUP
         BIND ETHERSPC

         BUFFERED

    LINK DRIVER ETHERSPC

         FRAME Ethernet_8Ø2.2

         FRAME Ethernet_II

         FRAME Ethernet_SNAP

         FRAME Ethernet_8Ø2.3

         Protocol SMB FØ ETHERNET_8Ø2.2

         PROTOCOL IP 8ØØ ETHERNET_II

         PROTOCOL ARP 8Ø6 ETHERNET_II

Modify your NET.CFG to read as follows if

running on a Token-Ring network:

   PROTOCOL ODINSUP
         BIND TOKENSPC

         BUFFERED

    LINK DRIVER TOKENSPC

         FRAME TOKEN-RING

         FRAME TOKEN-RING_SNAP

         PROTOCOL SMB f0 TOKEN-RING

         PROTOCOL IP 800 TOKEN-RING_SNAP

         PROTOCOL ARP 806 TOKEN-RING_SNAP

Save the changes made to the NET.CFG file.

25. The PROTOCOL.INI must be modified to

set the correct bindings. Type the following:

EDIT C:\NET\PROTOCOL.INI R

Networking with MS-DOS and Windows 3.x Networking with RealPC

Change all occurrences of ODINSUPMAC to

ETHERSPC (for Ethernet) or TOKENSPC (for

Token-Ring).

Add the following sections to the end of the

PROTOCOL.INI (for an Ethernet network):

[Link Driver]

data=FRAME Ethernet_8Ø2.3

data=FRAME Ethernet_8Ø2.2

data=FRAME Ethernet_II

data=FRAME Ethernet_SNAP

Add the following sections to the end of the

PROTOCOL.INI file (for a Token-Ring

network):

[Link Driver]

data=FRAME TOKEN-RING

data=FRAME TOKEN-RING_SNAP

Save the changes made to the PROTOCOL.INI
file.

26. Remove any floppy diskettes or CD-ROM and

restart RealPC by selecting Restart RealPC

from the Setup menu.

RealPC should now be configured correctly to

work with Microsoft Network Client 3.0.

Installing non-supplied network clients

Whichever network client you wish to install it

is best to follow the manufacturer’s installation

instructions. Configure the client to use ODI

drivers wherever possible.
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During the network client’s installation

process you may be asked if you want

Windows to be updated to support the

client. This will allow network printers and

services to be accessed from within the

Windows environment. It is strongly

recommended that this is done. Refer to the

network client’s installation documentation

for more information.
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The following section describes the

configuration of networking within Windows 95.

Windows 95 can be configured to use either the

RealPC NDIS or ODI network drivers. It is

recommended that the NDIS drivers are used

where possible as they are Windows 95 specific

and offer the best performance. Note also that

some third-party clients and protocol stacks

must be installed via NDIS drivers. The

configuration of the Insignia NDIS and ODI

drivers are outlined in the following sections.

RealPC is supplied with both 16-bit and 32-bit

Winsock (1.1) support pre-installed. This allows

any Winsock-compliant application to be used

without re-configuring Windows 95. If you need

to access local area network servers,

Windows 95 must be re-configured to access the

host’s network device, either via NDIS or ODI.

If you wish to use MacIPX and also to have

NetWare connectivity within RealPC,

Windows 95 must be set up using the Insignia

ODI drivers and Novell’s NetWare 4 client. For

more information refer to Simultaneous protocol

support, page 163.

To use Insignia NDIS drivers
To use the RealPC NDIS driver with the standard

Microsoft Windows 95 clients, follow the

instructions below. To use the NDIS driver with

other Windows 95 network clients, follow the

application installation instructions, installing

the Insignia NDIS driver as described below

when required.

➤ Ensure that the Windows 95 upgrade CD is

available to RealPC.

➤ Click the Start button, point to Settings,

and then click Control Panel.

➤ Double-click the Network icon in the

Control Panel folder.

The Network dialog box is displayed.
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➤ If any existing drivers are displayed, select

them and click Remove.

➤ Click Add….

➤ Select Adapter and click Add….

A number of network adapter cards will be

presented.

➤ Select Insignia Solutions.

➤ Select Ethernet Driver or Token-Ring

Driver, as appropriate, and click OK.
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➤ Ensure that Enhanced Mode (32 bit and

16 bit) NDIS driver is selected.

➤ Click OK to return to the Network dialog

box.

➤ If you require additional protocols and

clients add these in a similar way.

➤ Remove any protocols and clients you do

not need, and click OK.

The Network dialog box should now include

the following items:

Windows 95 adds the IPX/SPX and NetBEUI

protocols and the Microsoft and NetWare

clients by default.

The RealPC network driver can be configured to

be either NDIS (default) or ODI. To ensure that

the NDIS driver has been chosen:

➤ Select the Insignia Network Driver and click

Properties.
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➤ Select the Identification tab.

➤ Select a unique Computer name, the

Workgroup you wish to be a member of,

and a Computer Description for RealPC.

Other users identify your RealPC installation

from these settings. An informative Computer

name and Computer Description can help

when attempting to share network resources.

➤ Once you are sure that the configuration is

complete click OK.

➤ When a dialog box appears asking you to

confirm the resource allocation for the

driver, accept the default (IRQ 10), and click

OK.

Windows 95 will now download the appropriate

software and drivers. You may be prompted to

supply the location of the Insignia network

drivers, in which case specify C:\INSIGNIA.

The following dialog box will then appear:

➤ Click Yes to restart Windows 95.

After restarting Windows 95, double-click the

Network Neighborhood icon on the

Windows 95 desktop to list the servers and

machines that are visible to your computer.

To view all the network resources available to

your machine, double-click the Entire

Network icon.
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To use Insignia ODI drivers
This section describes how to configure

Windows 95 to use the Insignia ODI drivers,

although this is not the recommended solution.

You should use this option if you are not

using MacIPX. If you are using MacIPX refer

to To install the Novell NetWare Workstation

VLM Shell below.

TurboStart is not available if you are using

ODI networking with Windows 95.

➤ Follow the steps described in the To use

Insignia NDIS drivers, page 146, but select

the Real mode (16 bit) ODI driver from

the list of supported network drivers in the

RealPC Network Driver Properties dialog

box.

➤ When asked whether you want to restart

Windows 95 click No.

Even though Windows 95 has now been set up

as required, the Insignia ODI driver needs to be

configured to support the protocols and clients

selected.

The Insignia ODI drivers are configured through

the C:\WINDOWS\NET.CFG file. By default this

is set to support both Ethernet and Token-Ring,

with the frame types set to ETHERNET_802.2

and TOKEN-RING, respectively, for both Novell

NetWare and Microsoft Networking; these are

the same default protocols as those chosen by

Windows 95 during the network set-up.

If your network has different characteristics you

will need to edit the NET.CFG file to select the

appropriate options. To change the options,

comment out the current setting by inserting a

semicolon in front of the line and remove the

semicolons from the lines you require. Refer to

Configuring ODI drivers, page 157, for more

details.

To install the Novell NetWare
Workstation VLM Shell
This section describes how to add Novell’s

Workstation Shell (VLMs) network support to

Windows 95. You should only use this option if

you are using MacIPX.

You may wish to consult your NetWare system

administrator for the correct frame type to use.

➤ Run Windows 95.

➤ When the message Starting
Windows 95… appears, press 8

(C keypad 8 on the Macintosh).
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➤ Select Command Prompt only and press

R to proceed.

➤ Choose RealPC Setup… from the Setup

menu, and click the Shared Folders button.

➤ Set up the E: drive as the nw4clnt folder on

the RealPC installation CD. It is located in

the PC Extras folder in the clients folder.

➤ At the MS-DOS C:\> prompt type:

E:      R

➤ Type INSTALL R.

➤ Using the ^ and V keys to navigate

through this screen, select the following

options:

1. Select the default option: C:\NWCLIENT.

2. Select the default option: Yes.

3. Select Yes for Windows support and specify

the Windows directory.

4. Select the default option: No.

5. Press R to display the list of available

drivers. Scroll down to the bottom of the

driver list, select OTHER DRIVERS, and

press R.

Networking with RealPC Networking with Windows 95



152

➤ In the following dialog box enter

C:\INSIGNIA and press R.

➤ Select the appropriate ODI driver (Ethernet

or Token-Ring) and press R.

➤ Select which frame type you wish to use.

➤ When you have selected the required value

press ) (C Keypad-0 on the Macintosh)

to save.

➤ Select option 6 and press R to install.

Various files will be copied onto your hard disk.

➤ If prompted to Use version on installation

diskette, select No.

➤ When the installation is complete choose

Reset RealPC from the Setup menu to

restart RealPC.

Networking with Windows 95 Networking with RealPC



153

On restarting, Windows 95 will encounter the

following problem. This is because the

Windows 95 component of the Netware Client

has not yet been installed:

➤ Press any key to continue.

When Windows 95 has started double-click the

Network icon in the Control Panel folder.

➤ Click Add….

➤ Select Client and click Add….

➤ Select Novell and select Novell Netware

(Workstation Shell 4.0 and above).
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➤ Click OK.

➤ Select the Identification tab and identify

your RealPC as described earlier.

The Network control panel now shows the

items you have installed:

➤ Click OK.

Windows 95 will now download the appropriate

software to your hard disk.

For changes to take effect you will be asked

whether you wish to restart Windows 95.

➤ Click Yes.
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PPP connections with Microsoft
Dial-Up Adapter
This section describes how to configure PPP

with Windows 95.

These instructions assume that you have

Windows 95 installed and running.

➤ Insert the Microsoft Windows 95 upgrade

CD-ROM.

Setting up the appropriate drivers

➤ Click the Start button, point to Settings, and

then click Control Panel.

➤ Double-click the Network icon in the

Control Panel folder.

➤ When the Network dialog box appears,

select Adapter and click Add….

➤ Select Microsoft from the Manufacturers

list, select Dial-Up Adapter from the

Network Adapter list and click OK to add

it.

➤ From the Network dialog box, click Add….

Select Protocol and click Add….

➤ Select Microsoft from the Manufacturers

list, select TCP/IP from the Network

Protocols list and click OK to add it.

➤ Highlight TCP/IP and click Properties.

➤ If your Internet Service Provider

automatically assigns an IP address each

time you dial in, leave the defaults. If your

ISP requires that you specify your

IP configuration, click Specify an IP

address to complete the IP Address and

Subnet Mask according to the ISP’s

configuration instructions.

Also complete the DNS Configuration Gateway

and set the WINS Configuration to Disable

WINS Resolution according to the ISP’s

configuration instructions.

If you are logging into a Microsoft network via

modem:

➤ Verify the Identification items by clicking on

the Identification tab and completing the

Computer Name and Workgroup fields. Also,

turn on File Sharing by clicking on File and

Print Sharing.

➤ Highlight Client for Microsoft Networks

and click on Properties.

➤ Check the box to Log on to Windows NT

domain and enter your domain.

Auto detecting your modem

➤ From the Control Panels, select Modems

and Add…, Next>, and let it Auto Detect

your Modem. Click on Dialing Properties

and complete the fields.
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➤ In My Computer, double-click on Dial-Up

Networking. If the setup Wizard does not

start automatically, double-click on New

Connection.

➤ Click on Next>, name your connection and

select your modem.

➤ Click on Next>. Enter your Area Code and

Phone Number and click on Next>. Click on

Finish to create your connection.

➤ In My Computer, select Your Connection.

Enter your User Name and Password.

Verify your phone number and click on

Connect.

When the connection is made, RealPC will be

configured to work with your Internet

applications.

Troubleshooting

If you cannot Connect or Ping, verify the IP

addresses in your Network Control Panel.

Configuring NDIS drivers
The Windows 95 registry holds various

configuration settings for the RealPC NDIS

drivers. Although these settings can be modified

by editing the registry, the preferred approach is

by the Network icon within the Windows 95

Control Panel. The network settings can be

viewed by performing the following steps:

➤ Click the Start button, point to Settings, and

then click Control Panel.

➤ Double-click the Network icon in the

Control Panel folder.

To access the RealPC NDIS driver’s Advanced

settings:
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➤ Select the RealPC NDIS driver and click on

Properties.

➤ Select the Advanced tab to view the NDIS

driver’s settings:

The following Advanced settings are defined;

note that some are Token-Ring specific.

Maximum Packet Size (Token-Ring only)

This option allows the RealPC Token-Ring NDIS

driver to be configured to support a smaller

packet size defined by the host’s network

device. By default this is set to 4096 bytes. Note

that a size greater than that supported by the

host will be ignored.

On-the-fly Packet Filtering

In normal operation the RealPC NDIS drivers

filter received packets on-the-fly. That is, that

they only receive packets of protocol types

which they have previously transmitted. In some

circumstances this could cause a slight

degradation in performance, and the

functionality of the NDIS drivers can be

changed to disable this on-the-fly filtering

technique. Disabling this functionality can stop

network packets being received by Windows 95

if care is not taken.

If On-the-fly Packet Filtering is disabled valid

Protocol Overrides must be supplied.

Ring Speed (Token-Ring only)

The RealPC Token-Ring NDIS driver uses

whatever the host Token-Ring network card is

configured to. This advance setting is provided

for information only.
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Protocol Override 1–5

Five Protocol Override settings are provided.

These force the RealPC NDIS drivers to enable

the selected protocol types.

The following table shows how to enable

specific frame/protocol types:

Frame Type Value format Example

Ethernet_II xxxx 0806

Ethernet_802.2 xx F0

Ethernet_802.3 FF FF

Ethernet_SNAP AAxxxxxx AA008137

Token-Ring xx E0

Token-Ring_SNAP AAxxxxxx AA000800

Where x represents a hex digit.

Note that ALL protocols must be added. For

example, to enable TCP/IP you must enable

both IP (0800) and ARP (0806). If On-the-fly

Packet Filtering is enabled the protocol

overrides are ignored.

Configuring ODI drivers
The ODI system is configured through a single

file, NET.CFG.

The NET.CFG file is divided up into sections,

each of which provides parameters to configure

a different part of the ODI system. Each section

of the file begins with a section heading at the

start of the line, followed by a series of tab-

indented configuration options under the

section heading.

The following example shows a simple

NET.CFG file:

LINK SUPPORT

BUFFERS 8 1500

MEMPOOL 8192

LINK DRIVER ETHERSPC

FRAME ETHERNET_II

PROTOCOL IPX 8137 ETHERNET_II

These sections are described in detail below.

LINK SUPPORT

The LINK SUPPORT section of the NET.CFG
file is used to configure the Open Data-link

Interface Link Support Layer (LSL.COM). This

section is only needed when protocols require a

non-default configuration.

Networking with RealPC Networking with Windows 95
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LINK DRIVER

The LINK DRIVER section is the most

important part of the NET.CFG file for

configuring RealPC. The options set in this

section govern the interface between the driver

and the rest of the system, the protocols

registered with the network interface, and the

format of packets transmitted and received.

There are also numerous other configuration

options associated with the network interface

card, but most of these are not relevant to

RealPC.

The following options are the most important

for RealPC:

FRAME

Syntax: FRAME frame-type

This configuration option enables a particular

frame type.

PROTOCOL

Syntax: PROTOCOL name protocolID
 frame-type

This configuration option enables a particular

protocol to be used with a particular frame type.

The RealPC ODI driver will only receive network

packets for those protocols enabled within the

NET.CFG file.

MAX PACKET SIZE

Syntax: MAX PACKET SIZE value

Some platforms limit the size of packets which

can be transmitted. This option is only offered

to resolve any platform-specific limitations

which may occur in the future.

The default sizes are as follows:

Network Default max packet size

Ethernet 1514

Token-Ring 4210

Example

A sample LINK DRIVER section is as follows:

LINK DRIVER ETHERSPC

FRAME ETHERNET_802.2

FRAME ETHERNET_II

FRAME ETHERNET_802.3

FRAME ETHERNET_SNAP

PROTOCOL IPX 8137 ETHERNET_II

LINK DRIVER TOKENSPC

FRAME TOKEN RING

FRAME TOKEN RING_SNAP

PROTOCOL IPX 8137 TOKEN-RING_SNAP

MAX PACKET SIZE 4210
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The FRAME lines in this LINK DRIVER section

allow all four Ethernet and two Token-Ring

frame types to be used with the driver. It is

recommended that you always include all

frame types in the LINK DRIVER section to

allow the driver to transmit and receive frames

in any of the common hardware packet formats.

Note that the order of the lines is not significant.

A configuration such as this prevents any

FRAME and PROTOCOL mismatches occurring,

and also makes configuring both ODI and NDIS

(over ODI via the ODINSUP shim) identical.

The MAX PACKET SIZE option limits the size of

any packets being transmitted and is only

provided to solve platform-specific

implementations in which the host is not able to

transmit full size raw packets.

Since the RealPC ODI drivers (ETHERSPC,

TOKENSPC) and the other Novell ODI

components all obtain their configuration data

from the NET.CFG file, it is important that they

all reference the same NET.CFG file. It is

recommended that all the ODI components are

loaded from the directory which contains the

NET.CFG file, usually C:\NWCLIENT. For

example:

CD \NWCLIENT
LSL
ETHERSPC
IPXODI
VLM

Configuration issues
IRQ level

Some network client software needs to know

the interrupt number of the ODI driver during

installation and configuration. RealPC ODI and

NDIS drivers use IRQ 10 (decimal).

ODI frame types
The following sections provide information on

the FRAME types and PROTOCOL entries

required in the NET.CFG file for common

network clients and RealPC.

Windows 95/Microsoft LAN Manager/

Windows for Workgroups

PROTOCOL SMB F0 ETHERNET_802.2
PROTOCOL SMB F0 TOKEN RING

Novell NetWare

PROTOCOL IPX E0 ETHERNET_802.2
PROTOCOL IPX 8137 ETHERNET_II
PROTOCOL IPX 8137 ETHERNET_SNAP
PROTOCOL IPX 0 ETHERNET_802.3
PROTOCOL IPX E0 TOKEN RING
PROTOCOL IPX 8137 TOKEN RING_SNAP

Novell’s Protocol Burst support

Although by default this feature is disabled, it is

possible to increase the performance of the

NetWare 4 client within RealPC by enabling

Novell’s Protocol Burst support for use with the

RealPC ODI driver. This should only be enabled

when accessing NetWare 4 servers via the

NetWare 4 client as no increase in performance

will be seen in other circumstances.
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To enable Protocol Burst support the RealPC

NET.CFG file must be edited. Remove the ;
(semi-colon) at the beginning of the following

line:

; MAX IPG = 1

Change the value of PB BUFFERS from 0 to 7.

Protocol Burst support will now be enabled

whenever the NetWare 4 VLM client is loaded.

TCP/IP connectivity

PROTOCOL IP 800 ETHERNET_II
PROTOCOL ARP 806 ETHERNET_II
PROTOCOL IP 800 TOKEN RING_SNAP
PROTOCOL ARP 806 TOKEN RING_SNAP

Banyan VINES

PROTOCOL VINES BAD ETHERNET_II
PROTOCOL VINES BC TOKEN RING

Where two or more protocols of the same frame

type are provided for the network client, all

must be present in the NET.CFG file for the

client to work correctly. For example, for the

Microsoft network client to work over TCP/IP,

and for access to NetWare servers to be

enabled, the following must be defined in the

Ethernet section of the NET.CFG file:

LINK DRIVER ETHERSPC
FRAME ETHERNET_II
PROTOCOL IP 800 ETHERNET_II
PROTOCOL ARP 806 ETHERNET_II
PROTOCOL IPX 8137 ETHERNET_II
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Link Support Layer
No problems should be encountered when

loading the Link Support Layer. If an error does

occur, the most likely cause is an incorrect

entry in the LINK SUPPORT section of the

NET.CFG file.

The ODI driver
Several problems could cause the Insignia ODI

driver to report a failure at load time. The

following are common faults and solutions:

ODI driver cannot find the host’s adapter

The message shown below indicates that the

Insignia ODI driver has failed to initialize or find

the host’s network device:

C:\NWCLIENT>etherspc

Insignia Ethernet MLID v2.00E (950908).

(C) Copyright 1991-1995 Insignia Solutions Inc.

All Rights Reserved.

IRQ 10, Node Address 800690895E2 L

Max Frame 1514 bytes, Line Speed 10 Mbps, Bus ID 0

Board 1, Frame ETHERNET_802.2, LSB Mode

Board 2, Frame ETHERNET_II, LSB Mode

Board 3, Frame ETHERNET_SNAP, LSB Mode

Board 4, Frame ETHERNET_802.3, LSB Mode

Could not find a host Ethernet card.

ETHERSPC-DOS-6: The adapter did not initialize.

ETHERSPC did not load.

Ensure that the specified topology (Ethernet/

Token-Ring) is supported on your Macintosh.

ODI driver is loaded twice

The second attempt at loading the ODI driver

will produce error output similar to the

following:

C:\NWCLIENT>etherspc

Insignia Ethernet MLID v2.00E (950908).

(C) Copyright 1991-1995 Insignia Solutions Inc.

All Rights Reserved.

ETHERSPC-DOS-7: You need another ETHERSPC driver

section in the NET.CFG file in order to load the

LAN driver again.

The Insignia ODI drivers can only be loaded

once. If you need to reload the ODI driver

simply unload the previous instance first with

the command:

ETHERSPC U R

Token-Ring line speed

The line speed for Token-Ring should be

configured on your Macintosh since it cannot

be configured from within the Insignia ODI

drivers. The value displayed is the default and

has no significance; see below.

Insignia Token Ring MLID v2.00E (950908).

(C) Copyright 1991-1995 Insignia Solutions Inc.

All Rights Reserved.

IRQ 10

Max Frame 4210 bytes, Line Speed 4 Mbps, Bus ID 0

Board 1, Frame TOKEN RING, MSB Mode

Board 2, Frame TOKEN RING_SNAP, MSB Mode

Troubleshooting ODI
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RealPC is supplied with Winsock 1.1 compliant

drivers. RealPC will run Winsock-based

applications without any modification. No

configuration is required within the Windows

environment. Unlike third-party Winsock

drivers, which require a PC-based TCP/IP stack,

the RealPC Winsock drivers use the Macintosh’s

TCP/IP stack for all network activity. This not

only removes the need for a third-party PC-

based TCP/IP stack, but also reduces the overall

amount of memory used within RealPC to

provide Winsock support.

The Insignia Winsock drivers are pre-installed

within the Windows system and are ready to

use. Copies are also provided in the

C:\INSIGNIA directory. Note that since the

RealPC Winsock drivers use the Macintosh

TCP/IP protocol stack they both share the same

IP address.

The installation of third-party TCP/IP protocol

stacks replace the Insignia Winsock drivers and

will require full configuration (unique IP

address etc). To restore the Insignia Winsock

drivers simply copy them from the

C:\INSIGNIA directory and overwrite those in

C:\WINDOWS and C:\WINDOWS\SYSTEM.

Insignia Winsock drivers can be used by any

Winsock-compliant applications.

RealPC Winsock drivers
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Simultaneous protocol support

As the RealPC networking functionality

generally uses PC protocol stacks within

RealPC, there can be conflicts between protocol

resources (such as the port, socket, sequence

numbers etc) when trying to use the same

protocol stack from your Macintosh. RealPC,

however, provides support for simultaneous

protocol support for IPX and

TCP/IP protocols.

Simultaneous IP connections
This section describes how to configure

simultaneous TCP/IP network connections from

Windows running in RealPC and the MacOS

environment. Open Transport

TCP/IP is not provided by Insignia Solutions Inc.

but is included with MacOS 7.5.x and later.

Apple Open Transport

Apple Open Transport TCP/IP 1.1.1 running on a

Power Macintosh has a feature called

Multisession IP that allows the MacOS to make

IP connections while other applications, such as

RealPC, make separate IP connections

simultaneously. This setup requires a separate

IP address for the MacOS and a separate one for

the TCP/IP application running in RealPC. With

this feature, the user may install TCP/IP

packages such as Novell LAN WorkPlace for

Windows 95 in RealPC without conflicting with

the TCP/IP software in the MacOS.

The Open Transport TCP/IP can be configured

to use the Ethernet, Token-ring or Apple IP

configurations to get to the Internet. It can also

use Open Transports PPP 1.0 which configures a

modem for TCP/IP connections. The latest

version of Open Transport PPP can be

downloaded from Apple Computer’s web site.

Regardless of the way TCP/IP is accessing the

Internet or an intranet, the Insignia WinSock will

still be able to provide a simultaneous IP

connection through it.

The Insignia WinSock

Apple Open Transport TCP/IP 1.1.1 allows the

user to run TCP/IP-compatible applications on

your Power Macintosh. These applications will

also allow the user to run WinSock 1.1-

compatible applications in RealPC

simultaneously with MacOS TCP/IP

applications. This feature is only available when

the Insignia WINSOCK.DLL and WSOCK32.DLL
files are installed properly.

The Insignia WSOCK32.DLL is a 32-bit WinSock

that uses the IP stack provided by the Apple

TCP/IP software. It will allow WinSock 1.1-

compatible Windows applications, such as web

browsers and FTP software, to connect to the

Internet. The IP information configured in Open

Transport TCP/IP is used by the Windows

application.

Configuration

Refer to installation instructions from Apple

Computer to install and configure Open

Transport TCP/IP 1.1.1.

Networking with RealPC Simultaneous protocol support
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The Insignia WinSock was written specifically

for the IP stack in the MacOS provided by Open

Transport TCP/IP. When RealPC is installed, the

Insignia WSOCK32.DLL is in

C:\WINDOWS\SYSTEM and the Insignia

WINSOCK.DLL is in C:\WINDOWS.

No further configuration is needed in

Windows provided the TCP/IP is configured

correctly in the MacOS.

If, for some reason, these file are no longer in

these locations, they may be copied from the

RealPC Upgrade Disk.

➤ Choose RealPC Setup… from the Setup

menu, to display the Hard Disks panel.

➤ In the D: Drive section click the Change…

button, and select the RealPC Upgrade

Disk.

➤ Click Restart to restart RealPC with the new

D: drive.

Use Windows Explorer to copy the both the

WSOCK32.DLL and WINSOCK.DLL files from

the D:\INSIGNIA directory to the correct

directories on the C: drive:

C:\WINDOWS\WINSOCK.DLL
C:\WINDOWS\SYSTEM\WSOCK32.DLL

Restart Windows 95 to reinitialize the WinSocks:

➤ Click on the Start menu, select Shutdown.

➤ Select Restart the computer? and click

Yes.

RealPC should now be configured correctly for

simultaneous IP connections.

Simultaneous IPX connections
Simultaneous protocol support for IPX is

achieved by using Novell’s MacIPX protocol

stack. When using MacIPX it is necessary for

RealPC to use a modified version of Novell’s PC

IPX protocol stack, ISIPXODI.COM instead of

the original IPXODI.COM. As a result of this,

MacIPX can only be used when the NetWare 4

client is being used, whether from Windows 95

or Windows 3.x.

To install MacIPX on the
Macintosh
➤ Run the RealPC installer.

➤ Choose Custom install, and select the

MacIPX option.

Simultaneous protocol support Networking with RealPC
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To configure MacIPX
➤ Choose Control Panels from the • menu.

➤ Open the MacIPX control panel by double-

clicking its icon.

The MacIPX control panel will be displayed:

➤ Select the frame type which matches that

defined in your NET.CFG file in your

Windows environment.

Networking with RealPC Simultaneous protocol support
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DECnet Address Override

The DECnet protocol requires the Ethernet card

you use in your Macintosh to have a particular

address based on the area and node you have

been assigned in your DECnet network by your

system administrator.

To override the default address first install the

DECnet Address Override utility as follows:

➤ Run the RealPC installer, and select DECnet

Address Override Utility in the Custom

Install dialog box.

This installs the utility in the Utilities folder.

To run the utility:

➤ Double-click the DECnet Address

Override icon:

➤ Click Change Address….

➤ Enter the area and node given to you by

your system administrator, and click

Generate.

➤ Click OK to save the new address.

➤ Restart your Macintosh to use the new

address.

DECnet Address Override Networking with RealPC
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Using RealPC with the
Internet

RealPC includes Microsoft Internet Explorer, and supports

ActiveX and Java to give you full access to Web sites that use

these features.

RealPC also provides a range of Internet utilities, to allow you to

access the World Wide Web from RealPC, and to download PC

files from the Internet.

This chapter explains how to install and run Internet Explorer,

and shows how to use it to access up-to-the-minute support from

Insignia or Microsoft. It also describes how to use the

demonstration version of the NTRIGUE Net Client for Macintosh

provided with RealPC, to allow you to run Windows applications

on an NTRIGUE server via the Internet.
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Installing the Internet utilities

The PC Extras folder on the RealPC installation

CD includes a number of PC Internet utilities

which you can install once you have installed

Windows 3.x or Windows 95. The utilities are

provided in the following folders:

Folder Utility

Acrobat Acrobat Reader.

Clients Microsoft and NetWare

clients (refer to

Networking with RealPC,

page 133).

MSIE3.01 Microsoft Internet

Explorer.

MSVIEW95 Windows 95 viewers.

PKZIP PKZIP for MS-DOS and

Windows.

Shockwav Shockwave viewers.

Stuffit Stuffit for Windows.

To install any of these utilities you first need to

set up the PC Extras folder as a shared folder,

so you can access the files from RealPC. You

should then follow the instructions for installing

the individual utilities, as appropriate.

To set up PC Extras as a shared
folder
➤ Drag the PC Extras folder on the RealPC™

Install CD, and drop it on the RealPC

window:

You can now access the Internet utilities on

drive E:.

To install Acrobat Reader,
Microsoft Internet Explorer,
PKZIP, Shockwave, or Stuffit
➤ Double-click the My Computer icon on the

Windows 95 desktop.

➤ Double-click the E: drive icon.

➤ Double-click the appropriate folder icon.

➤ Double-click the utility’s installer icon.

➤ When the License Agreement dialog box

appears click Yes.

➤ If asked which components of the utility you

want to install, click Yes to install all

components.

➤ If asked where you want to install the utility,

click OK to accept the default location.

The utility is now installed onto your hard drive.

➤ When asked if you want to restart your

computer, click Yes to restart RealPC.
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To install the Microsoft Word
Viewer
➤ Double-click the My Computer icon on the

Windows 95 desktop.

➤ Double-click the E: drive icon.

➤ Double-click the MSView95 folder icon.

➤ Double-click the Wd95vw71 icon.

➤ When the License Agreement dialog box

appears click Yes.

The necessary installation files are copied to

your hard disk.

➤ Click Continue to install the Word Viewer.

➤ When asked where you want to install the

Word Viewer, click OK to accept the default

location.

➤ When the installation dialog box appears

click the Installation button to start the

installation.

The Word Viewer is now installed onto your

hard drive.

If an error message appears saying that setup

could not open a temporary file, click Ignore.

You can run the Word Viewer by clicking Start,

then Programs, Word Viewer.

To install the Microsoft Excel
Viewer
➤ Double-click the My Computer icon on the

Windows 95 desktop.

➤ Double-click the SoftWindows (C:) drive

icon.

➤ Select File > New > Folder from the drive

menu.

➤ Enter excelvwr as the name of the new

drive.

➤ Double-click the E: drive icon.

➤ Double-click the MSView95 folder icon.

➤ Move the mouse pointer over the Excelvwr

icon, hold down the = key on the numeric

keypad, drag the icon to the excelvwr

folder, and release the = key.

➤ Select Copy here from the menu that

appears.

The file is copied to your C: drive.

➤ Double-click the excelvwr icon on the C:
drive.

The file is expanded to two further files.

➤ Click the Start button and select MS-DOS

Prompt from the Programs menu.

➤ At the C:\> prompt enter:

CD C:\EXCELVWR R
XL95VIEW.EXE -d R
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The file is extracted into two new folders, Disk1

and Disk2.

➤ In Windows 95 double-click the Disk1 icon

in the excelvwr folder.

➤ Double-click the Setup icon to run the setup

program.

➤ When the License Agreement dialog box

appears click I Agree.

➤ When the installation dialog box appears

click the Installation button to start the

installation.

The Excel Viewer is now installed onto your

hard drive.

You can run the Excel viewer by clicking Start,

then Programs, Microsoft Excel Viewer.
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Running Microsoft Internet Explorer

Once you have installed Microsoft Internet

Explorer you can use it to access the World

Wide Web.

Before running Internet Explorer your

Macintosh needs to be connected to the

Internet, either via a direct TCP/IP connection,

or via a dial-up connection using PPP or SLIP.

To run Microsoft Internet
Explorer from Windows 3.x
➤ Double-click the Internet Explorer icon in

the Microsoft Internet Explorer program

group:

The following dialog box is displayed to allow

you to set up Internet Explorer as your default

browser:

➤ Click Yes to make Internet Explorer your

default browser.

Internet Explorer will run and connect to the

Microsoft home page by default:

To run Microsoft Internet
Explorer from Windows 95
➤ Double-click the The Internet icon on the

Windows 95 desktop.

➤ When the first dialog box appears click Next

to get connected.

➤ When asked which set-up option you

require, select Current and click Next.

➤ Click Yes to make Internet Explorer your

default browser.

Using RealPC with the Internet Running Microsoft Internet Explorer



172 Running Microsoft Internet Explorer Using RealPC with the Internet

Internet Explorer will run and connect to the

Microsoft home page by default.

To get support on Insignia
products
➤ Enter the following address in the Internet

Explorer address field:

http://www.insignia.com/

➤ Press R.

The Insignia technical support page will be

displayed:

From this page you can:

■ See a list of Macintosh, UNIX, or NTRIGUE

technical support documents.

■ Search for a document.

■ Browse through all the titles of the technical

support documents.
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You can also use Internet Explorer to access

Microsoft’s World Wide Web support page, to

get support on using Windows and other

Microsoft products.

To reach Microsoft’s support
site
➤ Enter the following address in the Internet

Explorer address field:

http://www.microsoft.com/support/

➤ Press R.

After a short delay the Microsoft support home

page will be displayed:

➤ Click on the button corresponding to the

support topic you are interested in.

Getting Microsoft support
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RealPC includes several Internet utilities to help

you work with the Internet.

You can install these utilities from the PC

Extras folder on the installation CD. For more

information refer to Installing the Internet

utilities, page 168.

To run them from Windows 95 click the Start

button, then click Programs:

To run them from Windows 3.x open the

appropriate program group and double-click

the application’s icon.

For more information about each utility double-

click the Read-Me file icon in the appropriate

folder on the C: drive.

Compressing and expanding
files
These utilities allow you to compress files, to

save time when sending them as attachments to

email, or to expand files that you have received

with email or downloaded from the Internet.

PKZIP, from PKWARE, compresses and

expands files using the popular .ZIP format:

For more information contact PKWARE’s Web

site at:

http://www.pkware.com

Stuffit Expander expands and decodes files in

a variety of formats, including Stuffit (.SIT),

UUENCODE (.UUE), and Binhex (.HQX):

For more information contact Aladdin Systems’

Web site at:

http://www.aladdinsys.com

Using Internet utilities
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Viewing files in different
formats
A range of viewers are provided, to enable you

to view files you have downloaded from the

Internet, even if you do not have the application

that created them.

Shockwave provides viewers for documents

and Web sites created with Macromedia’s

products: Director, FreeHand, and Authorware:

For more information and sample files contact

Macromedia’s Web site at:

http://www.macromedia.com

Ppview32 is a viewer for documents in

Microsoft PowerPoint format:

RealPC also includes Microsoft viewers for

Excel and Word.

The Acrobat Reader allows you to read on-line

versions of documents created in Acrobat

(.PDF) format:

For more information about setting up your

Web browser to recognize Acrobat Reader, and

sample Acrobat files, contact Adobe’s Web site

at:

http://www.adobe.com

Playing sound files
RealAudio is a compact sound format for

transmitting sound files over the Internet. On

Windows 95 RealAudio is included with Internet

Explorer. On Windows 3.x it is provided in the

RealAudio program group:

To hear a sample sound double-click the

Example 1 or Example 2 icons. For more

information contact the RealAudio Web site at:

http://www.realaudio.com
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RealPC includes a demonstration version of the

NTRIGUE Net Client for Macintosh, to allow you

to access an NTRIGUE server across the Internet

or via a TCP/IP network.

A Macintosh version of Microsoft Internet

Explorer is provided on the first RealPC

installation CD in the Extras folder.

To install the NTRIGUE Net
Client
➤ Insert the RealPC installation CD.

➤ Open the NTRIGUE Net Client folder in the

Extras folder.

➤ Double-click the installer icon.

➤ When the welcome screen is displayed click

Continue… to display the Easy Install

dialog box:

➤ Click Install to install the NTRIGUE Net

Client.

➤ Refer to the Read-Me file for the serial

number.

Using the NTRIGUE Net Client for Macintosh Using RealPC with the Internet

To connect to the Insignia
demonstration NTRIGUE server
➤ Run a Web browser on your Macintosh, such

as Netscape Navigator or Microsoft Internet

Explorer.

➤ Connect to Insignia’s home page at:

http://www.insignia.com

➤ Click NTRIGUE Demo on the Web,

Regular Version to go to the NTRIGUE page

and locate the Connect to NTRIGUE link:

➤ Click on the link to make the connection.

Using the NTRIGUE Net Client for Macintosh
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The following dialog box will be displayed:

➤ Click Configure Helper… to associate the

file with the Net Client application.

This dialog box appears:

➤ Enter the description NTRIGUE Net Client

and click Choose….

This dialog box allows you to choose the

application:

➤ Locate the Net Client application and click

Select.

➤ Click OK in the Configure File Type dialog

box to save your association.

The association will be saved by your Web

browser to enable you to access other NTRIGUE

servers via the Internet.

You will be connected to Insignia’s NTRIGUE

server, and the Windows NT desktop will be

displayed.

You can now run the Windows applications by

double-clicking their icons on the desktop.

For more information about the NTRIGUE Net

Client refer to the Acrobat version of the User

Guide in the NTRIGUE Net Client folder on the

first RealPC installation CD.
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Scripting RealPC

Scripting RealPC

RealPC includes support for AppleScript, to allow experienced

programmers to write scripts that run RealPC, execute

commands, read information from the screen, or quit from

RealPC.

To use AppleScript you need to install Apple’s AppleScript

software and the Script Editor.

This chapter provides several simple examples of using

AppleScript with RealPC, and gives a full description of the

AppleScript commands supported in RealPC.

For full information about using the AppleScript language and

Script Editor refer to the documentation provided with

AppleScript.
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Using scripting

This section illustrates how you can use scripting by giving some

simple scripting examples.

Running RealPC The following script runs RealPC:

tell application "RealPC"
run

end tell

Executing a command The following script executes the MS-DOS DIR command:

tell application "RealPC"
write "DIR" & return

end tell

Alternatively, you can include a return in the string by writing:

write "DIR\r"

Reading information The following example copies line 22 of the MS-DOS window

from the MS-DOS into the clipboard. It uses activate to bring the window to the

window front, and this should be used whenever copying or pasting text

or graphics.

tell application "RealPC"
activate
write "DIR" & return
set bounds of selection to {0,22,44,23}
copy

end tell

The numbers in the selection list specify an area of the

RealPC window in the format:

{left, top, right, bottom}

where left and right are the horizontal start and end in

characters, and top and bottom are the vertical start and end

in lines.

Using scripting Scripting RealPC

in the MS-DOS window
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The following example gives the command DIR to RealPC. It

then reads line 22 of the MS-DOS window, to get the hard disk

space available, and displays it in a dialog box:

Note that the repeat section of the script keeps checking the

result until it has stopped changing, to ensure that the DIR
command has completed. It does this using the two variables

TheResult and OldResult.

tell application "RealPC"
activate

write "DIR" & return
set bounds of selection to {0, 22, 44, 23}
set OldResult to ""

  repeat
    set TheResult to contents of selection

  if character 1 of TheResult = space and
TheResult = OldResult then exit repeat

  set OldResult to TheResult
end repeat
display dialog OldResult

end tell

Pasting into a The following script pastes the contents of the clipboard into the

Windows application frontmost application in Windows:

tell application "RealPC"
activate
set key "Alt" to down
set key "E" to down
set key "Alt" to up
set key "E" to up
set key "P" to press

end tell

Running a Windows The following examples illustrate how to run RealPC, and

application then start a Windows application such as Paintbrush.

window
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With Windows 3.x the script runs the application using an

MS-DOS command:

tell application "RealPC"
run
activate
write "WIN PBRUSH" & return

end tell

With Windows 95 the script runs the application using an

MS-DOS command at the command prompt:

tell application "RealPC"
run
activate
set key "F8" to press
set key "5" to press
set key "Return" to press
write "WIN PBRUSH" & return

end tell

Here 8 displays the Load menu, 5 chooses the command

prompt option, and Return loads the command prompt. Note

that this example assumes that you are not using TurboStart.

Quitting from The following example quits from RealPC:

tell application "RealPC"
quit

end tell

Scripting reference

The following sections give reference information about the

RealPC scripting commands.

Required suite These must be supported by all applications which support high

level events. They are:

quit

Quits RealPC.

Scripting reference Scripting RealPC

RealPC



183

For example:

tell application "RealPC"
quit

end tell

run

Runs RealPC.

For example:

tell application "RealPC"
run

end tell

Core suite RealPC does not support the entire AppleScript Core Suite

because many of the events in the suite have no relevance to

RealPC.

get

Gets the data for an object.

The following example will return the location of the top left

corner of the RealPC main window.

get position of window 1

The window number is ignored, and is only required for

consistency with other scriptable applications.

set

Sets the data for an object.

data size

Returns the size of an object in bytes.

For example:

data size selection

application

The RealPC application itself.

Scripting RealPC Scripting reference



184

The application has the following properties:

Property Description

clipboard The clipboard for the application. Returns

a list containing the data in the clipboard.

The clipboard can contain text or PICT

data. To specify a particular type write:

get clipboard as text

or

get clipboard as picture

frontmost Returns true if RealPC is in the

foreground, or false otherwise.

selection The selection visible to the user. For

example:

tell application "RealPC"
get contents of selection

end tell

name Returns the name displayed in the

MS-DOS window title bar. For example, a

demo version would return:

RealPC - For Demonstration
Purposes Only.

version Returns the RealPC major version number.

This is 1.

Scripting reference Scripting RealPC
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window

The RealPC main window.

The window can have the following properties:

Property Type Description

closeable Boolean, Does the RealPC window

read-only have a close box? Always

false.

titled Boolean, Does the RealPC window

read-only have a title bar? Always

true.

resizable Boolean, Is the RealPC window

read-only resizable? Always false.

position QuickDraw The location of the top left

Point, corner of the RealPC

read/write window.

contents Text, read-only The textual contents of the

RealPC window. This

contains an extra R at the

end of each line to maintain

the formatting with the script

editor results window.

selection

The RealPC main window selection.

The selection can have the following properties:

Property Type Description

bounds QuickDraw Bounds of the current RealPC

rectangle, selection rectangle.

read/write

contents Text, read-only The contents of the RealPC

selection rectangle.

Scripting RealPC Scripting reference
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Miscellaneous suite This suite consists of standard Apple Events which do not belong

to any other suite.

copy

Copy the selection to the clipboard.

For example:

tell application "RealPC"
copy

end tell

paste

Paste the selection from the clipboard.

For example:

tell application "RealPC"
paste

end tell

RealPC suite This suite consists of custom events specific to RealPC

key

RealPC key.

This command has no properties.

Its syntax is:

set key named-key-form to keystate

The valid keystate values are as follows:

Keystate Description

press The key behaves as if pressed once and

released.

down The key behaves as if held down. If key is

repeatable it will start auto-repeating on the

keyboard.

up The key behaves as if released. If the key was

auto-repeating because it was in the down

state for the required time it should stop.

Scripting reference Scripting RealPC
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Note that there is no way to guarantee the number of times that a

character is repeated while the key is in the down state because

this depends on how long it is held down.

The possible values of named-key-form are as follows:

Scripting RealPC Scripting reference

Insert

Num *

Num +

Num -

Num /

Num 0 to Num 9

Num Lock

Page Down

Page Up

Pause

Print Scrn

Return

Scroll Lock

Shift

Shift, right

Space

Tab

[

\

]

`

§

Arrow Right

Arrow Up

Caps Lock

Ctrl

Ctrl, right

Del

Delete

End

Esc

F1 to F9

F10

F12

Home

0 to 9

A to Z

'

`

-

.

/

;

=

Alt

Alt Gr

Arrow Down

Arrow Left

The following example types a R:

tell application "RealPC"
set key "Return" to press

end tell

Note that you can use the key command to perform actions in

Windows.
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LaunchWindowsApp

Runs a Windows 95 application. Its syntax is:

LaunchWindowsApp command

where command is a string that could be entered in the

Windows 95 Run… dialog box. The command may need to

include a full pathname if the application is not in the current

directory.

This command is only valid in Windows 95 and is ignored in

Windows 3.x.

reset

Reset RealPC.

TurboStart

Quits from RealPC and activates TurboStart.

This command is only valid in Windows 95 and is ignored in

Windows 3.x.

write

Insert a text string into the keyboard buffer as if it were typed in

at the keyboard. Only normal ASCII characters can be entered in

this way. The key event (described below) is provided to enter

function keys, modifier keys and so on.

The following example gives a DIR command:

write "DIR\r"

Note that the \r produces a R.
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Troubleshooting

This chapter gives suggested solutions to problems that you may

encounter when running PC applications on your Macintosh with

RealPC.

It also includes details of the RealPC and MS-DOS error messages,

with explanations and suggested solutions.
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Common problems

The following sections give solutions to the most commonly-

encountered problems when using RealPC.

Using floppy disks How do I eject a floppy disk?

Choose the appropriate drive from the Eject menu.

Alternatively, press CS1, CS2, or CS0 to eject a disk

from the internal, second internal, or external drive, respectively.

Using hard disks How do I create a new hard disk?

Use the Customize option of the RealPC installer. Alternatively,

use the Hard Disks panel in the RealPC Setup dialog box; refer

to Creating new hard disk files, page 46.

How do I make a hard disk file larger?

Use the Hard Disk Expander utility; refer to To change the size of

a hard disk file, page 45.

I get a Windows 3.x error message, after expanding a D:

hard disk, saying that the swap file cannot be found

Recreate the swap file using the Virtual Memory dialog box in the

386 Drivers Windows control panel.

Using CD-ROM How do I read a PC CD-ROM?

Insert the CD-ROM, and then access it as drive F:.

How do I eject a CD-ROM?

Choose the CD-ROM drive from the Eject menu.

Using memory How do I set up memory for PC applications?

Use the Memory panel in the RealPC Setup dialog box; refer to

Setting up memory, page 55.

Using the mouse The mouse pointer has disappeared

While the mouse is selected for use by MS-DOS applications it is

not available to the Macintosh. To restore it type CM.

Common problems Troubleshooting
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How do I get the right mouse button for PC applications?

Type keypad = or CR (or Enter on PowerBooks).

Using keyboards How do I get PC keys on the Macintosh keyboard?

Refer to Using the keyboard and mouse, page 34.

How do I set up a foreign keyboard in MS-DOS?

Use the MS-DOS KEYB command; refer to International usage,

page 75.

How do I set up a foreign keyboard in Windows 3.x or

Windows 95?

Refer to International usage, page 75.

Using the screen How do I change the size of the RealPC MS-DOS

window?

Choose Full Screen DOS from the RealPC Setup menu.

The RealPC screen becomes corrupted by my Macintosh

screen saver

Make sure you are running the SmartCopy utility.

Using printers How do I set up the COM and LPT ports?

Refer to Setting up serial ports, page 65, or Setting up printing,

page 72.

How can I print from a PC application?

Refer to Setting up serial ports, page 65, or Setting up printing,

page 72.

Printing is not working properly

Check that the correct port is selected in the PC application:

LPT1: for a printer selected in the Macintosh Chooser, or COM1:
or COM2: for a directly connected printer.

If you are using LPT1: check that Windows or the PC

application is set to the correct printer option.

Troubleshooting Common problems
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Check that you are using the Insignia Printer Driver, or that the

PC application is set up for the same type of printer as the setting

in the Printer Port panel of the RealPC Setup dialog box.

Check that the Auto-Send… command is specified to ensure

that data is being sent to the printer, or choose Send to Printer;

refer to Refer to Printing from MS-DOS, page 89, Printing from

Windows 3.x, page 109, or Printing from Windows 95, page 127.

Using serial devices How do I use the Macintosh serial ports with PC

applications?

Refer to Setting up serial ports, page 65.

Configuring RealPC Where are the RealPC preferences stored?

In the RealPC Prefs file in the Preferences folder in your

Macintosh System Folder.

Running PC applications How do I install PC software with RealPC?

Refer to Installing and running MS-DOS applications, page 92,

Installing and running Windows 3.x applications, page 114, or

Installing and running Windows 95 applications, page 132.

How do I run Windows?

Refer to Running Windows 3.x, page 100, or Running

Windows 95, page 116.

How do I use MS-DOS commands?

Type them at the C:\> prompt; refer to Using MS-DOS, page 81.

How can I edit MS-DOS files?

Use the MS-DOS editor, EDIT; refer to Editing configuration files,

page 96. Alternatively, you can use the Windows Notepad text

editor.

I get an error “application requires a VGA display”

If you try to run some Windows applications, such as Microsoft

Dinosaurs, after a default installation you may get this message.

To solve this problem use the Windows Desktop… command

to change the desktop size to 640 x 480.

Common problems Troubleshooting
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MS-DOS errors

These errors appear in the RealPC MS-DOS window.

Error Explanation Suggestion

Invalid drive If you are trying to access drive Refer to Setting up hard disk

software needed to handle drives, page 43, or Sharing PC

shared drives is not properly files between RealPC and

set up in your startup disk. the Macintosh, page 49.

Not ready error The drive is set to Empty or it Insert a disk.

reading drive A has no disk in it.

Not ready error The hard disk file is corrupted Create a new startup disk using

reading drive C (extremely rare). the Hard Disks panel in the

RealPC Setup dialog box.

Not ready error No drive D: is selected, drive Select a hard disk file.

reading drive D D: is set to Empty, or the hard

disk file is corrupted (extremely

rare).

Non System disk If you see this message when Eject the disk and restart

(or similar message) RealPC is starting up it usually RealPC. Alternatively, select

means that there is an MS-DOS Don’t Boot From Floppy in

disk (which is not a startup the Floppy Disks panel of the

disk) in the floppy disk drive. RealPC Setup dialog box.

This may be because you have

been using PC Exchange to

read an MS-DOS disk.
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RealPC shared drive errors

These errors appear in the RealPC MS-DOS window and relate to

the use of shared drives.

Error Explanation Suggestion

Illegal drive The drive letter you are using Refer to Sharing PC files

specification for a shared drive is either between RealPC and the

missing or further along the Macintosh, page 49.

alphabet than the limit set by

LASTDRIVE.

RealPC couldn't find This usually means that since Use the Shared Folders

that folder the last time RealPC ran the panel in the RealPC Setup

shared drive folder or disk was dialog box to select a new

moved or renamed. folder.

RealPC couldn't read The folder specified for a Check your access privileges.

that folder shared drive cannot be read.

That name is not a Only folders or disks, not

folder documents, can be used as

shared drives.

RealPC shared drive errors Troubleshooting



195Troubleshooting RealPC errors

RealPC errors

These errors are displayed in a Macintosh dialog box.

RealPC licensing

Error Explanation Suggestion

Sorry, this Only relevant to demos. Buy a full copy of RealPC.

demonstration version
of RealPC has expired

Sorry – Incorrect The password is incorrect. Retype it.

Password

Sorry – Incorrect type The password is incorrect. You should retype the

of Password password.

Thank you for trying Only relevant to demos. Buy a full copy of RealPC.

this demonstration
version of RealPC

Both the 'Name' and You have omitted a field in the Enter the missing field.

'Company Name' fields Personalization dialog box.

must be entered

Sorry – there are too Your concurrent use license Save your files and try again

many RealPC users. allows a maximum number of later, or ask another user to

RealPC may quit in 2 simultaneous users of RealPC, quit.

minutes. Please save and this number has been

your work exceeded.

Sorry – there are The number of users has not Buy another copy of RealPC.

still too many RealPC decreased.

users. RealPC has to
quit now

The number of Another user has finished and

RealPC users is you can now use RealPC.

now below the limit.
This copy will
continue running
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Note

If these errors occur regularly you may need to upgrade your

software license to allow a larger number of users. For more

information refer to Product upgrades, page 213.

Error Explanation Suggestion

Sorry – there are too The program already has the Save your documents and try

many RealPC users. maximum number of users again later, or ask another user

Please try again later allowed by your particular to quit.

license.

Please enter your Enter the password.

RealPC Password…

RealPC errors Troubleshooting
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Running RealPC

Error Explanation Suggestion

The RealPC CPU has The MS-DOS program you are Try again. If the error recurs

encountered an running has an illegal reinstall the program. Try

illegal instruction instruction in it and RealPC running the program in a

cannot process it. slightly different way. If the

error occurs consistently

contact Insignia technical

support.

Internal error in This is a rare, but fatal, error Restart RealPC and retry the

RealPC procedure and there is no way to recover. operations that produced the

error. If the error recurs

contact Insignia technical

support.

RealPC does not You have no bootable partition Check the drive attached to

support a ROM BASIC on your first hard disk drive. C:.

RealPC is in a The CPU is being continuously If the problem persists, contact

continuous reset state reset. A PC would lock up in Insignia technical support.

this state, but RealPC will

detect it. It has been caused by

the application you are

running.

Unknown type of video An earlier version of RealPC Only SVGA is available in

adapter currently in was used with a video adapter RealPC.

use not supported in RealPC.

RealPC has been The RealPC application must Refer to Installing RealPC,

damaged. Please reload be reinstalled. page 7.

the application from
your original disk

Sorry – can't modify The RealPC application is Unlock RealPC and try again.

resources. Please make locked or on a read-only disk.

sure that your RealPC
application is
writable
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RealPC hard disk files

Error Explanation Suggestion

Can't find … This message will have named It may have been moved or

a hard disk file which cannot renamed.

be found.

Document is not a The selected hard disk file is Make sure you do not have

RealPC hard disk file not a valid RealPC hard disk QuickFolder or Shield INIT in

file or RealPC will not properly your System Folder. Another

recognize a hard disk file. application may have written

into the document – only

RealPC should do this.

The hard disk document The hard disk filename in your Use the Hard Disks panel in

name must not be empty RealPC settings file is blank. the RealPC Setup dialog box

to assign a valid hard disk file.

Locked or already in The hard disk file specified is

use:… either locked, in use by

another user.

RealPC could not You probably do not have the Either change the access

create the new hard correct access privileges on a privileges, disable the anti-

disk document file server, are using an anti- virus extension, or specify a

virus extension, or the size of larger Macintosh hard disk.

the hard disk was not large

enough for the MS-DOS

software to be loaded.

There isn't enough There is insufficient space on Make more space available on

space for the new Hard the selected Macintosh drive. your hard disk or create a

Disk file smaller RealPC hard disk file.

RealPC errors Troubleshooting
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Memory

Error Explanation Suggestion

Out of memory You are running close to the Increase the application

minimum amount of memory memory size; refer to To

needed by RealPC. change the application memory

size, page 55.

RealPC couldn't There is not enough memory You can try allocating less.

allocate the requested available to provide the Refer to Setting up memory,

number of Memory pages requested amount of Memory. page 55.

RealPC couldn't use RealPC has a memory problem Refer to Setting up memory,

that drive in setting up the shared drive. page 55.

Floppy disk drives

Error Explanation Suggestion

The IBM hardware- The floppy disk drive that was Uncheck Use Internal Floppy

compatible floppy disk selected for drive A: has been as A: in the Floppy Disks

drive is no longer removed since the last time panel in the RealPC Setup

attached to this RealPC ran. dialog box.

machine

Network drives

Error Explanation Suggestion

Mac files must be A shared drive has been given a

accessed from a folder document name; only folders

or disks are valid.

Troubleshooting RealPC errors
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Serial ports

Error Explanation Suggestion

Both serial port Ensure that COM1: and COM2:
emulations cannot use are assigned to different ports.

the same serial port

One of the serial port The port that you have Either use the Macintosh

emulations is requested for COM1: or COM2: Chooser to disable AppleTalk

configured to use your on RealPC is already in use by or use the Serial Ports panel

AppleTalk port AppleTalk. in the RealPC Setup dialog

box to reassign COM1:or

COM2:.

Unable to open the The file that you selected for

serial port output use for the serial port output

file may be locked, or in use by

another application or network

user.
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Networking errors

These error messages may appear in the RealPC MS-DOS

window.

Error Explanation Suggestion

A File Server cannot
be found (vlm.com)

FATAL Could not find a
host Ethernet/Token
Ring board (etherspc/
tokenspc.com)

FATAL Board failed to
initialize correctly
(etherspc/tokenspc.com)

Warning Protocol
already in use.
Protocol=IP, Frame=xx,
PID=xx (etherspc.com/
tokenspc.com)

Warning Protocol
already in use.
Protocol=IPX, Frame=xx,
PID=xx (etherspc/
tokenspc.com)

You have the wrong frame type

set.

You are running

etherspc.com/
tokenspc.com when your

Macintosh does not have an

Ethernet/Token Ring board.

You are running etherspc/
tokenspc.com when your

Macintosh does not have an

Ethernet/Token Ring board, or

there is an error with the board.

Other software on your

Macintosh is already using the

TCP/IP protocol. Examples are

Telnet, FTP, or Internet

browsing software.

Other software on your

Macintosh is already using the

IPX protocol.

Correct your NET.CFG file.

Refer to Configuring ODI

drivers, page 157.

Check your Macintosh

installation.

Check your Macintosh

installation.

Quit from the Macintosh

TCP/IP software. Alternatively,

if the PC TCP/IP software is

Winsock compliant, you can

use the RealPC Winsock driver

concurrently with the

Macintosh TCP/IP software.

Select a different frame type in

RealPC.

PC software error
messages
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Specification

This chapter gives a full technical specification of RealPC.

General specification

Feature Specification

Processor Pentium MMX.

ROM BIOS AT-compatible.

MS-DOS Version 6.22.

Memory 640 Kbytes.

Extended: up to 255 Mbytes.

Hard disk drives Two drives, C: and D:.

Network drives Multiple drives, E: to Z:.

Floppy disk drives Drive A:.

Video VESA standard Super Video Graphics

Array (SVGA) supporting 640 x 480 256

colors, 640 x 400 256 colors, 800 x 600

16 colors, or 1024 x 768 16 colors.

Display Color on a Macintosh with at least 16

colors or grayscales; otherwise

monochrome.

Sound Windows sound, Sound Blaster, and

MIDI support.

Samples: 8 or 16 bit, mono or stereo.

Sample rates: 11.025, 22.05, or 44.1 kHz.

Windows desktop Black & white, 16 colors, 256 colors,

thousands, or millions. Size: 436 x 240 to

1600 x 1200.

Printer port One port, LPT1:.

Specification General specification
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Feature Specification

Printer Insignia Printer Driver, PostScript

printer, Epson LQ-2500 (132

columns), or direct printing with

PowerPrint.

Serial ports Two ports, COM1: and COM2:.

Keyboard 101-key, AT-style keyboard

supported by any Macintosh

keyboard.

Joystick Macintosh compatible joystick.

Mouse Microsoft Bus Mouse compatible.

CD-ROM drives One drive; Microsoft CD-ROM

extension software included.

Networking specification

Feature Specification

Network drivers ODI, NDIS, and WINSOCK.

Novell NetWare NetWare 4.x client.

Microsoft networking MS Client 3.0.

Compatible Ethernet or Any Ethernet or Token Ring adapter

Token Ring hardware and driver conforming to the Apple

standard.

Refer to the ReadMe RealPC file for details of the supported

Token Ring and Ethernet cards.

Networking specification Specification
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Glossary

Application icon In Windows, a graphic icon that represents a running

application. This icon appears only after you start an application

and reduce (minimize) it.

Application window In Windows, the window containing the work area and menu bar

for an application. The name of the application appears at the

top of the window.

ASPI Advanced SCSI Programming Interface. A standard developed by

Adaptec to allow PCs to access a wide range of SCSI devices.

AUTOEXEC.BAT A special batch file that is executed each time a PC restarts.

Batch file A text file containing MS-DOS commands that can be executed to

run the commands it contains as if they were typed in at the

keyboard.

Boot The PC terminology for starting up the computer.

CD-ROM A read-only form of data storage, using standard Compact Disc

media, capable of providing over 600 Mbytes of data.

CONFIG.SYS A special MS-DOS text file that contains commands to configure

the MS-DOS operating system.

Control menu box An application running in Windows has a control menu box at

the top left of the application window. This allows you to control

the characteristics of the window and switch between

applications.

Directory The PC name for a folder. As on the Macintosh, it can contain

files and other directories.

Ethernet A widely used network system. The Ethernet cabling system and

communications method have been standardized by the IEEE

802.3 committee and by ISO. Ethernet has a default frame type of

Ethernet_802.2.

Ethernet II One of the standards that can be used on an Ethernet cabling

system.

Glossary
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EtherTalk Apple’s data-link product that allows an AppleTalk network to be

connected by Ethernet cables. It is an Apple Computer

networking standard which is based on, and is compatible with,

Ethernet.

Expanded memory The LIM (Lotus, Intel, Microsoft) standard for extending the

amount of memory available to PC applications beyond their

original 640 Kbytes.

Extended memory The XMS (Extended Memory Specification) for extending the

amount of memory available to PC applications using 80286 or

better protected mode.

Extension The last part of an MS-DOS filename which can be used to

specify the type of file. It consists of a period and up to three

letters; for example, .BAT.

FDHD An alternative name for the Macintosh SuperDrive.

Frame A unit of information that is transmitted over the network. It is

also referred to as a message packet. Your frame structure can

differ depending on the frame type in use. You should ensure

that your computer is configured for the appropriate frame type.

Frame type A variation of a protocol, defining the internal structure of a

packet. When setting up networking you need to ensure the

correct frame type is selected for your network.

Group A collection of applications, accessories, or documents within

the Windows 3.x Program Manager.

IEEE (or ISO) 802.3 A standard developed for Ethernet networks, defining the

physical cabling and software protocols. See Frame type.

Internet An internet is an interconnected group of networks. When

written as Internet it refers specifically to the information

superhighway.

IPX The Novell communication protocol, standing for Inter-network

Packet eXchange. It creates, maintains, and terminates the

connections between network devices (such as computer file

servers and routers). It also addresses and routes the outgoing

data packets across the network.
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ISO 9660 standard The official term for the High Sierra standard format for

CD-ROMs.

Local Area Network A Local Area Network (or LAN) consists of computers and

shared devices connected to a single network transmission cable

in a limited area, usually a single building or section of a

building.

MIDI Musical Instrument Digital Interface; a standard format for

digitally encoding music.

MMX A technology integrated with recent releases of Intel’s Pentium

processors to provide multimedia extensions for use by games,

education, and entertainment software.

MS-DOS Microsoft Disk Operating System; the original system software

and filing system used on IBM PC or compatible computers.

NDIS Network Driver Interface Specification, a standard defined by

Microsoft and 3Com. It is the media- and protocol-independent

driver standard used by network operating systems such as LAN

Manager. RealPC includes NDIS drivers for Ethernet and Token

Ring.

Network drive A general name for disk drives that are treated by the PC as being

on a different computer. Network drives cannot be formatted or

partitioned.

Network number A number which identifies a network in an internet, so that data

can be sent to the correct destination. Ethernet and Token Ring

networks have network numbers.

NetWare Novell’s operating system that runs on file servers and routers. It

controls system resources and information processing on an

entire network or inter-network.

NuBus A standard expansion slot for Macintosh computers, which

allows Token Ring or other cards to be added. Some Macintosh

computers may require a PDS to NuBus adapter to allow them to

accept NuBus cards.

Glossary
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ODI Novell’s Open Data-Link Interface. It supports media- and

protocol-independent communications by providing a standard

interface that allows multiple protocols to share a single network

board without conflict. RealPC includes ODI drivers for Ethernet

and Token Ring.

ODINSUP A Novell converter program which allows the use of NDIS client

applications, such as Microsoft LAN Manager, with ODI drivers.

Packet A unit of information that has been formatted for transmission on

a network. A packet contains not only data but also its

destination and source.

PCI Peripheral Component Interconnect, a standard for PC and

Macintosh interface cards supported by recent Macintosh

computers.

PDS Processor Direct Slot. An expansion slot found in many

Macintosh computers, the PDS provides direct connection to the

processor. Some network cards are installed in the PDS rather

than a NuBus or PCI slot.

Protocol A set of procedural rules that permit the orderly exchange of

information within and across a network. These rules govern the

content, format, timing, sequencing, and error control of the

messages being exchanged on a network.

RISC Reduced Instruction Set Computer. A microcomputer

architecture designed with a simpler instruction set to allow

faster execution speeds to be achieved.

SCSI Small Computer Systems Interface (pronounced ‘scuzzy’), the

industry standard for connecting peripheral devices to host

computers. Most Macintosh computers have SCSI ports as

standard.

SNAP Sub Network Access Protocol frame type. There are SNAP frame

types for both Ethernet and Token Ring. They are extensions of

the basic 802.3 and 802.2 frame types, allowing more addressing

flexibility.

Sound Blaster A hardware sound interface for the PC developed by Creative

Technology Ltd.

Glossary
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SuperDrive The dual-format 3.5-inch floppy disk drive provided on all recent

Macintosh computers. It can read, write, and format both

Macintosh disks and MS-DOS disks.

SVGA Super Video Graphics Array, an extension to VGA providing

higher resolution and more colors.

SYSTEM.INI A Windows initialization file.

TCP/IP Transmission Control Protocol/Internet Protocol. A widely-used

industry standard for connecting different types of computers. An

internet is an interconnected set of networks.

Type A four-character code which identifies the type of document

created by an application on the Macintosh. RealPC allows you

to specify what type code is allocated to the files it creates.

Token Ring A network with a ring layout, where all network devices are

connected in a daisy chain system and pass tokens from one

attached device to another.

VESA Video Electronics Standards Association, a widely-adopted set of

display standards for PCs.

VGA Video Graphics Array, the most widely-accepted standard for PC

graphics displays.

Volume An alternative name for a disk.

VRAM Video Random Access Memory, memory used to store the

displayed image. The amount of VRAM required depends on the

display resolution and the number of colors.

WIN.INI A Windows initialization file that allows you to customize your

Windows environment.

Glossary
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Technical support

Insignia Solutions is committed to helping you get the most out

of your software. As a registered customer of Insignia Solutions,

you are entitled to free warranty support for your Insignia

products.

The information below will be helpful if you need to call for

technical assistance. Please take a moment to fill this out:

Software name:

Version:

Serial number:

Computer model:

RAM (Mbytes):

Operating system:

Before you call technical support, please follow this pre-call

checklist so our support technicians can help you more quickly

and efficiently:

➤ Consult the documentation included with your product. It

should provide answers to many of your questions.

➤ Have your software serial number available when you call.

➤ Let the technician know whether the program worked

correctly prior to the problem you are experiencing, and

whether you made any changes to your computer

environment.

➤ If possible, be prepared to reproduce the sequence of steps

or use the application that demonstrates the problem.

➤ Make a note of any error messages that appeared.

Technical support
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Technical support contacts

USA/Canada

Phone: (408) 327-6500

Fax: (408) 327-6343

Fax response: (408) 327-6295 or 800-876-3872

Internet: mactech@isinc.insignia.com
World Wide Web: http://www.insignia.com/

Technical support is available from 6am through 5pm, PST,

Monday through Friday.

Europe, Middle East, Africa, and CIS countries

Phone: +44 131 451 6900

Fax: +44 131 451 6910

Internet: support@isltd.insignia.com

Technical support is available from 9am through 5pm, UK time,

Monday through Friday.

In other countries support is provided through the authorized

dealer in your country.

Technical support contacts Technical support
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Software registration

Software registration is the key to receiving the full benefits of

Insignia Solutions’ customer services. Please be sure to run the

RealPC Registration program, or fill out and mail the Warranty

Registration Card.

Periodically, Insignia Solutions will make available upgrade/

update versions of certain programs at a modest charge to

registered customers. As a registered customer, Insignia will

notify you of upgrades/updates.

As a registered user, you will have full access to Insignia’s

customer service and technical support organizations.

Media replacement

Replacement CD-ROMs are available only if your Warranty

Registration Card is on file. A charge applies in some

circumstances.

Please contact our technical support organization to verify

defective media. For information on how to contact us, refer to

Technical support contacts, page 212.

Product upgrades

To upgrade your Insignia product, contact our sales and

customer service representatives at the numbers listed below:

USA/Canada

Phone: 800-848-7677 or (408) 327-6000

Fax: (408) 327-6272

Internet: maccs@isinc.insignia.com

Customer service is available from 6am through 5pm, PST,

Monday through Friday.

Software registration Media replacement
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Europe, Middle East, Africa, and CIS countries

Phone numbers:

UK: 0800 667706

France: 0590 8201

Germany: 0130 81 40 90

Italy: 1678 77164

Netherlands: 060 225531

Sweden: 020 791480

Rest of region: +44 131 458 6849

Fax: +44 131 451 6981

Internet: info@isltd.insignia.com
or contact your local software supplier.

Customer service is available from 9am through 5pm, UK time,

Monday through Friday.

In other countries customer service is provided through the

authorized dealer in your country.

Product upgrades Software registration
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Index

C: drive (continued)

setting up 44

C:\> prompt 83

CD-ROM software 25

CD-ROMs

ejecting 36

listing files 36

setting up 53

troubleshooting 190

using 36

CHKDSK (MS-DOS command) 92

colors, changing number of 60

components of RealPC 24

compressing and expanding files 174

CONFIG.SYS file 94

configuration files

AUTOEXEC.BAT 95

CONFIG.SYS 94

conventions vi

copy (scripting keyword) 186

copy-protection devices 68

copying and pasting

in MS-DOS 87

in Windows 3.x 107

in Windows 95 124

copying graphics

from the Windows 3.x desktop 108

from the Windows 95 desktop 125

copying text

from MS-DOS 87

to MS-DOS 88

copying text or graphics

from Windows 3.x 107

from Windows 95 124

to Windows 3.x 108

A
A: drive 41

setting up 42

abbreviations vi

Acrobat Reader, installing 168

adding Windows 3.x 3

adding Windows 95 4

Adobe Acrobat

installer 25

Reader 175

ADPCM decompression 112, 130

Apple Compatibility Card

container files 43, 44

Apple Guide help 31

AppleScript, using 179

application (scripting keyword) 183

application memory size

changing 55

optimizing performance 79

Auto-Send… (Printouts

submenu) 89, 109, 127

AUTOEXEC.BAT file 95

B
Bad command or filename message 84

Balloon Help 33

Banyan VINES 160

Best Window Position (Setup menu) 57

BLASTER (environment variable) 61

C
C: drive 41, 43

creating 46, 47

expanding 45

listing files 28
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copying text or graphics (continued)

to Windows 95 124

CPU

advanced options 71

emulation settings 70

CPU (RealPC Setup dialog box) 40, 70

CPU Memory indicator 56

Custom Install installation option 22

Custom Remove installation option 22

D
D: drive 41, 43

creating 47

expanding 45

removing 44

setting up 44

data files, sharing 78

data size (scripting keyword) 183

DECnet Address Override utility 166

DECnet protocol 166

defragmenting hard disk files 45

demonstration version 9

desktop, setting up 58

direct printing 77

Direct Printing option 91

disk drives

drive letters 41

setting up 41

disk replacement 213

display

setting the number of colors 59

setting up 57

Display (RealPC Setup dialog box) 40, 57

DMF-format floppy disks 42

Documentation folder 25

dongles 68

Don’t Boot From Floppy Disk option 42

~don’t rest utility 23

DOS. See MS-DOS

drag and drop

in MS-DOS 87

in Windows 3.x 107

in Windows 95 124

dragging graphics

from the Windows 3.x desktop 108

from the Windows 95 desktop 126

dragging text

from MS-DOS 88

to MS-DOS 88

to Windows 3.x 108

to Windows 95 125

dual-format CD-ROMs 36

accessing 53

E
E: drive 41

setting up 49

shared as RealPC folder 49

Easy Install installation option 8

EasyLaunch 50, 93, 114, 132

EDIT (MS-DOS command) 96

Eject menu 36

ejecting

CD-ROMs 36

floppy disks 37

SCSI disks 37

EMM386 (MS-DOS command) 55

Emulate PC Mouse (Setup menu) 100
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error messages

floppy disk drives 199

hard disk files 198

licensing 195

memory 199

MS-DOS errors 193

running RealPC 197

serial ports 200

shared drives 194, 199

exiting

from Windows 3.x 101

from Windows 95 117

expanded memory 55

expanding hard disk files 45

extended memory 55

Extras folder 25

F
F: drive, using 36

filenames

in MS-DOS and Windows 3.x 51

in Windows 95 52

floppy disk drives 41

error messages 199

setting up 42

floppy disks

DMF format 42

ejecting 37

listing files 37

troubleshooting 190

using 36

Floppy Disks (RealPC Setup dialog

box) 40, 41, 42

flow control 68

FPU, disabling 70

frame type 157

FSADRIVE (MS-DOS command) 41

Full Screen DOS (Setup menu) 57

G
G: drive 41

shared as RealPC folder 49

get (scripting keyword) 183

glossary 205

group icon 102

H
H: drive 41

shared as RealPC folder 49

handshaking 68

hard disk drives 41

setting up 43

troubleshooting 190

Hard Disk Expander utility 45

hard disk files 43

changing size 45

creating from RealPC 47

creating using the installer 46

defragmenting 45

error messages 198

expanding 45

removing 44

running RealPC with 28

showing full path 43

Hard Disks (RealPC Setup dialog

box) 40, 41, 43, 44

HD Expander utility 45

HDData file 48, 78
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Internet utilities

installing 25, 168

using 174

J
Joystick (RealPC Setup dialog box) 40, 69

joysticks, setting up 69

K
key (scripting keyword) 186

KEYB (MS-DOS command) 75

KEYBOARD.SYS file 75

keyboards

international 76

setting up for MS-DOS 75

troubleshooting 191

using 34

L
LASTDRIVE 41

left PC mouse button 34

Level 2 Cache, optimizing performance 80

licensing, error messages 195

listing files

on a CD-ROM 36

on a floppy disk 37

LQ-2500 emulation 73, 77, 90, 110, 128

options 74

setting up 73

M
Macintosh extensions, optimizing

performance 80

Macintosh files, copying to RealPC 50

help 31

Apple Guide 31

Balloon Help 33

on MS-DOS 28, 86

on Windows 3.x 106

on Windows 95 122

HELP (MS-DOS command) 86

I
IBM 101-key keyboard 34

Infowave Wireless Messaging Inc 91, 111, 129

Insignia Printer Driver 109, 127

Insignia technical support page 172

installation 7

Acrobat Reader 168

additional options 22

Adobe Acrobat 25

disk space requirements 8

Internet utilities 25, 168

Microsoft Excel Viewer 169

Microsoft Internet Explorer 168

Microsoft Word Viewer 169

multi-user pack 78

PKZIP 168

QuickTime 25

removing files 22

Shockwave 168

Stuffit 168

Windows 3.x 15

Windows 95 19

international keyboard

using with Windows 3.x 76

using with Windows 95 76

international usage 75
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Macintosh folder

setting up as a PC drive 50

using as a PC drive 49

Macintosh printer, printing to 89, 109, 127

MacIPX 146

configuring 165

control panel 165

installing 164

Maximum Packet Size option 156

Media Player 130

memory

changing 56

displaying 56

error messages 199

expanded 55

extended 55

setting up 55

troubleshooting 190

video 57

Memory (RealPC Setup dialog box) 40, 55, 56

menu bar, displaying 57

Microsoft Dial-Up Adapter 154

Microsoft Excel Viewer, installing 169

Microsoft Internet Explorer 167

installing 168

installing Macintosh version 25

running from Windows 3.x 171

running from Windows 95 171

Microsoft LAN Manager 159

Microsoft Network client, installing 139

Microsoft PowerPoint 175

Microsoft technical support 173

Microsoft Windows. See Windows

Microsoft Word Viewer, installing 169

MIDI

setting up 64

using an external MIDI device 64

using QuickTime 64

MIDI files

playing from Windows 3.x 112

playing from Windows 95 64, 130

playing using QuickTime 64

millions of colors 60

MMX instruction set, disabling 70

MODE (MS-DOS command) 67, 91

modems

interfacing 67

using to register RealPC 13

mouse

pointer in Windows 100, 116

right button 34

right PC button 101, 116

troubleshooting 190

using 34, 100, 116

MS-DOS

basics 84

configuration 94

copying and pasting text 87

errors 193

getting help 28

help 86

information 81

networking 136

optimizing performance 80

printing from 89

prompt 83

quitting from 30

running 82

running from Windows 3.x 82

Index
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MS-DOS (continued)

running from Windows 95 82

troubleshooting 191

using 81

MS-DOS applications

installing 92

running 92, 93

MS-DOS commands

CHKDSK 92

EDIT 96

EMM386 55

FSADRIVE 41

HELP 86

MODE 67, 91

MSCDEX 53

NLIST 139

WIN 100

MS-DOS editor 96

configuring 97

running 96

using on a black and white Macintosh 97

MS-DOS files

AUTOEXEC.BAT 95

CONFIG.SYS 94

editing 96

NET.CFG 157

MSCDEX (MS-DOS command) 53

multi-user pack, installing 78

My Computer folder 37

N
NDIS drivers

configuring 155

using 146

NDIS networking software 134

configuring 138

starting 138

NET.CFG (MS-DOS file) 157

network clients, installing 144

network drivers 134

network interfaces 134

NDIS 134

ODI 134

networking 133

troubleshooting 155

with MS-DOS 136

with Windows 3.x 136

with Windows 95 146

NLIST (MS-DOS command) 139

Novell NetWare 4 client 138

Novell NetWare, setting up with MS-DOS or

Windows 3.x 138

Novell NetWare Workstation VLM Shell,

installing 150

NTRIGUE Net Client, installing 25, 176

O
ODI drivers

configuring 157

troubleshooting 161

using 136, 150

ODI frame types 159

ODI network interface 134

ODI to NDIS converter 137

On-the-fly Packet Filtering 156

Open Transport 163

Open Transport installer 25

Index
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optimizing performance 79

application memory 79

Level 2 Cache 80

Macintosh extensions 80

MS-DOS 80

Windows desktop 79

overview 1

P
paste (scripting keyword) 186

PC Extras folder 25, 168

PC files

copying to the Macintosh 50

running from the Macintosh 50

PC printer, printing to 91, 111, 129

PC Serial Ports… (Setup menu) 91

performance improvements 79

personalizing RealPC 9

PKZIP 174

installing 168

PostScript printer, printing to 90, 110, 128

PostScript printing 72, 77

PowerBooks, disabling rest mode 23

PPP connections 154

Ppview32 viewer 175

Printer Port (RealPC Setup dialog box) 40, 72

printing

direct 73, 77

Epson LQ-2500 73, 77

from Windows 3.x 109

from Windows 95 127, 128

international 77

PostScript 72, 77

setting up 72

to a serial printer 67

printing (continued)

troubleshooting 191

printing from MS-DOS

to a PC printer 91

to a PostScript printer 90

to a serial printer 91

to any Macintosh printer 89

printing from Windows 3.x 111

to a PC printer 111

to a PostScript printer 110

to any Macintosh printer 109

using Epson LQ-2500 emulation 110

printing from Windows 95 129

to a PC printer 129

to a PostScript printer 128

to any Macintosh printer 127

using Epson LQ-2500 emulation 128

product upgrades 213

Protocol Override 157

protocol type 157, 158

Q
QuickTime installer 25

QuickTime Musical Instruments extension 64

Quit (File menu) 30

quit (scripting keyword) 182

quitting

from MS-DOS 30

from RealPC 30

from Windows 3.x 30

from Windows 95 30

R
ReadMe file 8

RealAudio 175
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RealPC Hard Disk File C 9, 24, 46

RealPC Setup… (Setup menu) 40

RealPC Upgrade Disk 24, 46

registering RealPC 11

using a modem 13

using a printer 14

removing files 22

replacement disk 213

requirements 6

disk space 8

~rest utility 23

rest mode in PowerBooks, disabling or

enabling 23

Restart RealPC (Setup menu) 29

restarting RealPC 29, 40

right PC mouse button 34, 101, 116

Ring Speed 156

run (scripting keyword) 183

running

RealPC 10, 28

Windows 3.x 100

Windows 95 116

S
scripting 179

core suite 183

miscellaneous suite 186

RealPC suite 186

reference 182

required suite 182

scripting examples

executing a command 180

giving commands to MS-DOS 181

pasting into a Windows application 181

quitting from RealPC 182

scripting examples (continued)

reading information from MS-DOS 180

running a Windows application 181

running RealPC 180

scripting keywords

application 183

copy 186

data size 183

get 183

key 186

paste 186

quit 182

run 183

selection 185

set 183

window 185

write 188

SCSI devices, setting up 53, 54

SCSI disks

ejecting 37

using 36

selection (scripting keyword) 185

serial communications, limitations 68

serial devices 67

interfacing 65

troubleshooting 192

serial ports

error messages 200

flow control 68

setting up 65

specifications 66

Serial Ports (RealPC Setup dialog box) 40, 65

serial printer

printing to 91

setting up 67
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set (scripting keyword) 183

Setup dialog box 40

shared folders 41

displaying full path 49

error messages 194

Shared Folders (RealPC Setup dialog

box) 40, 41, 49

SharePC utility 23, 78

sharing

PC files 49

RealPC data files 78

Shockwave, installing 168

Shockwave viewers 175

simultaneous IP connections 163

simultaneous IPX connections 164

Simultaneous Protocol support 163

SmartCopy 107, 124

software registration 213

sound

default playback device 62

playing from Windows 3.x 112

playing from Windows 95 130

setting up 61

Sound (RealPC Setup dialog box) 40, 61, 64

Sound Blaster 61

disabling 61

environment variable 61

from Windows 3.x 112

in Windows 95 130

selecting 61

Sound Blaster 16 61

Sound Blaster Pro 61

using in MS-DOS and Windows 3.x 61

using in Windows 95 62

sound files, playing 175

Sound Properties dialog box 131

specification 203

Stuffit Expander 174

Stuffit, installing 168

T
TCP/IP connectivity 160

technical support 211

thousands of colors 60

troubleshooting 189

CD-ROMs 190

floppy disks 190

hard disks 190

keyboards 191

memory 190

mouse 190

MS-DOS window 191

networking 201

ODI 161

printers 191

serial devices 192

Windows 192

TurboStart 30

TurboStart (File menu) 30

tutorials

Windows 3.x 103

Windows 95 119

U
update utility 48

upgrades 213

upgrading from VirtualPC 26

Use Internal Floppy as A: option 42
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utilities

DECnet Address Override 166

~don’t rest 23

Hard Disk Expander 45

~rest 23

SharePC 23, 78

V
viewing files in different formats 175

Virtual PC

hard disk files, using 26, 43, 44

upgrading from 26

W
Wait for ‘Send’ (Printouts

submenu) 89, 109, 127

What’s This? box 123

WIN (MS-DOS command) 100

WIN.INI 102

window (scripting keyword) 185

Windows 3.x

basics 102

copying and pasting 107

Default Printer 110, 111

drag and drop 107

exiting 101

File Manager 102

getting help 106

group icon 102

information about 106

installing 15

installing and running applications 114

networking 136

playing MIDI files from 112

playing sounds from 112

Windows 3.x (continued)

printing 109

Program Manager 102

quitting from 30

running 18, 100

running MS-DOS 82

setting sounds for events 113

setting up Novell NetWare 138

tutorial 103

using an international keyboard 76

Windows 3.x applications

installing 114

printing from 111

running 114

Windows 95

basics 118

copying and pasting text and graphics 124

copying graphics from the desktop 125

exiting 117

getting help 122

installation 19

installing and running applications 132

networking 146, 159

playing MIDI files 64, 130

playing sounds from 130

printing 127, 129

quitting from 30

running 116

running MS-DOS 82

setting sounds for events 131

tutorial 119

using an international keyboard 76

Windows 95 applications

installing 132

printing from 129
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Windows 95 applications (continued)

running 132

Windows 95 desktop

changing size 59

restoring size 59

zooming to full screen 59

Windows desktop

changing size 58

moving 59

moving to best position 57

optimizing performance 79

setting up 58

Windows for Workgroups 159

Windows Setup window 58

Windows sound card 61

WinPost 103, 119

creating a new note 104, 121

printing a note 105, 121

running 104, 120

Winsock 146, 163

drivers 162

write (scripting keyword) 188
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